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Preface  

 
This section provides supporting information for the Oracle Financial Services Asset 
Liability Management Application Pack (OFS ALM) Pack Installation and 
Configuration Guide and includes the following topics: 

• Summary 

• Audience 

• Related Documents 

• Conventions 

• Abbreviations 

 

Summary 
 

 
You can find the latest copy of this document in OHC Documentation library which 
includes all the recent additions/revisions (if any) done till date. 

Before you begin the installation, ensure that you have access to the Oracle Support 
Services Portal with the required login credentials to quickly notify us of any issues at 
any stage. You can obtain the login credentials by contacting Oracle Support Services. 

 

Au dience 
 

 
Oracle Financial Services Asset Liability Management Application Pack Installation 
and Configuration Guide is intended for administrators, and implementation 
consultants who are responsible for installing and maintaining the application pack 
components. 

 

Prerequis ites fo r the Au dience 

The following are the prerequisites for administrators installing OFS Asset Liability 
Management Application Pack. This document assumes that you have experience in 
installing Enterprise components and basic knowledge about the following: 

• OFS ALM pack components 

• OFSAA Architecture 

• UNIX Commands 

• Database Concepts 

• Web server/Web application server 
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Related Do cuments 
For more information, see the following documents in the Oracle Financial Services 
Asset Liability Management Application Pack 8.x documentation library: 

• Oracle Financial Services Asset Liability Management User Guide 

• Oracle Financial Services Asset Liability Management Analytics User Guide 

 

Conventions 
The following text conventions are used in this document: 

 

Convention  Meaning 

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary. 

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values. 

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter. 

 

Ab breviations 
The following table lists the abbreviations used in this document: 

 

 

Ab breviation Meaning 

AIX Advanced Interactive eXecutive 

BDP Big Data Processing 

DBA Database Administrator 

DDL Data Definition Language 

DEFQ Data Entry Forms and Queries 

DML Data Manipulation Language 

EAR Enterprise Archive 

EJB Enterprise JavaBean 

ERM Enterprise Resource Management 

FTP File Transfer Protocol 

GUI Graphical User Interface 

HDFS Hadoop Distributed File System 

HTTPS Hypertext Transfer Protocol Secure 

J2C J2EE Connector 

J2EE Java 2 Enterprise Edition 

JDBC Java Database Connectivity 

JDK Java Development Kit 

JNDI Java Naming and Directory Interface 

JRE Java Runtime Environment 

http://docs.oracle.com/cd/E88917_01/alminstall.htm
http://docs.oracle.com/cd/E88917_01/alminstall.htm
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Ab breviation Meaning 

JVM Java Virtual Machine 

LDAP Lightweight Directory Access Protocol 

LHS Left Hand Side 

MOS My Oracle Support 

OFSAAI Oracle Financial Services Analytical Application Infrastructure 

OLAP On-Line Analytical Processing 

OLH Oracle Loader for Hadoop 

ORAAH Oracle R Advanced Analytics for Hadoop 

OS Operating System 

RAM Random Access Memory 

RDBMS Relational Database Management System 

SFTP Secure File Transfer Protocol 

SID System Identifier 

SSL Secure Sockets Layer 

TDE Transparent Data Encryption 

TNS Transparent Network Substrate 

URL Uniform Resource Locator 

VM Virtual Machine 

Web Archive WAR 

XML Extensible Markup Language 
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  1 
About OFSAA and OFSAA Application Packs 

 
This chapter includes the following topics: 

• About Oracle Financial Services Analytical Applications (OFSAA) 

• About Oracle Financial Services Analytical Applications (OFSAA) Application 
Packs 

• About Oracle Financial Services Advanced Analytical Applications Infrastructure 
(OFS ALM) Application Pack 

• About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) 

 

About Oracle Financial Services Analytical Applications 
(OFSAA) 

In today's turbulent markets, financial institutions require a better understanding of 
their risk-return, while strengthening competitive advantage and enhancing long-term 
customer value. Oracle Financial Services Analytical Applications (OFSAA) enable 
financial institutions to measure and meet risk-adjusted performance objectives, 
cultivate a risk management culture through transparency, lower the costs of 
compliance and regulation, and improve insight into customer behavior. 

OFSAA uses industry-leading analytical methods, shared data model, and 
applications architecture to enable integrated risk management, performance 
management, customer insight, and compliance management. OFSAA actively 
incorporates risk into decision making, enables to achieve a consistent view of 
performance, promote a transparent risk management culture, and provide pervasive 
intelligence. 

Oracle Financial Services Analytical Applications delivers a comprehensive, integrated 
suite of financial services analytical applications for the both banking and insurance 
domain. 
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About Oracle Financial Services Analytical Applications (OFSAA) Application Packs 
 

 

 

About Oracle Financial Services Analytical Applications (OFSAA) 
Application Packs 

The following figure depicts the various application packs that are available across the 
OFSAA Banking and Insurance domains: 

 
Figure 1–1 OFS AA Ap plication Packs 
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About Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) 

 

About Oracle Financial Services Advanced Analytical 
Applications Infrastructure (OFS ALM) Application Pack 

OFS ALM 8.0.6.0.0 Pack includes the following applications: 

• Oracle Financial Services Analytical Applications Infrastructure: Oracle Financial 
Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle 
Financial Services Analytical Applications family of products to perform the 
processing, categorizing, selection, and manipulation of data and information 
needed to analyze, understand and report on specific performance, risk, 
compliance and customer insight issues by providing a strong foundation for the 
entire family of Oracle Financial Services Analytical Applications across the 
domains of Risk, Performance, Compliance and Customer Insight. 

• Oracle Financial Services Asset Liability Management: Oracle Financial Services 
Asset Liability Management (OFS ALM) helps financial services institutions 
measure and monitor interest rate risk, liquidity risk, and foreign currency risk. 
This solution measures and models every loan, deposit, investment, and portfolio 
individually, using both deterministic and stochastic methods. Oracle Financial 
Services ALM is a next-generation solution fully integrated with Oracle’s Financial 
Services Analytical Applications and shares a common account level relational 
data model. 

• Oracle Financial Services Asset Liability Management Analytics: This application 
provides timely and actionable insight for managing interest rate and liquidity 
risk and provides transparency into critical issues. 

 

About Oracle Financial Services Analytical Applications 
Infrastructure (OFS AAI) 

Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the 
Oracle Financial Services Analytical Applications family of products to perform the 
processing, categorizing, selection, and manipulation of data and information required 
to analyze, understand and report on specific performance, risk, compliance and 
customer insight issues by providing a strong foundation for the entire family of 
Oracle Financial Services Analytical Applications across the domains of Risk, 
Performance, Compliance and Customer Insight. 

 

Components of OFS AAI 

The OFSAA Infrastructure includes frameworks that operate on and with the Oracle 
Financial Services Analytical Applications Data Model and forms the array of 
components within the Infrastructure. 

The OFSAA Infrastructure components/frameworks are installed as two layers; 
primarily the metadata server and Infrastructure services run on one layer, and the UI 
and presentation logic runs on the other. The UI and presentation layer is deployed on 
any of the supported J2EE Servers. 

Figure 1-2 depicts the various frameworks and capabilities that make up the OFSAA 
Infrastructure. 
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About Data Security Configurations 
 

 

 

Figure 1–2 Components of OFS AAI 

 

 

OFSAA Infrastructure High Availability 

The current release of the OFSAA Infrastructure supports only the Single Instance 
installation for the Infrastructure components. However, the High Availability (HA) 
for the Database Server and the Web Application Server clustering, and deployment 
are supported in this release. 

This release supports the Active-Passive model of implementation for OFSAAI 
components. For more information, see Oracle Financial Services Analytical 
Applications Configuration for High Availability- Best Practices Guide. 

 

About Data Security Configurations 
Data Security refers to the protection of data against unauthorized access and data 
theft. OFSAA ensures Data Security with the following features: 

• Multi-Factor Authentication 

• Transparent Data Encryption (TDE) 

• Data Redaction 

• Key Management 

• HTTPS 

• CSRF 

• Logging 

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
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  2 
Understanding OFS ALM Application Pack 

In s ta lla tion 

 
This chapter includes the following topics: 

• Installation Overview 

• Deployment Topology 

• Hardware and Software Requirements 

• Verifying System Environment 

• Understanding the Installation Mode 

 

Installation Overview 
This release (8.0.6.0.0) of the OFS ALM Application Pack bundles the upgrade patch 
set along with the base installer. Users/Administrators who wish to install a new OFS 
ALM Application Pack 8.0.6.0.0 instance or upgrade an existing OFS ALM Application 
Pack 8.0.x.x.x instance to 8.0.6.0.0 should download this installer. Figure 2–1 shows the 
order of procedures required to follow to install a new OFS ALM Pack 8.0.6.0.0 
instance. To upgrade an existing OFS ALM Application Pack 8.0.x.x.x instance to 
8.0.6.0.0 release, see Upgrading the OFS ALM Application Pack. 
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Deployment Topology 
 

 

 

Figure 2–1 Ins talla tion Overview  
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Deployment Topology 
 

 

 

 

 

 

 
Table 2-1 provides additional information and links to the specific documentation for 
each task in the flowchart. 

 
Table B–1 OFS AA Ap plication Pack Ins ta lla tion Tas ks and De s criptions 

 

Ta s ks De ta ils and Do cumentation 

Verify Systems 
Environment 

To verify that your system meets the minimum requirements for 
installing and hosting the OFS ALM Application Pack, see 
Verifying System Environment. 

Obtain the software To access and download the OFS ALM Application Pack, see 
Obtaining the software. 

Configure and Execute the 
Schema Creator Utility 

To create the database schemas, see Configuring and Executing 
the Schema Creator Utility. 

Install OFS ALM Pack To install the OFS ALM Application Pack, see Installing the OFS 
ALM Application Pack. 

Configure OFS ALM Pack To configure the OFS ALM Application Pack post-installation, 
see Post Installation Configurations. 

 

Deployment Topology  
Figure 2-2 shows the logical architecture implemented for the OFS ALM Application 
Pack. 
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Verifying System Environment 

 

Figure 2–2 Dep loyment Topo logy  

 

 

 

Hardware and Software Requirements  
This section describes the various Operating Systems, Database, Web Server, and Web 
Application Server versions, and other variant details on which this release of the OFS 
ALM Application Pack has been qualified. 

 

No te : OFS ALM Application Pack installation can be performed on 
both Virtual and Physical servers. 

 

 

Refer to the Technology Matrix for Hardware and Software requirements for this 
release. 

 

Verifying System Environment 
To verify your system environment meets the minimum requirements for the 
installation, a Pre-Install Check utility is available within the Install Kit archive file. 
This utility can also be obtained separately by contacting Oracle Support Services. 

Though the system environment verification is an integral and automated part of the 
installation of this software product, Oracle strongly recommends running this utility 
prior to beginning the installation as part of your organization's "Installation 
Readiness Verification Process". 

https://docs.oracle.com/cd/E55339_01/homepage.htm
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No te : For more details on download and usage of this utility, see 
Oracle Financial Services Analytical Applications Infrastructure 
Environment Check Utility Guide given in the Related Documents 
section. 

 

Understanding the Installation Mode 
The following modes of installation are available for the OFS ALM Applications Pack. 

• Installing in GUI Mode 

• Installing in SILENT Mode 
 

No te : This is recommended to use SILENT mode of installation. 
 

 

Installing in GUI Mode 

This mode launches the product installation in a Graphical User Interface (GUI) 
mode. You must enter the required information on various windows within the UI in a 
user interactive format at various stages. 

 

No te : For more information on configuration required for GUI mode 
installation, see Installing in GUI Mode. 

 

 

Installing in SILENT Mode 

This mode mandates updating the installation configuration files with required details 
and performs installation in a Silent non-user interactive format. 

 

No te : For more information on configuration required for SILENT 
mode installation, see Installing in SILENT Mode. 
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  3 
Preparing for Installation 

 
This chapter provides the necessary information to review before installing the OFS 
ALM Pack v8.0.6.0.0. This chapter includes the following topics: 

• Installer and Installation Prerequisites 

• Obtaining the software 

• Performing Common Pre-Installation Tasks 

 

Installer and Installation Prerequisites 
Table 3-1 provides the list of prerequisites required before beginning the installation 
for the OFS ALM application. The Installer or Environment Check Utility notifies you 
if any requirements are not met. 
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Table B–2 Prerequis ite In fo rmation 
 

Category Sub-Category Expected Va lue 

Environment 
Settings 

Java Settings • PATH in .profile file must be set to include the 
Java Runtime Environment absolute path. The 
path should include the Java version (7 or 8) 
based on the configuration. 

No te : 

• Ensure that the absolute path to JRE/bin is set 
at the beginning of the PATH variable. 

• For example, 
PATH=/usr/java/jre1.7/bin:$ORACLE_ 

HOME/bin:$PATH 

Ensure that SYMBOLIC links to JAVA installation 
are not set in the PATH variable. 

Oracle Database 
Settings 

Oracle Database Server 

• TNS_ADMIN must be set in .profile file 
pointing to appropriate tnsnames.ora file. 

• Enable Transparent Data Encryption (TDE) 
and/ or Data Redaction** 

• ** Note: For more information, see Appendix: 
Enabling TDE, Data Redaction, and the 
Corresponding Settings in OFSAA. 

 OFSAA Processing Server 

• ORACLE_HOME must be set in .profile file 
pointing to appropriate Oracle Client 
installation. 

• PATH in .profile must be set to include 
appropriate $ORACLE_HOME/bin path. 

• Ensure that an entry (with SID or SERVICE 
NAME) is added in the tnsnames.ora file. 

Oracle Essbase 
Settings 

• ARBORPATH, ESSBASEPATH, HYPERION_ 
HOME to be set in the .profile pointing to an 
appropriate Oracle Essbase Client installation. 

No te : 

These settings are required only if you want to use 
Oracle Hyperion Essbase OLAP features. 
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Table B–2 (Cont.) Prerequis ite In fo rmation 
 

Category Sub -Ca tegory Expected Va lue 

OS/ File System 
Settings 

File Descriptor 
Settings 

• Greater than 15000 

Note: 

The value specified here is the minimum value to be 
set for the installation process to go forward. For 
other modules, this value may depend on the 
available resources and the number of processes 
executed in parallel. 

Total Number of 
Process Settings 

• Greater than 4096 

Note: 

The value specified here is the minimum value to be 
set for the installation process to go forward. For 
other modules, this value may depend on the 
available resources and the number of processes 
executed in parallel. 

Heap Size Greater than or equal to 8310 

Port Settings • Default port numbers to be enabled on the 
system are 6500, 6501, 6505, 6507, 6509, 6510, 
6666, 9999, and 10101. 

.profile 

permissions 
• User to have 755 permission on the .profile file. 

Installation 
Directory 

• A directory where the product files will be 
installed. 

• Assign 755 permission to this directory. 

• This directory needs to be set as FIC_HOME. 

Temporary 
Directory 

Default temporary directory where installation files 
are stored for a short period of time to support 
faster installation. 

• For installation on UNIX OS, your UNIX 
administrator must give you the required 
read-write permissions for the /tmp directory 
and disable the NOEXEC option 

• Configure adequate space on the /tmp 
directory. It is recommended that you allocate 
more than 10 GB of space. 

Note: If NOEXEC is enabled, the extraction of files 
by the installer into the /tmp directory is prevented 
and the binaries will not execute in the directory, 
which will fail the installation. 

Staging Area/ 
Metadata 
Repository 

• A directory to hold the application metadata 
artifacts and additionally act as a staging area 
for flat files. 

• The directory should exist on the same system 
as the OFSAA Installation. This directory can 
be configured on a different mount or under a 
different user profile. However, the owner of 
the installation directory that is mentioned in 
the previous row, must have RWX permissions 
on this folder. 

• Assign 775 permission to this directory. 

Note: This directory is also referred to as the 
FTPSHARE folder. 

Download 
Directory 

• A directory where the product installer files 
will be downloaded/ copied. 

• Set 755 permissionPorenptahriisndgifroerctIonrsyta. llation    3-11 
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Table B–2 (Cont.) Prerequis ite In fo rmation 
 

Category Sub -Ca tegory Expected Va lue 

Database Settings Database Instance 
Settings 

• NLS_CHARACTERSET to be AL32UTF8 

• NLS_LENGTH_SEMANTICS to be BYTE 

• OPEN CURSORS limit to be greater than 1000 

Web Application 
Server 

WebSphere/ 
WebLogic/ 
Tomcat 

• Web Application Server should be installed 
and the profile /domain created. 

• You will be prompted to enter the WebSphere 
Profile path or WebLogic Domain path or 
Tomcat Deployment path during OFSAAI 
installation. 

Note: 

See Appendix A for WebSphere Profile and 
WebLogic Domain creation. 

• For deployment on Oracle WebLogic Server 
12.1.3+ (64 bit) with Java 8, download and 
install patch 18729264 from 
http://support.oracle.com/. 

Web Server Apache HTTP 
Server/ Oracle 
HTTP Server/ 

IBM HTTP Server 

This is an optional requirement. HTTP Server 
Installation to be present. You are prompted to 
enter the Web Server IP/Hostname and Port details 
during installation. 

Note: See Appendix A for web server installation. 

Operating System Solaris 11 
 

 

 

 

 

 

Solaris 10 

Upgrade to Oracle Solaris 11.3 with SRU09 or 
higher. See https://docs.oracle.com/cd/E53394_ 
01/html/E54845/index.html to upgrade to SRU09 
if you have a lower SRU version. Additionally, 
install the required runtime libraries. For more 
information, see Installing Only the Runtime 
Libraries on Oracle Solaris 11. 

Install the required OS patches. For more 
information, see Installing the Required Oracle 
Solaris 10 Patches. Additionally, install the required 
runtime libraries. For more information, see 
Installing Only the Runtime Libraries on Oracle 
Solaris 10. 

Note: In an OFSAA instance where multiple 
OFSAA application packs have been installed/ 
deployed, it is mandatory to upgrade all OFSAA 
application packs to 8.0.60.0 release. You should 
start the upgrade of the OFS ALM Applications 
pack, only after confirming that all of the 
application packs in your OFSAA instance are 
available for upgrade to 8.0.6.0.0 version. For 
information on availability of the required OFSAA 
Application Packs, see 2246606.1. 

Others Oracle R/ Oracle 
R Enterprise 

• This is an optional requirement. 

• see section Installing Oracle R distribution and 
Oracle R Enterprise (ORE) for more details. 

AAI  Download the one-off patch for bug number 
30273976 from http://support.oracle.com/. 

Download the one-off patch for bug number 
30667112 from http://support.oracle.com/. 

http://support.oracle.com/
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gozsu.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gouag.html#scrolltoc
https://docs.oracle.com/cd/E60778_01/html/E60743/gouag.html#scrolltoc
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=355436839277658&id=2246606.1&_afrWindowMode=0&_adf.ctrl-state=yzhdrvwqa_4
http://support.oracle.com/
http://support.oracle.com/
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The following step is applicable only if the existing OFSAA setup version is 8.0.5.x.x 
and Configuration and Atomic Schema(s) were restored from exported dumps of 
other environments: 

Log in to Configuration Schema and execute the following SQL statements: 

alter table AAI_AOM_APP_COMP_ATTR_MAPPING drop constraint AOM_APP_COMP_ 

ATTR_PK drop index 

/ 

alter table AAI_AOM_APP_COMP_ATTR_MAPPING add constraint AOM_APP_COMP_ 

ATTR_PK primary key (APP_COMP_ATTR_MAP_ID) 

 
 

No te : Ensure that the tablespace(s) used for the database user(s) is 
set to AUTOEXTEND ON. 

 

 

Obtaining the software 
This release of OFS ALM Application pack v8.0.6.0.0 can be downloaded from 
http://support.oracle.com/ using patch 27768297. 

If you have ALM Application pack 8.0.0.0.0, 8.0.2.0.0, or 8.0.5.0.0, then you can 
upgrade it to version 8.0.6.0.0. 

 

Performing Common Pre-Installation Tasks 
The common pre-installation activities that you must carry out before installing the 
OFS ALM application pack are: 

 
 

• Configuring for GUI Mode Installation 

• Identifying the Installation, Download and Metadata Repository Directories 

• Downloading and Copying the OFS ALM Applications Pack Installer and 
Mandatory Patches 

• Extracting the Software 

• Setting Up the Web Application Server 

• Installing Oracle R distribution and Oracle R Enterprise (ORE) 

 

 
Configuring for GUI Mode Installation 

To install OFS ALM Application Pack in GUI mode, you need to ensure the following 
software and configurations are available: 

• Install and configure any PC X Server software such as Open Text Exceed 
(formerly Hummingbird Exceed) on the user desktop system from which the 
installation is triggered. 

• Configure the DISPLAY variable. 

Ensure to set the DISPLAY variable on the system on which the OFSAA will be 
installed, to point to the user desktop system where the PC X Server software is 
installed. 

http://support.oracle.com/
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Syntax: 

export DISPLAY=hostname:n.n1 

where hostname is the IP Address/ Host Name of the user desktop system 

and n is the sequence number (usually 0). 

For example, 10.11.12.13:0.0 or myhostname:0.0 

 

Identifying the Installation, Download and Metadata Repos itory 
Directories  

To install OFSAA Application Pack, create the following directories: 

• OFSAA Download Directory (Optional): Create a download directory and copy 
the OFSAA Application Pack Installer File (archive). This is the directory where 
the downloaded installer/patches can be copied. 

• OFSAA Installation Directory (Mandatory): Create an installation directory 
where the product binaries will be installed. Set the variable FIC_HOME in the 
.profile file to point to the OFSAA Installation Directory. 

• OFSAA Staging/Metadata Directory (Mandatory): Create a Staging/Metadata 
Repository Directory to copy data files, save data extracts, and so on. Additionally, 
this directory also maintains the OFSAA metadata artifacts. This directory is also 
referred to as "FTPSHARE". This directory must be created on the same host as the 
OFSAA Installation Directory mentioned in the previous point in this list. 

 
 

No te : 

• Assign 755 user permission to the installation directory. 

• Assign 775 user permission to the staging directory. 

• Ensure the OFSAA staging directory is not set to the same path as 
the OFSAA installation directory and is not a sub-folder inside the 
OFSAA installation directory. 

 

Downloading and Copying the OFS ALM Applications Pack Installer and 
Mandatory Patches  

To download the OFS ALM Applications Pack Installer, follow these steps: 

Copy the downloaded installer archive to the Download Directory (in Binary Mode) 
on the setup identified for OFSAA installation. 

If you have ALM Application pack version 8.0.0.0.0, 8.0.2.0.0, or 8.0.5.0.0, then you can 
upgrade it to version 8.0.6.0.0. 

 

 Log in to My Oracle Support, search for the 27768297 Mandatory Patch in the 

Patches & Updates Tab and download it. 

https://support.oracle.com/
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No te : On the 10th of December 2021, Oracle released Security Alert 

CVE-2021-44228 in response to the disclosure of a new vulnerability 

affecting Apache Log4J prior to version 2.15. The application of the 

33663417 Mandatory Patch fixes the issue. 

For details, see the My Oracle Support Doc ID 2827801.1. 

 

Extracting the Software 
 
 

No te : You must be logged in to the UNIX operating system as a 
non-root user. 

 

 

1. Download the unzip utility (OS specific) unzip_<os>.Z and copy it in Binary mode 
to the directory that is included in your PATH variable. If you already have the 
unzip utility to extract the contents of the downloaded archive, skip this step. 

2. Uncompress the unzip installer file with the command: 

uncompress unzip_<os>.Z 

 

No te : If an error message "uncompress: not found [No such file or 
directory]" is displayed, contact your UNIX administrator. 

 

 

3. Assign execute (751) permission to the file with the command: 

chmod 751 unzip_<OS> 

For example, chmod 751 unzip_sparc 

4. Extract the contents of the OFS ALM Application Pack 8.0.0.0.0 installer archive 
file in the download directory with the following command: 

unzip OFS_ALM_PACK.zip 

5. Navigate to the download directory and assign execute permission to the installer 
directory with the following command: 

chmod -R 750 OFS_ALM_PACK 

 

Setting Up the Web Application Server 

For setting up the environment based on your selected Web Application Server, see to 
Starting/ Stopping Infrastructure Services for more information. 

For more information, see Oracle Financial Services Analytical Applications 
Infrastructure Security Guide. 

 
Installing Oracle R distribution and Oracle R Enterprise (ORE) 

This is an optional step and required only if you intend to use Oracle R scripting in the 
Oracle Financial Services Enterprise Modeling Application or if the OFSAA 
Application that you have licensed uses this feature. For information on applications 
that use this feature, see the Tech Matrix. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2827801.1
https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
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The following is the instruction to install ORD and ORE: 

Install Oracle R Distribution and Oracle R Enterprise (Server Components) on the 
Oracle Database server. See Oracle® R Enterprise Installation and Administration 
Guide for Windows, Linux, Solaris, and AIX - Release 1.5 at Oracle R Enterprise 
Documentation Library and Release 1.5.1 at Oracle R Enterprise Documentation 
Library. 

Table B–3 
 

No 
. 

Oracle R 
Enterprise 

Oracle R Advanced Ana 
lytics for Hadoop  

Open source R or Oracle R 
Distribution 

Oracle Databas  
Enterpris  Edition 

1 1.5.1 2.7.1 3.3.0 11.2.0.4, 12.1.0.1, 
12.1.0.2, 12.2.0.1 

2 1.5.0 2.5.1, 2.6.0, 2.7.0 3.2.0 11.2.0.4, 12.1.0.1, 
12.1.0.2 

 
 

No te : If you use ORE 1.5 or ORE 1.5.1, for Oracle Financial Services 
Enterprise Modeling, you must set the session time zone in 'R_ 
HOME/etc/Rprofile.site’ file on the database server, where R_ HOME 
is the home directory of the R instance on which ORE server packages 
are installed. Alternatively, you can set session time zone in scripts 
registered within OFS EM by using the 'Sys.env(TZ=<time zone>)’ R 
function. 

 

 

For the ALM application pack, this is an optional step and required only if you intend 
to use Term Structure Parameter Estimation functionality under Rate Management – 
Interest Rates, for computing term structure parameters. Both Funds Transfer Pricing 
and Asset Liability Management applications require term structure parameters for all 
monte carlo engine based calculations (OAS, VaR, and EaR). 

The following are the prerequisites: 

• Install R and Oracle R Enterprise Server on the Oracle Database server. Refer to 

https://docs.oracle.com/cd/E57012_01/doc.141/e57007.pdf 

• ORE version supported - Oracle R Enterprise (Server) version 1.4.1 

Configuration for Oracle R Enterprise 

Grant the RQADMIN role to atomic schema. 

You can grant the rqadmin role in SQL*Plus by logging in to the database with DBA 
privileges and provide the following privilege to Atomic Schema: 

RQADMIN by executing the command: 

GRANT RQADMIN TO <atomic_schema>; 

https://docs.oracle.com/cd/E57012_01/doc.141/e57007.pdf


Installing the OFS ALM Pack 3-9 

 

 

 

 

  4 
Installing the OFS ALM Pack 

 
This chapter provides instructions to install the OFS ALM pack for various modes of 
installation. 

This chapter includes the following sections: 

• Overview of Schema Creator Utility 

• Configuring and Executing the Schema Creator Utility 

• Installing the OFS ALM Application Pack 
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No te : Release 8.0.6.0.0 of ALM is not fully backward compatible 
with earlier versions of OFSAA applications. You can either upgrade 
all of your applications from existing 8.0.x versions to 8.0.6.0.0 version 
or choose to upgrade only selective application packs to v8.0.6.0.0. In 
the case of the latter, you must also apply the corresponding 
compatibility patches so that the remaining application-packs can 
remain at their pre-8.0.6.0.0 versions: 

Compatibility patch for OFS ALM: 28097119 

You can download this patch from the Patches & Updates tab of 
http://support.oracle.com/ portal. For more information about the 
application of this patch, refer to the Readme files. 

To run the DMT migration for 'T2T_OPTIONS_CONTRACT', follow these 

steps: 

1. Navigate to $FIC_HOME/utility/DMT/Migration/bin. 

2. Execute below command: ./DMTUpgradeUtility_806.sh 
ONLY_DEFINITION_AS_VERSION <METADATA_ 

TYPE><INFODOM_NAME> <DEFINITION_NAME> 

Here, 

• <METADATA_TYPE> can be DMT_PLC (PLC or DT) or 

DMT_DM(Data Mapping and Data File Mapping ) 

• <INFODOM_NAME> can be: 

DMT_PLC- Infodom in which the definition is defined. 

DMT_DM-Any valid Infodom. 

• <DEFINITION_NAME> can be: 

DMT_PLC-Any valid Definition Name 

DMT_DM-<Application Name>~<Source 
Name>~<Definition Name> 

Example: 

./DMTUpgradeUtility_806.sh ONLY_DEFINITION_AS_VERSION 
DMT_DM Infodom2 App1~Src1~T2T 

For more information, see OFSAA DMT Metadata Migration 
Guide. 

 

Overview of Schema Creator Utility 
Creating database users/ schemas is one of the primary steps in the complete OFSAA 
installation. This release of OFSAA provides a utility to quickly get started with the 
OFSAA 8.0 installation by allowing easier and faster creation of database User(s)/ 
Schema(s), assign the necessary GRANT(s) and so on. Additionally, it also creates the 
required database objects in these schemas. 

 

About Schema Creator utility 

The schema creator utility should be configured and executed mandatorily every time 
prior to installation of any OFSAA Application Pack. 

The following are the types of schemas that can be configured in the OFSAA: 

http://support.oracle.com/
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
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• CONFIG: This schema holds the entities and other objects required for OFSAA 
setup configuration information. 

 

No te : There can be only one CONFIG schema per OFSAA instance. 
 

 

• ATOMIC: This schema holds the data model entities. One ATOMIC schema is 
attached to one Information Domain. 

 

No te : For some application packs there can be multiple ATOMIC 
schemas per OFSAA Instance, but the ALM Application Pack 
supports only one atomic schema per OFSAA instance. 

 

 

• SANDBOX: Denotes the schema that contains the data for all Sandbox executions. 
One SANDBOX schema is attached to one Sandbox Information Domain. 

 

No te : This Schema type is not applicable for OFS ALM Application 
Pack. There can be multiple SANDBOX schemas per OFSAA Instance 
and a Sandbox Information Domain can have only one SANDBOX 
schema. 

 

 

• ADDON: Denotes any additional schema used by the OFSAA Applications. 
 

No te : This Schema type is not applicable for OFS ALM Application 
Pack. 

 

 

Selecting Execution Modes in Schema Creator Utility 

Schema creator utility supports the following modes of execution: 

• Online Mode: In this mode, the utility connects to the database and executes the 
Data Definition Language (DDL)s for User, Objects, and Grants. If you have 
SYSDBA privileges, you can execute the Schema Creator Utility in Online mode 
and create Users, Objects, and Grants during the execution process. 

 

No te : To execute the utility in Online mode, you must connect as 
"<User> AS SYSDBA" 

 

 

• Offline Mode: In this mode, the utility generates a SQL script with all the required 
DDLs for User, Objects and GRANTS. This script must be executed by the DBA on 
the appropriate database identified for OFSAA usage. If you do not have SYSDBA 
privileges, you can execute the Schema Creator Utility in Offline mode and 
generate the script file that contains the Schemas, Objects, and GRANTS 
information. Subsequently, a SYSDBA user must execute the script file manually. 
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No te : 

1. Connect as any database user. 

2. Reconfigure the OFS_ALM_SCHEMA_IN.xml file and execute the 
utility. For more information on reconfiguring these files, see 
Configuring <<APP Pack>>_SCHEMA_IN.xml File 

To execute the utility in Offline mode, you must connect as a user 
with the following GRANTS (alternatively, you can also connect 
as a user with SYSDBA privileges): 

• SELECT ON DBA_ROLES 

• SELECT ON DBA_USERS 

• SELECT ON DBA_DIRECTORIES 

• SELECT ON DBA_TABLESPACES 

• CREATE SESSION 

3. If there are any errors during the SQL script execution, 
reconfigure the OFS_ALM_SCHEMA_IN.xml and execute the 
utility. This regenerates the scripts with corrected information. 

For more information, see Configuring <<APP Pack>>_ 
SCHEMA_IN.xml File 

4. Do not modify the <PACK>_SCHEMA_OUT.XML file generated after 
the execution of this utility. 

 

Selecting Execution Options in Schema Creator Utility 

Depending on the option selected to run the OFSAA Application Pack installer, you 
must select the appropriate schema creator utility execution option. To run the OFSAA 
Application Pack installer in Silent mode, it is mandatory to execute the schema 
creator utility with -s option. 

 

No te : If the schema creator utility is executed without the option -s, 
it is mandatory to run the OFSAA Application Pack Installer in GUI 
mode. 
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Configuring and Executing the Schema Creator Utility 
This section includes the following topics: 

• Prerequisites 

• Configuring the Schema Creator Utility 

• Executing the Schema Creator Utility 

 

Prerequisites 

The prerequisites you must have before configuring the Schema Creator Utility are: 

• Oracle User ID/Password with SYSDBA privileges. 

• JDBC Connection URL for RAC/Non RAC database. 

• HOSTNAME/IP of the server on which OFSAA is being installed. 

• For enabling Transparent Data Encryption (TDE) in your OFSAA instance during 
installation, perform the steps explained in the Appendix R: Enabling Transparent 
Data Encryption (TDE) in OFSAA. 

• The following configuration is required only if you intend to use Oracle 
Linux/Red Hat Enterprise Linux v7.x. 

For Oracle Linux/RHEL 7.x, navigate to OFS_ALM_PACK/bin/ and modify the 
value for property Linux_VERSION to include 7 in the VerInfo.txt file and save the 
changes. 

For example, Linux_VERSION=5,6,7 

• For IBM AIX 7.1, navigate to OFS_ALM_PACK/bin/ and modify the value for 
property AIX_VERSION to include 7.1 in the VerInfo.txt file and save the changes. 

For example, AIX_VERSION=6.1,7.1 

 

Configuring the Schema Creator Utility 

This section explains the steps to configure the Schema Creator Utility. 

To configure the Schema Creator Utility, follow these steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following path: OFS_ALM_PACK/schema_creator/conf directory. 

3. Edit the OFS_ALM_SCHEMA_IN.xml file in a text editor. 

4. Configure the elements as described in Configuring <<APP Pack>>_SCHEMA_ 
IN.xml File. 

5. Save the OFS_ALM_SCHEMA_IN.xml file. 
 

No te : On successful execution of the utility, the entered passwords 
in the OFS_ALM_SCHEMA_IN.xml file are nullified. 

 

 

Executing the Schema Creator Utility 

This section includes the following topics: 

• Executing the Schema Creator Utility in Online Mode 

• Executing the Schema Creator Utility in Offline Mode 
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• Executing the Schema Creator Utility with -s Option 

• Executing the Schema Creator Utility while Installing Subsequent Applications 
Pack 

 

No te : If you intend to use Oracle OLAP feature, execute the 
following grant on all ATOMIC schema(s) grant olap_user to 
&database_username. 

 

 

Executing the Schema Creator Utility in Online Mode 

In Online mode, the Schema Creator Utility creates all the Schemas, Schema Objects, 
Tablespaces, GRANTS, and Roles in the database during the execution process. 

To execute the Schema Creator Utility in Online mode, follow these steps: 

1. Log in to the system as non-root user. 

2. Navigate to the following path: OFS_ALM_PACK/schema_creator/bin/ 

3. Execute the osc.sh file using the following command: 

./osc.sh 

The following message is displayed: 

You have chosen ONLINE mode. Triggering the utility in ONLINE mode will 
execute the DDLs directly on the Database. Do you wish to proceed? (Y/y or N/n). 

4. Enter Y/y to proceed with the script generation. 

5. Enter the DB Username with SYSDBA Privileges. For example: SYS as SYSDBA. 

6. Enter the User Password. 

 
Figure 4–1 Schema Creation - On line Mode  

 

 

7. The console runs the initial validation checks and then displays the following 
message: 

You have chosen to install this Application Pack on <Name of the Atomic 
Schema>ATOMIC schema. Do you want to proceed? (Y/N). 

8. Enter Y/y to proceed with the schema creation. 
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The following message is displayed: 

You have chosen to install this Application Pack on <Name of the Infodom>. Do 
you want to proceed? (Y/N). 

 
Figure 4–2 Schema Creation - On line Mode (contd.) 

 
 

 

9. Enter Y/y to start the schema creation. 

 
Figure 4–3 Schema Creator Utility - Online 
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No te : 

• On successful execution of schema creator utility, the console 
displays the following status message: 

Schema Creator executed successfully. Please proceed with the 
installation. 

• See log file in OFS_ALM_PACK/schema_creator/logs 
directory for execution status. If there are any errors, contact 
Oracle Support Services. 

 

Executing the Schema Creator Utility in Offlin e Mode 

In Offline mode, the Schema Creator Utility creates an output in SQL file format. This 
script must be executed manually by logging as database user with SYSDBA 
privileges. The SQL file contains the creation of Schemas, Schema Objects, 
Tablespaces, Grants, and Roles. 

Prerequisites 

To execute the utility in Offline mode, you must connect a database user with the 
following GRANTS (alternatively, you can also connect as a user with SYSDBA 
privileges): 

• SELECT ON DBA_ROLES 

• SELECT ON DBA_USERS 

• SELECT ON DBA_DIRECTORIES 

• SELECT ON DBA_TABLESPACES 

• CREATE SESSION 

 

No te : Explicit GRANTS to the user are required. GRANTS assigned 
through Roles are not supported. 

 

 

To execute the schema creator utility in Offline mode, follow these steps: 

1. Log in to the system as non-root user. 

2. Navigate to the OFS_ALM_PACK/schema_creator/bin directory. 

3. Execute the osc.sh file using the following command: 

./osc.sh -o 

4. The following message is displayed: 

You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will 
generate the script. Do you wish to proceed? (Y/y or N/n). 

5. Enter Y/y to generate the script. 

6. Enter the DB Username with SELECT privileges. 

7. Enter the User Password. 
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Figure 4–4 Schema Creation - Offlin e Mode 

 

8. The console runs the initial validation checks and displays the following message: 

You have chosen to install this Application Pack on <Name of the Atomic 
Schema>ATOMIC schema. Do you want to proceed? (Y/N). 

9. Enter Y/y to start the script generation. 

The following message is displayed: 

You have chosen to install this Application Pack on <Name of the Infodom>. Do 
you want to proceed? (Y/N) 
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Figure 4–5 Schema Creation - Offlin e Mode 

 

10. Enter Y/y to start the script generation. 
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Figure 4–6 Schema Creator Utility - Offlin e 

 

On successful execution of schema creator utility, the console displays the 
following status message: 

Schema Creator executed successfully. Please execute /scratch/ofsaaapp/OFS_ 
ALM_PACK/schema_creator/sysdba_output_scripts.sql before proceeding with 
the installation. 

Additionally, if you have configured the <<APP PACK>>_SCHEMA_BIGDATA_ 
IN.xml file, a file called hive_output_scripts.hql is also created in the 
/scratch/ofsaaapp/OFS_ALM_PACK/schema_creator directory. 

11. Navigate to the directory OFS_ALM_PACK/schema_creator. 

12. Log in to SQLPLUS with a user having SYSDBA privileges. 
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Figure 4–7 Schema Creator - Offlin e Mode (c ontd.) 

 

13. Execute the sysdba_output_scripts.sql file using the following command: 

SQL>@sysdba_output_scripts.sql 

Alternatively, you can copy the sysdba_output_scripts.sql file and SQLScripts 

directory to a remote server and execute the sysdba_output_scripts.sql file. 

 

No te : See log sysdba_output_scripts.log file for execution status. 
If there are any errors, contact Oracle Support Services. If there are no 
errors in the execution, the log file is empty. 

 

 

Executing the  Schema Creator Utility with -s Option 

If you intend to run the OFS ALM Application Pack Installer in Silent mode, it is 
mandatory to execute the schema creator utility with -s option. 

To execute the utility with -s option, follow these steps: 

1. Edit the file OFS_ALM_PACK/schema_creator/conf/OFS_ALM_SCHEMA_IN.xml in text 
editor. 

2. Set the value for attribute "INFODOM" of <SCHEMA> tag(s) to specify a specific 
Information Domain name. By default, the value is empty and the utility derives 
the Information Domain name. If the attribute value is set, the utility/ installer 
configures the Information Domain against this <SCHEMA>. 

3. Execute the utility with -s option. 

For example: ./osc.sh -s. 

 

No te : 

• If the utility is executed without the -s option, it is mandatory to launch 
the OFSAA Applications Pack Installer in GUI mode. 

• To execute the utility in OFFLINE mode with SILENT option, enter the 
following command: 
./osc.sh -o -s 
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Figure 4–8 Schema Creator Utility with -s Option 
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Figure 4–9 Schema Creator Utility with -s Option 
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Figure 4–10 ALMS chema Creator Utility with -s Option 

 
 

 

Executing the Schema Creator Utility while Ins ta lling Subs equent Ap 

plications Pack 

While executing the schema creator utility for subsequent Applications Pack, you can 
choose to install the pack either on the same Information Domain /Atomic Schema or 
on a new Information Domain /Atomic Schema. You can execute the schema creator 
utility either in Online or Offline mode. 

 

No te : OFS ALM Application Pack can be installed on any 
Information Domain / Atomic schema where any OFS Application 
Packs are installed other than OFS Behavior Detection Application 
Pack or OFS Compliance Regulatory Reporting Application Pack. 

 

 

To execute the schema creator utility while installing OFS ALM Application Pack over 
an existing Application Pack, follow these steps: 

1. Repeat the steps 1 to 9 from the Executing the Schema Creator Utility section. 

 

No te : Ensure to use the same config schema user name as the 
previous Application Pack. 

 

 

2. The utility identifies the Application Packs that are already installed on the current 
OFSAA setup and displays the following on the console: 

• Atomic schema of the existing Application Pack 

• Information Domain Name of the existing Pack, and the 

• List of Installed Application Packs 
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Figure 4–11 Schema Creator Utility while ins ta lling Subs equent Ap plication Pack 

 
 

 

3. Select the Atomic User, on which you want to install the Application Pack. 
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Figure 4–12 Schema Creator Utility while ins ta lling Subs equent Ap plication Pack 

 

On successful execution of schema creator utility, the console displays the 
following status message: 

Success. Please proceed with the installation. 
 
 

No te : 

• See the log file in OFS_ALM_PACK/schema_creator/logs directory 
for execution status. 

• See the log file sysdba_output_scripts.log for execution status 
if executed in offline mode. This log would be empty if there are 
no errors in the execution. 

• If there are any errors, contact Oracle Support Services. 
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Installing the OFS ALM Application Pack 
This section provides instructions to install the OFS ALM Application Pack depending 
on the mode of installation. 

This section includes the following topics: 

• Installing in SILENT Mode 

• Installing in GUI Mode 

• Verifying the Log File 
 

No te : The Schema Creator job needs to be run first, if you are 
performing OFS ALM 8.0.6 fresh installation on an existing Pack. It 
will append the new artifacts in the existing instance. 

 

 

Installing in SILENT Mode 

In the SILENT Mode Installation, you must configure the product XML files and 
follow instructions in the command prompt. 

To install OFS ALM in SILENT mode, follow these steps: 

1. Log in to the system as non-root user. 

2. Identify a directory for installation and set the same in the user .profile file as 
follows: 

FIC_HOME=<OFSAA Installation Directory> 

export FIC_HOME 

3. Execute the user .profile. 

4. Navigate to OFS_ALM_PACK directory. 

5. Edit the OFS_ALM_PACK/conf/OFS_ALM_PACK.xml to enable the product licenses. 
Update the attribute ENABLE=YES/NO in OFS_ALM_pack.xml for licensing the 
App in the pack. 

 

No te : See Configuring <<APP Pack>>_PACK.xml File section for 
details on configuring this XML file. 

Update OFS_ALM_PACK.XML, set the attribute “ENABLE=YES” of 
<APP_ID> tag for applications to be enabled during installation. If 
any application has mentioned OFS_ALM as PREREQ in the <APP_ 
ID> tag, set the attribute “ENABLE=YES” for OFS_ALM. 

 

6. Edit the OFS_ALM_PACK/schema_creator/conf/OFS_ALM_SCHEMA_IN.xml file to set 
the appropriate attribute values. 

Include INFODOM = “<Infodom Name>” in OFS_ALM_SCHEMA_IN.xml file. 

 

No te : See Configuring <<APP Pack>>_SCHEMA_IN.xml File 
section for details on configuring this XML file. 

 

 

7. Edit the OFS_ALM_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml file to set the 
appropriate infrastructure installation attribute values. 
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No te : 

This step can be ignored if an installation of OFSAA 8.0.0.0.0 already 
exists. 

 

8. Execute the schema creator utility. 

 

No te : 

This step is mandatory and should be executed before every 
OFSAA Application Pack installation. 

Ensure to execute with -s option in Online/Offline mode. 

For more information, see Executing the Schema Creator Utility. 

 

9. Rename the SILENT.template file in the installer as SILENT.props. 

10. In the console, navigate to the path OFS_ALM_PACK/bin. Enter the following 
command in the console to execute the application pack installer with Silent 
option. 

./setup.sh SILENT 

11. Enter the Infrastructure Application /Database component FTP/SFTP password 
value, when prompted at the command prompt. 

 

Table D–2 Cons ole Prompts - Silent Mode ins talla tion  
 

Cons ole Prompts Us er Inputs 

Please OFSAA 
Processing Tier 
FTP/SFTP password 

Enter the password to access processing tier directory in 
the application server. 

Note: In case the prompt reads as follows, enter the 
username/ password for accessing the product Staging/ 
Metadata Repository FTPSHARE 

• Kerberos username [user] 

• Kerberos password for user: 

 

12. Enter Always, when prompted to add host key fingerprint. 

The OFSAAI License Agreement is displayed. 

13. Enter Y/y to accept the License Agreement. 

14. Enter the passwords for default Infrastructure administrator and authorizer users. 
 

No te : The installation process continues on the console. Do not close 
the console until the installation process is complete. 

 

 

15. The following message is displayed in the console: 

Installation completed… 

16. On completion of installation, see the installation log files. 
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For more information, see Verifying the Log File. 

17. Install the patches listed in the following table. Refer to the Description column for 
details: 

 

Patch Nu mber Typ e De s cription 

27938294 Mandatory one-off patch Refer to the Readme available with the patch for 
further instructions on installing the patch. 

28079607 Mandatory one-off patch Refer to the Readme available with the patch for 
further instructions on installing the patch. 

28033582 Mandatory compatibility 
patch 

Enables you to upgrade selected packs in your 
OFSAA instance to 8.0.6.0.0 and makes the 
existing packs from earlier versions compatible 
with 8.0.6.0.0. Applying this patch resolves 
compatibility issues. 

 
18. DMT migration utility is available as part of the installer to migrate the DMT 

metadata (PLC/Data Source/Data Mapping/Data File Mapping)  to be persisted 
in tables instead of XML. To identify when to migrate, what/how to migrate, and 
how to handle migration issues, see OFSAA DMT Metadata Migration Guide. 

 

No te : Execute the DMT Migration Utility to manually migrate the 
DMT metadata of the Applications which are not upgraded to 
8.0.6.0.0. 

 

 

19. Perform the steps mentioned in Post Deployment Configurations section. 

20. For enabling Transparent Data Encryption (TDE), see Configuring TDE, Data 
Redaction and the Corresponding Settings in OFSAA. 

21. For enabling Data Redaction, see Data Redaction section under Data Security and 
Data Privacy chapter in OFS Analytical Applications Infrastructure 
Administration Guide 8.0.6.0.0. 

 

No te : Download and install patch for Bug 21160684 if installing this 
release of the OFS ALM Application Pack version 8.0.0.0.0 on Java 8. 
For more information, refer Configurations for Java 8. This patch is 
not required if an OFSAA instance already exists and is configured for 
Java 8. 

 

 

Silent.props File 

SILENT installation is achieved via a properties file [Silent.props] that must be 
updated with proper values, before attempting to install using the silent mode. 

 

No te : Do not install the new applications in the same segment if the 
pre-installed applications use run management. 

 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
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The following table lists all the properties that need to be specified: 

 

 
Property Name  

De s cription of 
Property 

 
Permis s ible values 

 
Comments 

LOG_MODE Mode for logging 1= General 
0 = Debug 

Optional; 
Default : 0 

SEGMENT_1_CODE Segment Code Not Applicable MANDATORY 
Note: The Segment 
Code should be in 
upper case. 

APPFTP_LOG_ 
PATH= 

Infodom Maintenance 
log path (to be 
created) for the new 
Infodom for applayer 

Not Applicable # Mandatory if this an 
App Layer 
Installation and if you 
want to create a new 
infodom 
# That is, you have 
specified INSTALL_ 
APP=1 and 
INFODOM_TYPE=0 

DBFTP_LOG_PATH Infodom Maintenance 
log path (to be 
created) for the new 
Infodom for DBLayer 

Not Applicable # Mandatory if this an 
App Layer 
Installation and if you 
want to create a new 
infodom 
# That is, you have 
specified INSTALL_ 
APP=1 and 
INFODOM_TYPE=0 

OBI_HOST Host Name of the 
OBIEE Server 

Not Applicable  

OBI_PORT Port Number of the 
OBIEE Server 

Not Applicable  

OBI_CONTEXT Context Name of the 
OBIEE Server 

Not Applicable  

UPLOAD_MODEL If you want to 
perform Model 
Upload 

0 = No 
1 = yes 

 

MODEL_TYPE Released data model 
or Customized data 
model 

0 = released 
1 = customized 

 

DATAMODEL Path for the 
customized data 
model 

Not Applicable # Mandatory only if 
you want to upload 
the customized data 
model 
# That is, you have 
specified MODEL_ 
TYPE=1 

DM_DIRECTORY File name for the 
customized data 
model 

Not Applicable # Mandatory only if 
you want to upload 
the customized data 
model 
# That is, you have 
specified MODEL_ 
TYPE=1 
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Property Name  

De s cription of 
Property Permis s ib le values Comments 

 

ETL_APPSRC_TYPE Create new ETL 
App/Src pair or use 
an existing one 

0 = New 
1 = Existing 

# Mandatory if this an 
AppLayerinstallation 
# That is, you have 
specified INSTALL_ 
APP=1 
# 0 = If you want to 
create a new ETL 
app/src pair 
# 1 = If you want to 
use an existing pair 

ETL_APP_1_DESC Description for the 
ETL App 

Not Applicable # Mandatory if you 
want to create new 
ETL app/src pair 
#That is, you have 
specified ETL_ 
APPSRC_TYPE=0 

ETL_SRC_1_1_DESC Description for the 
ETL Staging source 
description 

Not Applicable # Mandatory if you 
want to create new 
ETL app/src pair 
#That is, you have 
specified ETL_ 
APPSRC_TYPE=0 

ETL_SRC_1_2_DESC Description for the 
ETL Processing source 
description 

Not Applicable # Mandatory if you 
want to create new 
ETL app/src pair 
#That is, you have 
specified ETL_ 
APPSRC_TYPE=0 

ETL_APP_1_NAME ETL application name Not Applicable This is for App Layer 
installation 

ETL_SRC_1_1_NAME ETL Staging source 
name 

Not Applicable This Source must be 
mapped to the above 
ETL Application 

ETL_SRC_1_2_NAME ETL Processing source 
name 

Not Applicable This Source must be 
mapped to the above 
ETL Application 

 

Installing in GUI Mode 
 

No te : Ensure that you have followed the steps as mentioned in the 
Configuring for GUI Mode Installation section prior to proceeding 
with the next steps. 

 

 

1. Log in to the system as non-root user. 

2. Identify a directory for installation and set the same in the user .profile file as the 
following: 

FIC_HOME=<OFSAA Installation Directory> 

export FIC_HOME 

3. Execute the user .profile file. 

4. Navigate to the path: OFS_ALM_PACK. 
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5. Edit the OFS_ALM_PACK/schema_creator/conf/OFS_ALM_SCHEMA_IN.xml file to set 
the appropriate attribute values. 

 

No te : See Configuring <<APP Pack>>_SCHEMA_IN.xml File for 
details on configuring this XML file. 

 

 

6. Execute the schema creator utility. 

 

No te : This step is mandatory and should be executed before every 
OFSAA Application Pack installation. 

See Executing the Schema Creator Utility for more details. 

 

7. In the console, navigate to the path OFS_ALM_PACK/bin. Execute the following 
command in the console. 

./setup.sh GUI 

 
 

 

No te : See the console for any errors during Pre-install checks. 
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Figure 4–13 In itia lization Window  

 

 

 

8. The general License Agreement is displayed. Select I accept the terms of the 
License Agreement option. 

 
Figure 4–14 Licens e Ag reement 

 

9. Click Next. 

The Financial Services Advanced Analytics Infrastructure Application Pack details 
window is displayed. 
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Figure 4–15 Financial Services Ad vanced An alytics In fra s tructure Ap plication Pack De ta ils 

 

 

 

10. Select the product(s) for which you have already obtained the license(s). 

 

No te : Financial Services Analytical Applications Infrastructure is 
selected by default. 

 

 

11. Click Next. 

The Application Pack License Agreement window is displayed. 

 
Figure 4–16 Financial Services Ad vanced An alytics In fra s tructure Ap plication Pack Licens e 

Agreement Window  

 
 

 

12. Select I accept the terms of the License Agreement option. 

13. Click Next. 
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The Pre Installation Summary window is displayed. 

 
Figure 4–17 Pre-Ins talla tion Summary 

 
 

 

14. Click Next. 

The Manage Information Domains window is displayed. 

 
Figure 4–18 Manage In fo rmation Do mains window 

 
 

 

15. The default information domain name for this Application Pack is OFSALMINFO. 

Double-click the Information Domain Name field to edit. 
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No te : For subsequent Application Pack installation on the same 
information domain, the Information Domain Name is not editable. 

Permissible length is 16 characters and only alphanumeric characters 
are allowed. No special characters are allowed. 

 

16. Click Next. 

The User Installation Directory window is displayed. 

 
Figure 4–19 Us er Ins ta lla tion Dire ctory 

 
 

 

No te : The User Installation Directory path is auto-populated from 
the path you have set in the user .profile file in Step 2. 

 

 

17. Click Next. 

The OFSAA Infrastructure Server Details window is displayed. 
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Figure 4–20 OFS AA In fra s tructure Server De ta ils 

 
 

 

18. Enter the IP address or hostname of the Database Server. 

 

No te : The OFSAAI Server IP/Hostname is auto-populated by 
default. 

 

 

19. Click Next. 

The Web Application Server window is displayed. 

 
Figure 4–21 Web Ap plication Server 

 
 

 

20. Select the appropriate Web Application Server. The options are Tomcat, 
WebSphere, and WebLogic. 

21. Click Next. Based on the selection, corresponding windows are displayed. 

• For WebSphere: The WebSphere Setup Details window is displayed. 
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Figure 4–22 Web Sphere Setup De ta ils 

 
 

 

Enter the installation path (up to the Node Cell Name directory) of WebSphere 
server. The format is <WebSphere profile 
directory>/installedApps/<NodeCellName>. 

• For Tomcat: The Absolute Tomcat Path window is displayed. 

 
Figure 4–23 Absolute Tomcat Path 

 
 

 

Enter the Tomcat installation path (till/webapps) where OFSAAI is deployed. 

• For WebLogic: The WebLogic Home window is displayed. 
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Figure 4–24 Web Logic Ho me 

 

 

Enter the WebLogic home directory path. 

 
Figure 4–25 Web Logic Setup Details 

 

 

Enter the path of the Weblogic domain directory and click Next. 

22. The OLAP Details window is displayed. 
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Enter 1 if you want to configure OFSAA OLAP feature using Oracle Hyperion 
Essbase. By default, it is set to 0. 

23. Click Next. The Web Server Details window is displayed. 

 
 

24. By default, ENABLE HTTPS is selected. If you want to install without HTTPS 
enabled, click the checkbox to remove the selection and proceed with the 
installation. Enter the Web Server (HTTP Server) Port, Context name for 
deployment, and Local path to any folder on the Web Application Server 
(Tomcat/Websphere/Weblogic). 

25. Click Next. The Database Details window is displayed. 

 

Figure 4–28 Da tabase Details 
 

 

26. Enter Oracle SID / Service_Name. 

 

Note: 

• The JDBC URL, CONFIG SCHEMA USER ID, Oracle 
Configuration Schema Password, and ABSOLUTE DRIVER PATH 
are auto-populated. 

• ABSOLUTE DRIVER PATH can be the path where Oracle DB 
client is installed or JDBC driver is installed. For example, 
/scratch/oracle/app/oracle/product/11.2.0/client_ 

1/jdbc/lib 

27. Click Next. The Ports Configuration window is displayed. 

 
Figure 4–29 Ports Con fig uration 
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No te : The Java Port, Native Port, Agent Port, ICC Server Port, and 
ICC Native Port fields are auto-populated. You can also modify the 
Ports settings. 

 

28. Click Next. The SFTP Details window is displayed. 

 
Figure 4–30 SFTP De ta ils 

 
 

 
 

No te : 

• ENABLE SFTP and FILE TRANSFER PORT details are 
auto-populated. 

• Ensure that the system, on which the OFSAA Infrastructure is 
installed, has FTP or SFTP enabled. 

• You can also modify the SFTP settings 

29. Click Next. The OFSAAI Post Install Details window is displayed. 

 
Figure 4–31 OFS AAI Pos t Ins ta ll De ta ils 
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30. Enter the FTPSHARE path. This is same as the OFSAA Staging/Metadata 
directory. 

 
 

 

31. Enter the FTP/SFTP User ID and Password for FTPSHARE directory access. 

 

No te : The transfer of data (files) between the OFSAA Server and the 
Web Application Server happens through FTP/ SFTP. Ensure the 
necessary host configurations are made for a successful handshake. 
For more details, see Adding FTP/SFTP Configuration for File 
Transfer. 

 

 

32. Click Next. The Pre-installation Summary window is displayed. 

 
Figure 4–32 Pre-ins talla tion Summary 
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33. Click Install. The Installing OFSAA Infrastructure window is displayed. 

 

Figure 4–33 Ins ta lling OFS AA In fra s tructure 

 
 

 

 

No te : Anytime during the installation you can click Cancel to stop 
the installation. Once completed, the INSTALLATION SUMMARY 
window is displayed. 

 

 

34. Once completed, the INSTALLATION SUMMARY window is displayed. 

 
Figure 4–34 INS TALLATION S UMMARY 
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The summary window displays the number of Fatal Errors, Errors, Debug 
Statements, Informations, and Warnings along with the location of log files. 

35. Click Next. The Installation Complete window is displayed. 

 

Figure 4–35 Ins tallation Complete 

 
 

36. Click Done. 
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37. Click Next. 

Select the log mode for this installer. If Debug is selected, the Passwords will be 
printed in the log file. 

 

 
 

38. Click Next. 

 
 

 

Application Server ftpshare log path and database server ftpshare log path. 

Permissible length for information domain is maximum 10 characters and only 
alphanumeric characters allowed. No special characters are allowed. 

39. Click Next. 
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Confirm whether you want to perform the Model upload. 

40. Click Next. 

If the option Customized Data Model was selected, the next window is displayed 
prompting the user to select the customized data model located in the machine. 
Select the Customized data model file from the server. 

 

No te : If you have installed an application pack (for example PFT) 
and performed the data model customization, then you should merge 
the data model before installing another application pack (for example 
ALM). 

If the data model merge is not performed before installing second 
pack, then data model customization changes will be lost. 

 

41. Click Next. 
 

 

42. The following panel displays pre-model upload details. Verify the details before 
proceeding to the next step. 
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No te : If Heap Memory Warning is displayed, then click on Back, and 
update your .profile entry with required heap memory size. 

1. Open a new session in Putty. 

2. Shutdown Reveleus server using $FIC_ 

HOME/ficapp/common/FICServer/bin/ 

reveleusshutdown.sh. 

3. Update the X_ARGS_APP entry in .profile following example. 

Example: 

X_ARGS_APP="-Xms2g -Xmx18g 

-XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=1024M 

-XX:+UseParallelOldGC -XX:+DisableExplicitGC" 

4. Run .profile. 

5. Start Reveleus using $FIC_ 
HOME/ficapp/common/FICServer/bin/ startofsaai.sh 

stopofsaai.sh. 

 

 

 

43. Click Next to proceed for model upload. 
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This process will take some time depending on the size of the data model and 
available physical memory in the environment. You will not be able to take any 
further action on the screen, until the model upload is complete. Note that this 
process cannot be rolled back. 

If the model upload fails, then a pop-up message with relevant error and the log 
file path is displayed. 

Review errors and take relevant action. Continue with this step until the model 
upload is successful and the installer takes you to next step. 

Few common errors during model upload are: 

• Error while getting the Erwin File path. 

Possible reason/resolution: Restart the FICServer. 

• Error in Upload Operation: “FAILED WHILE SUPER CATEGORY - SUB 
CATEGORY RELATIONS HANDLINGDELETING”. 

Possible reason/resolution: Incorrect Erwin.xsl file version in $FIC_APP_ 
HOME/common/FICServer/conf directory. 

 

No te : Incremental/Sliced model upload might give errors if there 
are NOT NULL columns being added to a table that already has rows 
or if the columns that are being dropped have values. Check the data 
model changes excel file for any such cases. In such a case, take a 
backup of the table and truncate the table. Insert records back into the 
table with a default value for the NOT NULL column. 

 

 

Navigate to the previous screen and proceed with the steps mentioned above. 

 

 

44. Click Next. 
 

The Pre Setup Information screen requests for setup information. 

The following panel seeks input from the user on whether to create new ETL 
application/source pair or use an existing one. 

45. Click Next to continue. 
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If the option New application/source pair was chosen then the following panel is 
displayed seeking the application and source name for creation of the same. 

Specify all the details required for application and source creation. 

46. Click Next to proceed. 
 

 
 

This will create application and source within OFSAAI. Source model will also be 
generated. This process will take some time depending on the number of entities / 
attributes in the atomic schema. This step cannot be rolled back. 

47. Click Next. 

The Pre-installation summary window is displayed. Verify all details and proceed. 
Click Install to proceed. 

 
 

 

A confirmation message box is displayed. Click OK to continue. 

 

This panel displays the installation process. Wait until it completes. 

 

The following screen displays the completion of installation of the Oracle Financial 
Services Asset Liability Management Analytics Product Setup. 

Click Done. 
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No te : The installation process continues on the console. Do not close 
the console until the installation process is complete. 

 

 

48. Click Done to exit. 

 

 
49. Install the patches listed in the following table. Refer to the Description column for 

details: 
 

Patch Nu mber Typ e De s cription 

27938294 Mandatory one-off patch Refer to the Readme available with the patch for 
further instructions on installing the patch. 

28079607 Mandatory one-off patch Refer to the Readme available with the patch for 
further instructions on installing the patch. 
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Patch Nu mb er Type De s cription 

28033582 Mandatory compatibility 
patch 

Enables you to upgrade selected packs in your 
OFSAA instance to 8.0.6.0.0 and makes the 
existing packs from earlier versions compatible 
with 8.0.6.0.0. Applying this patch resolves 
compatibility issues. 

 

50. DMT migration utility is available as part of the installer to migrate the DMT 
metadata (PLC/Data Source/Data Mapping/Data File Mapping)  to be persisted 
in tables instead of XML. To identify when to migrate, what/how to migrate, and 
how to handle migration issues, see OFSAA DMT Metadata Migration Guide. 

 

No te : Execute the DMT Migration Utility to manually migrate the 
DMT metadata of the Applications which are not upgraded to 
8.0.6.0.0. 

 

 

51. Perform the steps mentioned in Post Installation Configurations section. 

52. For enabling Transparent Data Encryption (TDE), see Configuring TDE, Data 
Redaction and the Corresponding Settings in OFSAA. 

53. For enabling Data Redaction, see Data Redaction section under Data Security and 
Data Privacy chapter in OFS Analytical Applications Infrastructure 
Administration Guide 8.0.6.0.0. 

 
Ve rifying the Log File 

Verify the following logs files for more information: 

• See the Pack_Install.log file located in the OFS_ALM_PACK/logs/ directory for 
OFS ALM Application Pack installation logs. 

• See the log file(s) located in the OFS_ALM_PACK/OFS_AAI/logs/ directory for 
Infrastructure installation logs. 

• See the OFSAAInfrastucture_Install.log file located in the $FIC_HOME 
directory for Infrastructure installation logs. 

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
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Upgrading the OFS ALM Application Pack 
 

 

 

 

  5 
Up gradin g the OFS ALM Application Pack 

 
This chapter includes the following topics: 

• Upgrading the OFS ALM Application Pack 

 

 
 

No te : Release 8.0.6.0.0 of OFS ALM Application pack is not fully 
backward compatible with earlier versions of OFSAA applications. 
You can either upgrade all of your applications from existing 8.0.x 
versions to 8.0.6.0.0 version or choose to upgrade only selective 
application packs to v8.0.6.0.0. In the case of the latter, you must also 
apply the forthcoming compatibility patches for the required 
application packs, so that the remaining application-packs can 
continue to be at their pre-8.0.6.0.0 versions. 

Compatibility patch for OFS ALM: 28097119 

You can download this patch from the Patches & Updates tab of 
http://support.oracle.com/ portal. For more information about the 
application of this patch, refer to the Readme files. 

To run the DMT migration for 'T2T_OPTIONS_CONTRACT', follow these 

steps: 

1. Navigate to $FIC_HOME/utility/DMT/Migration/bin. 

2. Execute below command: ./DMTUpgradeUtility_806.sh 
ONLY_DEFINITION_AS_VERSION <METADATA_ 

TYPE><INFODOM_NAME> <DEFINITION_NAME> 

Here, 

• <METADATA_TYPE> can be DMT_PLC ( PLC or DT) or 

DMT_DM( Data Mapping and Data File Mapping ) 

• <INFODOM_NAME> can be: 

DMT_PLC- Infodom in which the definition is defined. 

DMT_DM-Any valid Infodom. 

• <DEFINITION_NAME> can be: 

DMT_PLC-Any valid Definition Name 

DMT_DM-<Application Name>~<Source 
Name>~<Definition Name> 

Example: 

./DMTUpgradeUtility_806.sh ONLY_DEFINITION_AS_VERSION 
DMT_DM Infodom2 App1~Src1~T2T 

For more information, see OFSAA DMT Metadata Migration Guide. 

 

http://support.oracle.com/
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
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Upgrading the OFS ALM Application Pack 
Refer to the following instructions to download, extract, install, and configure this 
release: 

 

 
 

No te : 

• If you are currently on Release 8.0.0.x.x or 8.0.1.x.x of the OFS ALM, then 
you need to first upgrade to Release 8.0.2.x.x before upgrading to 
8.0.6.0.0. 

• Upgrade of ALM Application Pack 8.0.6.0.0 requires the upgrade of 
related packs like the PFT pack and PM pack to 8.0.6.0.0. If these packs 
are not upgraded, the applications within these packs will be disabled 
from the User Interface. For Example: 

 

VERSION PACK ID COMPATIBLE PACK ID 

8.0.6.0.0 OFS_ALM_PACK OFS_PFT_PACK 

8.0.6.0.0 OFS_ALM_PACK OFS_PM_PACK 

1. To download and copy the OFS ALM Application Pack v8.0.6.0.0 archive file, see 
Downloading and Copying the OFS ALM Applications Pack Installer and 
Mandatory Patches section. 

 

No te : The archive files are different for every operating system like 
AIX, Solaris, and RHEL/Oracle Linux. 

 

 

2. Log in to the OFSAA Server with user credentials that was used to install OFSAA. 

3. Shut down all the OFSAAI Services. For more information, see the Starting/ 
Stopping Infrastructure Services section. 

4. Execute the following command: 

chmod -R 750 $FIC_HOME 

5. If you have Unzip utility, skip to the next step. Download the Unzip utility (OS 
specific) and copy it in Binary mode to the directory that is included in your 
PATH variable, typically $HOME path or directory in which you have copied the 
8.0.6.0.0 installer. 

• Uncompress the unzip installer file using the command: 

uncompress unzip_<os>.Z 

 

No te : In case you notice an error message “uncompress: not found 
[No such file or directory]” when the package is not installed, contact 
your UNIX administrator. 

 

 

• Give EXECUTE permission to the file using the command: 

chmod 751 OFS_ALM_80600_<OperatingSystem>.zip 

6. Extract the contents of the Oracle ALM Application Pack 8.0.6.0.0 installer archive 
file using the following command: 

unzip_<os> <name of the file to be unzipped> 

7. Give EXECUTE permission to the archive file. Navigate to the path OFS_ALM_ 
80600_<OperatingSystem>.zip and execute the command: 

chmod -R 750 OFS_ALM_80600_<OperatingSystem> 
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8. Rename the SILENT.template file in the installer as SILENT.props. 

 

9. Configure Silent.Props file for following parameters: 
 

 
Property Name  

De s cription of 
Property 

 
Permis s ible values 

 
Comments 

UPLOAD_MODEL If you want to 
perform Model 
Upload 

0 = No 
1 = Yes 

Mandatory 
Select “1” to perform 
the Model Upload 
Select “0” to skip 
Model Upload 

MODEL_TYPE Released data model 
or Customized data 
model 

0 = Released 
1 = Customized 

# Mandatory only in 
the case of uploading 
the data model 
If the UPLOAD_ 
MODEL option is 
selected as “1”, then 
you can choose to 
upload Released 
Model (0) or 
Customized Model 
(1). 

DATAMODEL Path for the 
customized data 
model 

Not Applicable # Mandatory only in 
the case of uploading 
the Customized data 
model 
# Option selected for 
MODEL_TYPE=1 

DM_DIRECTORY File name for the 
customized data 
model 

Not Applicable # Mandatory only in 
the case of uploading 
the Customized data 
model 
# Option selected for 
MODEL_TYPE=1 

 
10. Execute setup.sh file using the following command: 

./setup.sh SILENT 

Verify if the release is applied successfully by checking the log files generated in 
the installation folder as mentioned below: 

• OFS_ALM_PACK/OFS_AAAI_PACK/logs/OFSAAIUpdate.log for 
Infrastructure installation log file. 

• OFS_ALM_PACK/OFS_ALM /logs/OFS_ALM_installation.log for OFS 
ALM Application Pack installation log file. 

You can ignore following errors: 

ORA-00001 

ORA-00955 

ORA-02260 

ORA-01430 

Error Message->DMT.DUPLICATE_RECORD_FOUND 

Error Message->COMMONOBJECT.SAVE_FAILED 

errors in the log file. In case of any other errors, contact Oracle Support. 

11. Install the consolidated one-off patch 27938294. Refer to the Readme available 
with the patch for further instructions on installing the patch. 
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12. Install the mandatory one-off patch 28079607. Refer to the Readme available with 
the patch for further instructions on installing the patch. 

13. DMT migration utility is available as part of the installer to migrate the DMT 
metadata (PLC/Data Source/Data Mapping/Data File Mapping)  to be persisted 
in tables instead of XML. To identify when to migrate, what/how to migrate, and 
how to handle migration issues, see OFSAA DMT Metadata Migration Guide. 

14. For more information on securing your OFSAA Infrastructure, see the Security 
Guide in OHC Documentation Library. 

15. After successful installation, follow these steps: 

Log in to the web application server and clear the application cache. Navigate to 
the following path depending on the configured web application server and delete 
the files. 

• Tomcat 

<Tomcat installation 

folder>/work/Catalina/localhost/<Application 

name>/org/apache/jsp 

• WebLogic 

<Weblogic installation location>/domains/<Domain 

name>/servers/<Server name>/tmp/_WL_user/<Application 

name>/<auto generated folder>/jsp_servlet 

In case of WebLogic version 12.2.x.x, delete the folder named ".WL_internal" 
present in the path <WebLogic installation location>/user_ 
projects/domains/< Domain name >/applications/<context_ 
name>.ear/META-INF/", if it exists. 

• WebSphere 

<Websphere installation 

directory>/AppServer/profiles/<Profile name>/temp/<Node 

name>/server1/<Application name>/<.war file name> 

16. Add umask 0027 in the .profile of the UNIX account which manages the 
WEB server to ensure restricted access permissions. 

17. Restart all the OFSAAI services. For more information, see the Starting/ Stopping 
Infrastructure Services section. 

18. Generate the application EAR/WAR file and redeploy the application onto your 
configured web application server. For more information on generating and 
deploying EAR / WAR file, see the Creating and Deploying EAR/ WAR File 
section. 

19. If OFS Enterprise Modeling is licensed and enabled in your OFSAA instance, 
uninstall OFSAAIRunner package and reinstall the latest available 
OFSAAIRunner package. For more details, see the Configuring Oracle R 
distribution and Oracle R Enterprise (ORE). 

20. For enabling TDE, see Configuring TDE in case of Upgrade section in Configuring 
TDE, Data Redaction and the Corresponding Settings in OFSAA 

https://docs.oracle.com/cd/E60202_01/homepage.htm
https://docs.oracle.com/cd/E60202_01/homepage.htm
https://docs.oracle.com/cd/E60202_01/homepage.htm


3-56 OFS ALM Application Pack Installation and Configuration Guide 

Upgrading the OFS ALM Application Pack 
 

 

 

Removing Old Struts Libraries 

After you upgrade the ALM Pack, the Struts libraries need to be checked and the older 
version of the files should be removed mandatorily. Use the following procedure to 
remove the old Struts libraries: 

Navigate to the path $FIC_WEB_HOME/webroot/WEB-INF/lib and perform the 
following checks: 

1. If both struts2-core-2.3.32.jar and struts2-core-2.3.34.jar exist, 
then delete the file struts2-core-2.3.32.jar file. 

2. If both xwork-core-2.3.32.jar and xwork-core-2.3.34.jar exist, then 
delete the file xwork-core-2.3.32.jar file. 

3. If both ognl-3.0.19.jar and ognl-3.0.21.jar exist, then delete the file 

ognl-3.0.19.jar file. 
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Post Installation Configurations 

 
On successful installation of the Oracle ALM Application Pack, follow these 
post-installation steps: 

This chapter includes the following sections: 

• Configuring the excludeURLList.cfg File 

• Configuring Resource Reference 

• Starting OFSAA Infrastructure Services 

• Adding TNS entries in the TNSNAMES.ORA File 

• Configuring Oracle R distribution and Oracle R Enterprise (ORE) 

• Creating and Deploying the Application Pack Web Archive 

• Accessing the OFSAA Application 

• Performing Post Deployment Configurations 
 

No te : Ensure to clear the application cache prior to the deployment 
of Applications Pack Web Archive. This is applicable to all Web 
Servers (WebSphere, WebLogic, and Tomcat). For more information, 
see Clearing Application Cache section. 

 

 

Configuring Resource Reference 
Configure the resource reference in the Web Application Server configured for OFSAA 
Applications. See Configuring Resource Reference in Web Application Servers for 
details on configuring the resource reference in WebSphere, WebLogic, and Tomcat 
Application Servers. 

 

Starting OFSAA Infrastructure Services 
Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA 
Applications. See to the Starting/ Stopping Infrastructure Services for details on 
Start/Stop OFSAA Services. 

 

Ad ding TNS entries in the TNS NAMES .ORA File 
Add TNS entries in the tnsnames.ora file, for every schema created for the 
Application Pack. 

To find the tnsname for the entries, follow these steps: 
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1. Log in to the application using System Administrator privileges. 

2. Navigate to System Configuration & Identity Management tab. 

3. Click Administration and Configuration, select System Configuration, and click 
Database Details. 

4. Expand Name to get the list of TNS entry names. 

5. Alternatively, you can connect to the CONFIG schema and execute the following 
query: 

select dbname from db_master where dbname !='CONFIG' 

 

Configuring Oracle R distribution and Oracle R Enterprise (ORE) 
This section is applicable only if OFS Enterprise Modeling is licensed and enabled in 
your OFSAA instance. 

1. Install OFSAAIRunner Package. For more information, see Installing OFS AAAI 
Runner Package. If you have already installed the OFSAAIRunner package (as 
part of a previous installation), uninstall it. (For more information, see 
Uninstalling OFSAAI Runner Package section), and reinstall the latest available 
OFSAAIRunner package. 

2. Log in to the database with dba privileges and provide the following privilege to 
Configuration Schema: 

• RQADMIN by executing the command: 

GRANT RQADMIN TO <config_schema>; 

3. Log in to the database with DBA privileges and provide the following privileges 
to Atomic Schema: 

• CREATE MINING MODEL privilege (to execute the Data Mining models) by executing 
the command: 

GRANT CREATE MINING MODEL TO <atomic_schema>; 

 

Installing OFS AAAI Runner Package  

OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It 
is a prerequisite for executing models developed using R scripts. This package helps 
in: 

• Initializing inputs 

• Mapping framework variables to R objects 

• Configuring possible outputs of the script 

• Storing results back to the Database 

OFSAAIRunner package (OFSAAIRunner_1.0.0.tar.gz) is available under $FIC_DB_ 
HOME/lib. 

 

Prerequisite 

Oracle R & ORE must be installed on the Oracle Database server before installing the 
OFSAAIRunner package. 

Refer to the following instructions to install the OFSAAIRunner package: 
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1. Log in to the OFSAA Server. Navigate to the folder $FIC_DB_HOME/lib. 

2. Copy the file OFSAAIRunner_1.0.0.tar.gz in Binary mode to the Oracle Database 
Server. 

3. Log in to the Oracle Database Server with the user using which Oracle Database 
Server installation is done. 

4. Navigate to the directory where the file OFSAAIRunner_1.0.0.tar.gz is copied. 

5. Install the package by executing the command: 

ORE CMD INSTALL OFSAAIRunner_1.0.0.tar.gz 

Successful installation is indicated in the installation log as: 

* DONE (OFSAAIRunner) 

Making packages.html ... done 

 

No te : The OFSAAIRunner package is installed in 

/usr/lib64/R/library. 

 

6. Navigate to the directory $ORACLE_HOME/R/library and check whether the 
OFSAAIRunner package is listed there by executing the command: 

>library(OFSAAIRunner) 

>OFSAAIRunner:: and press TAB twice. 

This lists out all the functions. 

 

Uninstalling OFS AAI Runner Package 
 

No te : This procedure is required only if you are uninstalling OFSAAI 
Runner Package. 

 

 

Perform the following instructions to uninstall the OFSAAIRunner package: 

1. Log in to the Oracle Database Server with the same username, using which Oracle 
Database Server installation is done. 

2. Enter ORE in command prompt and execute the command: 

#ORE 

>remove.packages("OFSAAIRunner") 

3. To save the workspace image, enter the command: 

>q() 

4. Enter y when prompted to save the workspace image. 

Save workspace image? [y/n/c]: y 

5. Navigate to the directory $ORACLE_HOME/R/library and verify the package is 
not listed there by executing the command: 

ls –l 
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Configuring ORE Execution 

Perform the following step: to configure ORE execution: 

1. Add a TNS entry in tnsnames.ora file with TNS name same as that of value set for 
ORACLE_SID in the database server. 

 

No te : For the RAC database, follow the preceding configuration in 
all machines. 

 

 

Configuring Tomcat 

To stop generating static content with one print statement per input line, you need to 
configure the web.xml file. 

To configure the web.xml file, perform the following steps: 

1. Navigate to tomcat/conf directory. 

2. Edit web.xml file as follows: 

Set the mapped file parameter to False in the servlet tag mentioned with 

<servlet-name>jsp</servlet-name>. 

<init-param> 

<param-name>mappedfile</param-name> 

<param-value>false</param-value> 

</init-param> 
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Creating and Deploying the Application Pack Web Archive 
On successful installation of the OFSAA Application Pack, the web archive file is 
automatically generated. However, you need to deploy the generated web archive file 
on the Web Application Server. 

To identify the location of the generated web archive file and to generate and deploy 
the web archive file later, see Creating and Deploying EAR/ WAR File. 

 

No te : See the Oracle Financial Services Forms Manager User Guide 
for instructions on Creating and Deploying the Forms Manager Web 
Archive. 

 

 

Accessing the OFS AA Ap plication 
Prior to accessing the OFSAA application ensure the Internet Explorer Settings are 
configured. 

Refer to Accessing OFSAA Application for details on accessing the OFSAA 
Application on the successful deployment of the application web archive. 

 

Performing Pos t De ployment Con fig urations 
Prior to using the OFSAA Application perform the Post Deployment Configuration 
steps detailed in Post Deployment Configurations. 
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Starting or Stopping Infrastructure Services  

 
This section details how to start and stop Infrastructure services. This chapter covers 
the following topics: 

• Starting Infrastructure Services 

• Stopping Infrastructure Services 

 

Starting Infrastructure Services 
Once the installation of Infrastructure is completed successfully and the 
post-installation steps are completed, the servers must be started. Log on to each 
machine and run the .profile file. All servers mentioned must be started from the 
same shell encoding. The servers mentioned in this section are dependent on each 
other. It is mandatory to maintain the order in which the servers are started. Allow 
each of the servers to initialize completely before starting the next server. 

1. On the machine in which Infrastructure Application components have been 
installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the 
following command to start the Infrastructure Server. 

./startofsaai.sh 

 

 

No te : You can also start the Infrastructure Server by executing the 
command nohup ./ startofsaai.sh &. Starting the process 
using nohup and & will return the command prompt without having 
to wait till the process completes. However, this command cannot be 
used when you are starting the server for the first time or starting 
after changing the user password in the configuration database 
schema. 

 

 

2. Start ICC server: 

• On the machine in which Infrastructure default Application components have 
been installed, navigate to $FIC_HOME/ficapp/icc/bin 

• Execute the command: 

./iccserver.sh 

 

No te : Only Infrastructure Default Application Server can hold the 
ICC component. 
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3. Start Back-end Services: 

• On the machine on which Infrastructure Database components are installed, 
navigate to $FIC_DB_HOME/bin and execute the command to start Agent 
server: 

./agentstartup.sh 

Or 

• Start Back-end services using the command: 

nohup ./agentstartup.sh & 

 

No te : This agent internally starts the Router, Message Server, OLAP 
Data Server, and AM services. 

 

 

Starting Web Application Servers 

Start the Web Application Server depending on the type from the following table. 

 
Table 7–3 Webs erver s tartup options 

 

Startup Option  De s cription 

Starting WebSphere Profile On the machine in which WebSphere is installed, navigate to 
[Webshpere_Install_Directory] 

/AppServer/<profiles>/<profile name>/bin and execute the 
command: ./startServer.sh server1 

Starting WebLogic Domain On the machine in which WebLogic is installed, navigate to 
<WebLogic Installation directory>/user_ 

projects/domains/<domain name>/bin and execute the 
command: startWebLogic.sh -d64 

Note: If WebLogic is already running, access the WebLogic 
Admin Console. Stop and start the application <context 
name>.ear 

Starting Tomcat 
Application 

On the machine in which Tomcat is installed, navigate to 
<Tomcat_Install_ Directory>/bin and execute the command: 
./catalina.sh run 

 

Stopping Infrastructure Services  
To stop Infrastructure services, follow these steps: 

1. On the machine in which Infrastructure Application components are installed, 
navigate to $FIC_APP_HOME/common/FICServer/bin and execute the command:. 

./stopofsaai.sh 

2. To stop the ICC server, on the machine in which Infrastructure default Application 
components are installed, navigate to $FIC_HOME/ficapp/icc/bin and execute the 
command: 

./iccservershutdown.sh 

 

No te : Only Infrastructure Default Application Server can hold the 
ICC component. 
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Stopping Infrastructure Services 

 

3. To stop the Back-end server, on the machine in which Infrastructure database 
components are installed, navigate to $FIC_DB_HOME/bin and execute the 
command: 

./agentshutdown.sh 
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Accessing OFSAA Application 

 
This section details the steps to be performed to access OFSAA Application. 

 

Accessing the OFSAA Application 
1. From your system, open the browser and enter the URL in the following format: 

<scheme>://<IP address/ 

hostname>:<port>/<context-name>/login.jsp 

For example, https://192.0.2.2/ofsaa/login.jsp 

The OFSAA login window is displayed. 

 
Figure 8–1 OFSAA Login Window  

 

 

 
 

 
 

2. With the installation of every OFSAA Application Pack, there are two seeded user 
profiles configured in the system: 

SYSADMN - System Administrator 
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SYSAUTH - System Authorizer 

 

No te : For SYSADMN and SYSAUTH, the default password is 
password0. 
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3. Log in to the application using the "SYSADMN" User ID. (Note that, there is no "I" 
in the SYSADMN login USER ID). On the first login, you will be prompted to 
change the password. 
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OFSAA Landing Page 

 
This section includes the following topics: 

• OFSAA Landing Page for ALM Administrator 

• Enabling a Product within an Application Pack 

 

OFSAA Landing Page for ALM Administrator 
On successful authentication, the OFSAA Landing Page is displayed. This is a 
common landing page for all users until a preferred application landing page is set by 
the user in his preferences. 

The landing page includes multiple tabs and each tab has specific links to OFSAA 
Infrastructure and/or Application modules. The tabs and links are displayed based on 
the OFSAA Application accessed and the access roles mapped to the logged-in user. 

Each tab contains the LHS Menu and RHS Menu. The LHS Menu holds link(s) to 
modules in a tree structure. The RHS Menu holds link(s) to modules in a navigational 
window format. 

The following tabs are available in the Landing Page: 

• Applications Tab 

• Object Administration Tab 

• System Configuration and Identity Management Tab 

 

Applications Tab 

This tab lists the various OFSAA Applications that are installed in the OFSAA setup. 
The Select Application drop-down list displays the OFSAA Applications, based on 
the logged-in user and mapped OFSAA Application User Group(s). Links to related 
modules within Applications and Infrastructure are grouped appropriately to 
maintain a unified experience. 

 

Object Administration Tab 

This tab lists the various OFSAA Information Domains created in the OFSAA setup. 
The Select Information Domain drop-down list displays the OFSAA Information 
Domains based on the logged-in user and mapped OFSAA Application User Group(s). 
Links to modules that enable object traceability and migration of objects are grouped 
in this tab. 
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System Configuration and Identity Management Tab  

This tab lists the OFSAA Infrastructure System Configuration and Identity 
Management modules. These modules work across Applications/ Information 
Domains and hence there are no Application and Information Domain drop-down 
lists in this tab. Links to modules that allow the maintenance of setup installation and 
identity management tasks are grouped together in this tab. 

 

No te : The navigation path differs from Application to Application. 
That is, based on the selected Application, the navigation varies. 

For more details on how to operate on each tab, see OFSAAI User 
Guide available in OTN. 

 

Enabling a Product within an Application Pack 
You can also enable a product/ application within an application pack 
post-installation at any point of time. 

To enable a product through the application UI, follow these steps: 

1. Log in to the application as SYSADMN user or any user with System 
Administrator privileges. 

2. Navigate to System Configurations & Identity Management tab, expand 

Administration and Configuration, and select System Configuration. 

3. Click Manage OFSAA Product License(s). The Manage OFSAA Product License(s) 
window is displayed. 

 
Figure 9–1 Manage the OFSAA Product Licens e(s ) window  

 

4. Select an Application pack to view the products in it. The products are displayed 
in the Products in the Application Pack grid. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Enabling a Product within an Application Pack 

 

Figure 9–2 Manage OFS AA Product Licens e(s ) window- Part 2 

 

5. Select the checkbox to enable a product within the Application Pack which is not 
enabled during installation. 

6. Click VIEW LICENSE AGREEMENT to view the license information. The License 
Agreement section is displayed. 

 
Figure 9–3 Licens e Ag reement 

 

7. Select the option I ACCEPT THE LICENSE AGREEMENT and click ENABLE. A 
pop-up message confirmation is displayed showing that the product is enabled for 
the pack. 

 

 

No te : 

n To use the newly enabled product, you need to map your 
application users to the appropriate product specific User_ 
Group(s) and authorize the actions by logging in as System 
Authorizer. 

n For more information, see the Mapping/Unmapping Users 
section in the OFSAAI User Guide available on OTN. 

n To identify the newly enabled product specific UserGroups/ 
Application Pack specific User_Groups, refer to the respective 
Application Pack specific Installation and Configuration Guide/ 
User Manual. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Post Deployment Configurations  

 
This section provides detailed information about the Post Deployment Configuration. 

 

Post Deployment Configurations 
This section lists the various configurations to be completed before you use the 
OFSAA Applications. 

• Deploying the Application 

• Logging as System Administrator 

• Creating Application Users 

• Mapping Application User(s) to User Group 

• Changing ICC Batch Ownership 

• Mapping ICC Batch Execution Rights to User 

• Saving Post- Load Change Transformations 

 

Deploying the Application 

This section provides the details on ALM and ALMBI application deployment. It 
covers the following topics: 

• Deploying the ALM Application 

• Deploying the ALMBI Application 
 

No te : You must update Security Patches post application 
installation. For more information, see the Support ID 2306980.1. 

 

 

Deploying the ALM Application 

To deploy the ALM application, follow the steps: 

The Oracle Financial Services Analytical Applications Infrastructure Application 
Server is started using startofsaai.sh. This file can be edited for setting customized 
memory settings, garbage collector settings depending on the available hardware 
configuration. Please raise an SR in support.Oracle.com if you have any queries 
related to EPM applications. 

Once the installation of Oracle Financial Services Asset Liability Management pack is 
completed, you must perform the following steps: 

1. Check the Log file. 



Post Deployment Configurations 

9-24 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 

2. Add the below mentioned entries in excludeURLList.cfg file located in the path 
$FIC_WEB_HOME/webroot/conf/. These entries are required for Asset and 
Liability Management, Funds Transfer pricing, Profitability Management and 
Hedge Management / IFRS: 

[SQLIA]./fsapps/common/batchCreate.action 

[SQLIA]./fsapps/common/batchEdit.action 

Note: Copy the above information into notepad, and then copy it from notepad 
into cfg file. Take extra care to avoid copying formatting characters into the cfg 
file. 

3. For Administrative Reports (Admin BI) configuration follow the steps mentioned 
in Oracle Financial Services Administrative Reports on OBIEE 11g v8.0.0.0.0 - 
Configuration Note.docx under $FIC_HOME/adminbi 

 

No te : You can also find the Oracle Financial Services Administrative 
Reports on OBIEE 11g v8.0.0.0.0 - Configuration Note on OHC. 

 

 

4. The web.xml under the path $FIC_WB_HOME \webroot\WEB-INF\ should have 
Resource tag, if not present add the tag and replace ORDEMO with the 
INFODOM name. 

<resource-ref> 

<description>DB ConnectionORDEMO</description> 

<res-ref-name>jdbc/ORDEMO</res-ref-name> 

<res-type>javax.sql.DataSource</res-type> 

<res-auth>Container</res-auth> 

</resource-ref> 

Note: Copy the above information into notepad, and then copy it from notepad 
into cfg file. Take extra care to avoid copying formatting characters into the cfg 
file. 

5. Transfer the ownership of batches to the required User. 

Login to config user. 

Execute the Following anonymous pl/sql block to execute procedure “AAI_ 
OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP”. 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_ 

OWNERSHIP('fromUser','toUser','infodom'); 

end; 

OR 

begin 

AAI_OBJECT_ADMIN.TRANSFER_BATCH_ 

OWNERSHIP('fromuser','touser'); 

end; 

Parameter details: 
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from User: indicates the user who currently owns the batch, 

to User: indicated the user to which the ownership has to be transferred. 

infodom: optional parameter, if specified the ownership of batches pertaining to 
that Infodom will be changed. 

6. If the web application server is hosted on a machine other than where pack is 
installed, then perform the following step. 

Generate RSA key for the machine where Web application server is hosted. 

Add the generated RSA key to the authorized keys list of the machine where Pack 
is installed 

 

Deploying the ALMBI Application 
 

No te : ALMBI in OBIEE version 11.1.1.7.1 and 12.2.1.3.0 will be 
present, but features of ALMBI version 8.0.6.0.0 will be available for 
OBIEE versions 11.1.1.9.5 and 12.2.1.3.0. 

 

 

OBIEE 11.1.1.9.5 
 
 

To deploy the ALMBI application, follow the OBIEE configuration steps: 

1. Make sure Oracle Business Intelligence (Version 11.1.1.9.0) installation is 
completed. 

 

No te : After Installation, patch 22061111 is recommended for all the 
customers who are using Oracle Business Intelligence Enterprise 
Edition 111.1.1.9.0. This patch can be downloaded from Oracle 
support site. 

 
 

 

2. Set the <Oracle BI Instance Home> directory. 

For example, 

/u01/OBIEE11G/instances/instance1. 

3. Start WebLogic AdminServer. 

1. Set the < BI Domain Home> directory. 

For Example, /u01/OBIEE11G/user_ 
projects/domains/bifoundation_domain. 

2. Navigate to < BI Domain Home >/bin and run nohup 
./startWebLogic.sh &. 

3. Bringing up this service may take a few minutes depending on your 
environment. Check the logs using the command tail –f nohup.out. 

4. Start WebLogic Managed Server(bi_server1). 

1. Login onto http://localhost:7001/console using your Administrator 
credentials created during platform install (Replace the hostname based on 
your setup). 

2. Under Environment, click Servers link. 



Post Deployment Configurations 

9-26 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 
The bi_server1 line should show as shutdown state at this point. 

3. Click Control tab. 

4. Select the bi_server1 line by clicking on the left tick box. 

5. Click Start button at the top of the list and confirm starting this service. 

6. State will update to “RUNNING” mode after a few minutes. 

5. Start OBIEE services and login. 

1. Starting services From EM screen 

Login to the EM administration screen using the URL: 
http://localhost:7001/em (Replace the hostname and port number 
based on your setup). Use the login you created in BIEE installation to log in. 

Expand 'Business Intelligence' node on the left and choose Coreapplication. 

Click Overview Tab. 

Click Restart (or Start) under the Manage System section. 

Click Yes on dialog box to confirm the move. Wait for message that confirms 
successful restart. 

2. If starting using EM is not successful and complaining about OPMNCTL not 
up, follow starting process with OPMNCTL 

Open a command prompt, navigate to <Oracle BI Instance 
Home>/bin. 

Run ./opmnctl status, this will show you status of all the OBIEE core services 

run ./opmnctl startall or ./opmnctl stopall depending on your need. 

6. Deploy RPD and webcat file(s). 

1. Navigate to folder $FIC_HOME/ALMBI/RPD_WEBCATALOG/11.1.1.9.5 
which contains both ALMBI.rpd and archived ALMBI.catalog.Copy both the 
files to a local folder. 

2. Login to OBIEE – Enterprise Manager URL (http://<ip 
address>:<port>/em). 

Click on coreapplication from Business Intelligence tab on left hand side. 

Under ‘coreapplication’, select the tab Deployment and click Lock and Edit 
Configuration button located below title ‘coreapplication’. The below screen 
is displayed. 

RPD Deployment: 

Select Browse button available under Upload BI Server Repository section and 
select ALMBI.rpd file from the local folder. Enter Repository password 
‘Administrator1’. 

Web Catalog Deployment: 

Create a new webcatalog folder for ALM BI application through Enterprise 
Manager of OBIEE. 

Set the Catalog Location available under ‘BI Presentation Catalog’ like: 
“$ORACLE_ 
INSTANCE/bifoundation/OracleBIPresentationServicesComponent/$COMP 
ONENT_NAME/catalog/ALMBI”. 
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Click Apply and then click Activate changes. A pop up is displayed after 
successful activation. 

Click Close and switch to Capacity management tab. 

Restart the presentation services. Under the System Components Availability, 
select Presentation Services and click on Restart Selected option. 

Once the Presentation Service is restarted, it will give the pop up for 
successful restart. Click Close. 

Verify that new folder structure is created in the system. It can be found under 
path : 

<Oracle BI Instance Home> 

\bifoundation\OracleBIPresentationServicesComponent\coreap 

plication_obips1\catalog\ALMBI 

This ‘ALMBI’ folder will be having a root folder which in turn contains three 
folders named ‘shared’, ‘system’ and ‘users’. 

3. Open the Catalog Manager 

Navigate to File menu and open the catalog online (File->Open catalog) by 
giving the necessary credentials based on your setup (Type - (online), URL - 
(http://<ipaddress>:<port>/analytics/saw.dll). 

Once the catalog is opened, it will display a folder structure on left hand side. 
Select the shared folder in the LHS tree structure. 

Go to ‘File’ menu and select ‘Unarchive’. It will ask for the path for a file. 

Browse the path of the archived catalog file saved in your local folder using 
the ‘Browse’ button in the pop up. Click ‘OK’. 

The catalog will be unarchived in specified location. A pop up for successful 
operation will be shown. Restart the presentation services once again. 

4. Open the analytics OBIEE URL- 
(http://<ipaddress>:<port>/analytics/saw.dll?bieehome) Login with 
credentials based on your setup, and verify that catalog is available. 

7. Configure tnsnames.ora. 

Open tnsnames.ora file under the folder - <Oracle Home>/network/admin. 

Make sure an entry is made in the tnsnames.ora to connect to atomic schema of 
OFSAA application. 

Save the tnsnames.ora. 

8. Configure ODBC data source to connect to Oracle BI Server. 

1. Go To Control Panel>Administrative Tools>Data Sources (ODBC). 

2. Select the ‘System DSN’ tab and click ‘Add’ Button. 

3. Select a driver specific to (Oracle BI Server 11g) and click ‘Finish’ Button. 

4. Enter ‘Name’ and ‘Server’ details (Specify the Host Name or IP Address of the 
BI Server and click ‘Next’). 

5. Enter Oracle BI Server login id and password (Enter User Name and Password 
created at the time of OBIEE installation). Click ‘Next’. 

6. Click Finish. 

9. Modify connection pool and set the properties. 
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1. Open the OBI Administration tool. 

2. Select Start > Programs > Oracle Business Intelligence > BI Administration. 

3. Select File > Open > Online and select ‘ALMBI.rpd’ file. 

4. In the Open dialog box, select and open ‘ALMBI.rpd’ file. 

5. Enter Repository password as ‘Administrator1’. 

6. RPD changes: 

Go to Manage -> Variables edit the Session variable ‘TNS’ 

For Ex: Change the Default Initializer from ‘TNS ENTRY’ to ‘actual TNS entry’ 
like ‘(DESCRIPTION=(ADDRESS_ 
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database IP 
address>)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=<Database 
Name>)))’ 

Edit the Initialization Block ‘TNS Init Block’ ->Click Edit Data Source 

For Ex: Change the Default Initialization string from “select 'TNS ENTRY' 
from dual “ to select (DESCRIPTION=(ADDRESS_ 
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database IP 
address>)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=<Database 
Name>)))’ from dual 

Edit the Session variable ‘DBUSER’ 

Change the Default Initializer from ‘'USERNAME'’ to actual Database schema 
name. 

Edit the Initialization Block ‘DBUSER Init Block’ ->Click Edit Data Source 

Replace 'USERNAME' with the actual atomic schema name. 

Edit the Session variable ‘DBUSERPWD’ 

Edit the Initialization Block DBUSERPWD Init Block’ ->Click Edit Data Source 

Replace 'PASSWORD' with the actual atomic schema password. 

Check in the changes and give yes for global consistency check. Make sure No 
errors and warnings. Click Save. 

Close the RPD file (File / Exit). 

7. WEBCATALOG changes: 

Click Open->shared Folders->Change Database Connection-> Prompt For 
Sources_TNS 

Select the Prompt TNS and click on edit. 

Change the sql statement in default selection. 

For example: select case when '@{DBNAME}' ='ALMDB' THEN 
'(DESCRIPTION=(ADDRESS_ 
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<IP 
ADDRESS>)(PORT=1521)))(CONNECT_DATA=(SERVICE_ 
NAME=<DATBASE NAME>)))' end from "ALM BI" and Click Save. 

10. Login into OFSALMA Application using the URL: 
http://localhost:9704/analytics.(Replace the port number 

based on your setup). 

Navigate to FICWEBHOME . 
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Run ant.sh 

11. Once the OBIEE Environment is up and running, the OBIEE URL needs to be 
updated in the table 'AAI_MENU_B' for an end user to access the respective 
Business Intelligence Analytics Application. 

Following update statement needs to be executed in the config schema: 

UPDATE AAI_MENU_B 

SET V_MENU_URL = '<URL>' 

WHERE V_MENU_ID IN (‘<List of enabled BI Analytical Links for a 

particular Media Pack >’) 

/ 

COMMIT 

/ 

For ALM Media Pack as an example: 

UPDATE AAI_MENU_B 

SET V_MENU_URL = 'http://10.1.2.3:9704/analytics' 

WHERE V_MENU_ID IN ('OFS_ALM_ABI','OFS_ALMBI_LINK') 

/ 

COMMIT 

/ 

(Replace the IP address and port number based on your setup.) 
 

OBIEE 12.2.1.3.0 
 
 

To deploy the ALMBI application, follow the OBIEE configuration steps: 

1. Install Oracle Business Intelligence Version 12.2.1.3.0. Refer Installing and 
Configuring Oracle Business Intelligence 12c(12.2.1.2) E78115-02 for more details. 

2. Ensure BI server is up and running. 

3. Deploy RPD and webcat file(s) 

1. Create a folder in the below location 

<Oracle_Home>/user_projects/domains/domain_name 

2. Navigate to folder $FIC_HOME/ALMBI/RPD_WEBCATALOG/12.2.1.3.0 
which contains both ALMBI.rpd and archived ALMBI.catalog.Copy 
ALMBI.rpd to the folder created in the above step.Copy ALMBI.catalog to a 
folder in the server where BI client tools are installed. 

3. Open the command prompt and go to below location <Oracle_ 
Home>/user_projects/domains/bi/bitools/bin 

RPD Deployment 
 

No te : You can only upload the repository to a specific service 
instance. 

 
 

 

Oracle provides the downloadrpd and uploadrpd commands for offline 
repository diagnostic and development purposes such as testing, only. In all other 



Post Deployment Configurations 

9-30 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 
repository development and maintenance situations, you should use BAR to 
utilize BAR's repository upgrade and patching capabilities and benefits. 

You can use this command to upload the Oracle BI repository in RPD format. You 
cannot use this command to upload a repository composed of MDS XML 
documents. 

You can execute the utility through a launcher script datamodel.sh on UNIX 
and datamodel.cmd on Windows. If the domain is installed in default folder, 
then the location of the launcher script looks like the following: 

Oracle_Home/user_projects/domains/Domain_ 

Name/bitools/bin/datamodel.sh or datamodel.cmd on Windows 

If the client installed does not have domain names, then launcher script location is 
as follows: 

Oracle_Home\bi\bitools\bin\datamodel.sh or datamodel.cmd on 
Windows 

Syntax: 

The uploadrpd command takes the following parameters: 

uploadrpd -I <RPD filename> [-W <RPD password>] [-SI 

<service_instance>] -U <cred_username> [-P <cred_password>] 

[-S <host>] [-N <port>] [-SSL] [-H] 

• I specifies the name of the repository that you want to upload. 

• W is the repository’s password. If you do not supply the password, then you 
will be prompted for the password when the command is run. For security 
purposes, Oracle recommends that you include a password in the command 
only if you are using automated scripting to run the command. 

• SI specifies the name of the service instance. 

• U specifies a valid user’s name to be used for Oracle BI EE authentication. 

• P specifies the password corresponding to the user’s name that you specified 
for U. If you do not supply the password, then you will be prompted for the 
password when the command is run. For security purposes, Oracle 
recommends that you include a password in the command only if you are 
using automated scripting to run the command. 

• S specifies the Oracle BI EE host name. Only include this option when you are 
running the command from a client installation. 

• N specifies the Oracle BI EE port number. Only include this option when you 
are running the command from a client installation. 

• SSL specifies to use SSL to connect to the WebLogic Server to run the 
command. Only include this option when you are running the command from 
a client installation. 

•  H displays the usage information and exits the command.Use -H or run .sh 
without any parameters to display the help content. 

ALMBI repository password is 'Administrator1' 

such as 

./datamodel.sh uploadrpd -I <Oracle_Home>/user_ 

projects/domains/doamin_name/tmp/ALMBI.rpd -W Administrator1 

-SI ssi -U Username -P Password 
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You will get below message if RPD deployment is successful: 

Operation successful. 

RPD upload completed Successfully. 

Catalog Deployment 

1. Open Catalog Manager. 

2. Navigate to File menu and open the catalog online (File->Open catalog) by 
giving the necessary credentials based on your setup (Type - (online), URL - 
(http://<ipaddress>:<port>/analytics-ws). 

3. Once the catalog is opened, it will display a folder structure on left hand side. 
Select the Shared Folders in the LHS tree structure. 

4. Go to File menu and select Unarchive. It will ask for the path for a file. 

5. Browse the path of the archived catalog file saved in your local folder using 
the ‘Browse’ button in the pop up. Click OK. 

6. The catalog will be unarchived in specified location. A pop up for successful 
operation will be shown. 

7. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) Login 
with credentials based on your setup, and verify that catalog is available 

4. Configure tnsnames.ora. 

Open tnsnames.ora file under the folder - <Oracle Home>/network/admin. 

Make sure an entry is made in the tnsnames.ora to connect to atomic schema of 
OFSAA application. 

Save the tnsnames.ora. 

5. Configure ODBC data source to connect to Oracle BI Server. 

1. Go To Control Panel>Administrative Tools>Data Sources (ODBC). 

2. Select the System DSN tab and click Add Button. 

3. Select a driver specific to (Oracle BI Server 12c) and click ‘Finish’ Button. 

4. Enter Name and Server details (Specify the Host Name or IP Address of the BI 
Server and click Next). 

5. Enter Oracle BI Server login id and password (Enter User Name and Password 
created at the time of OBIEE installation). Click Next. 

6. Click Finish. 

6. Modify connection pool and set the properties. 

1. Open the OBI Administration tool. 

2. Select Start > Programs > Oracle Business Intelligence > BI Administration. 

3. Select File > Open > Online and select ‘ALMBI.rpd’ file. 

4. In the Open dialog box, select and open ‘ALMBI.rpd’ file. 

5. Enter Repository password as ‘Administrator1’. 

6. RPD changes: 

Go to Manage -> Variables edit the Session variable ‘TNS’ 
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For Ex: Change the Default Initializer from ‘TNS ENTRY’ to ‘actual TNS entry’ 
like ‘(DESCRIPTION=(ADDRESS_ 
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database IP 
address>)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=<Database 
Name>)))’ 

Edit the Initialization Block ‘TNS Init Block’ ->Click Edit Data Source 

For Ex: Change the Default Initialization string from “select 'TNS ENTRY' 
from dual “ to select (DESCRIPTION=(ADDRESS_ 
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database IP 
address>)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=<Database 
Name>)))’ from dual 

Edit the Session variable ‘DBUSER’ 

Change the Default Initializer from ‘'USERNAME'’ to actual Database schema 
name. 

Edit the Initialization Block ‘DBUSER Init Block’ ->Click Edit Data Source 

Replace 'USERNAME' with the actual atomic schema name. 

Edit the Session variable ‘DBUSERPWD’ 

Edit the Initialization Block DBUSERPWD Init Block’ ->Click Edit Data Source 

Replace 'PASSWORD' with the actual atomic schema password. 

Check in the changes and give yes for global consistency check. Make sure No 
errors and warnings. Click Save. 

Close the RPD file (File / Exit). 

7. WEBCATALOG changes: 

Click Open->shared Folders->Change Database Connection-> Prompt For 
Sources_TNS 

Select the Prompt TNS and click on edit. 

Change the sql statement in default selection. 

For example: select case when '@{DBNAME}' ='ALMDB' THEN 
'(DESCRIPTION=(ADDRESS_ 
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<IP 
ADDRESS>)(PORT=1521)))(CONNECT_DATA=(SERVICE_ 
NAME=<DATBASE NAME>)))' end from "ALM BI" and Click Save. 

7. Login into OFSALM Application using the URL: 
http://localhost:9704/ofsa.(Replace the port number based on 

your setup). 

Navigate to FICWEBHOME . 

Run ant.sh 

8. Once the OBIEE Environment is up and running, the OBIEE URL needs to be 
updated in the table 'AAI_MENU_B' for an end user to access the respective 
Business Intelligence Analytics Application. 

Following update statement needs to be executed in the config schema: 

UPDATE AAI_MENU_B 

SET V_MENU_URL = '<URL>' 
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WHERE V_MENU_ID IN (‘<List of enabled BI Analytical Links for a 

particular Media Pack >’) 

/ 

COMMIT 

/ 

For ALM Media Pack as an example: 

UPDATE AAI_MENU_B 

SET V_MENU_URL = 'http://10.1.2.3:9704/analytics' 

WHERE V_MENU_ID IN ('OFS_ALM_ABI','OFS_ALMBI_LINK') 

/ 

COMMIT 

/ 

(Replace the IP address and port number based on your setup.) 

 

No te : In case during this Application Pack installation, you enabled 
OFS ALM BI product only, download and apply patch no to correct 
the inconsistency in the OFSAA installation audit tables. This patch is 
not required if you enabled OFS ALM and OFS ALM BI during 
installation. 

 

 

Post Installation Changes in instanceconfig.xml File 

Do the following changes in the instanceconfig.xml file as post installation changes: 

1. Backup and edit the instanceconfig.xml file located at: 

$ORACLE_HOME/user_ 

projects/domains/bi/config/fmwconfig/biconfig/OBIPS 
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Table I–4 

 

Tag to be 
changed  

 
Changes  

Change the 
followingtag: 
<Views> 

<Views> 

<Pivot> 

<DefaultRowsDisplayedInDelivery>75</DefaultRowsDisplayedInDelivery> 

<DefaultRowsDisplayedInDownload>500000</DefaultRowsDisplayedInDow 
nload> 

<DisableAutoPreview>false</DisableAutoPreview> 

</Pivot> 

<Table> 

<DefaultRowsDisplayedInDelivery>75</DefaultRowsDisplayedInDelivery> 

<DefaultRowsDisplayedInDownload>500000</DefaultRowsDisplayedInDow 
nload> 

</Table> 

<Charts> 

<MaxVisibleColumns>50000</MaxVisibleColumns> 

<MaxVisiblePages>25000</MaxVisiblePages> 

<MaxVisibleRows>10000000</MaxVisibleRows> 

<MaxVisibleSections>50000</MaxVisibleSections> 

<JavaHostReadLimitInKB>10240</JavaHostReadLimitInKB> 

</Charts> 

<Cube> 

<CubeMaxRecords> 150000 </CubeMaxRecords> 

</Cube> </Views> 

Change the 
followingtag: 
<Security> 

<Security> 

<CheckUrlFreshness>false</CheckUrlFreshness> 

<EnableSavingContentWithHTML>true</ 

EnableSavingContentWithHTML> 

</Security> 

 

2. Save and exit the file. 

3. Backup and edit the instanceconfig.xml file located at: 

$ORACLE_HOME/user_ 

projects/domains/bi/config/fmwconfig/biconfig/OBIJH/config.xm 

l 

 

Table I–5 
 

Tag to be 
changed  

 
Changes  

Change the 
followingtag: 
</XMLP> 

<XMLP> 

<InputStreamLimitInKB>2048000</InputStreamLimitInKB> 

<ReadRequestBeforeProcessing>false</ReadRequestBeforeProcessing> 

</XMLP> 
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4. Save and exit the file. 

5. Restart the presentation server for the changes to take effect. 

GDPR Con fig uration 

By default, data will be redacted to WebLogic user. If you want to see redacted 
data(PII data on the PII dashbaord) after enabling GDPR , then create WebLogic user 
or any new user( who wants to see redacted data) in OFSAA application and OBIEE (if 
it’s new user) and map the user to “Data Security Group” in OFSAA using SMS. 

For more information on PII dashboard, refer to GDPR section in the Oracle Financial 
Services Asset Liability Management Analytics User Guide on OHC. 

For more information on Data Protection Implementation by OFSAA, refer to Oracle 
Financial Services Data Foundation User Guide on OHC. 

 

Instrument Table Validation 

Run the Instrument Table Validation. For more information, see the Doc ID 1457511.1 
and Data Model Utility Guide 

Check the FSI_MESSAGE_LOG file after running Instrument Table Validation to 
verify that tables are classified correctly. 

 

Logging as System Administrator 

Post installation, the first login into Infrastructure is possible only for a System 
Administrator through user id “sysadmn”. This ID is created at the time of installation 
with the password provided during installation. Enter login id “sysadmn” and 
password that was provided during installation. Click Login. 

System Administrator 

System Administration refers to a process of managing, configuring, and maintaining 
confidential data in a multi-user computing environment. System Administration in 
Security Management involves creating functions, roles, and mapping functions to 
specific roles. System Administration also involves maintaining segment information, 
holiday list, and restricted passwords to ensure security within the Infrastructure 
system. 

You can access System Administrator in LHS menu of Security Management. The 
options available under System Administrator are: 

• Function Maintenance 

• Role Maintenance 

• Segment Maintenance 

• Holiday Maintenance 

• Restricted Passwords 

 

Function Maintenance 

A function in the Infrastructure system defines the privileges to access modules or 
components and to define or modify metadata information associated. Function 
Maintenance allows you to create functions for users to ensure only those functions 
are executed which are specific to the user's role. 

You can access Function Maintenance by expanding System Administrator section 
within the tree structure of LHS menu. The Function Maintenance window displays 

https://docs.oracle.com/cd/E60202_01/homepage.htm
https://docs.oracle.com/cd/E60202_01/homepage.htm
https://docs.oracle.com/cd/E92917_01/homepage.htm
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=525825754789171&id=1457511.1&_adf.ctrl-state=b2shewfr3_75
https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=525825754789171&id=1457511.1&_adf.ctrl-state=b2shewfr3_75
https://docs.oracle.com/cd/E60202_01/homepage.htm
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the function details such as Function Code, Function Name, Description, and the 
number of Roles Mapped to the function. The Function Maintenance window also 
facilitates you to view, create, modify, and delete functions within the system. 

You can also make use of Search and Pagination options to search for a specific 
function or view the list of existing functions within the system 

 

Role Maintenance 

A role in the Infrastructure system is a collection of functions defined for a set of users 
to execute a specific task. You can create roles based on the group of functions to 
which users are mapped. 

You can access Role Maintenance by expanding System Administrator section within 
the tree structure of LHS menu. The Role Maintenance window displays the role 
details such as Role Code, Role Name, Role Description, and the number of Users 
Mapped to the role. The Role Maintenance window also facilitates you to view, create, 
modify, and delete roles within the system. 

You can also make use of Search and Pagination options to search for a specific role or 
view the list of existing roles within the system. 

 

Segment Maintenance  

Segment is used to control access rights on a defined list of objects. It is mapped to an 
information domain. 

Segment Maintenance in the Infrastructure system facilitates you to create segments 
and assign access rights. You can have different segments for different Information 
Domains or same segments for different Information Domains. 

User scope is controlled by segment/ folder types with which the object is associated. 

Objects contained in a public folder will be displayed irrespective of any user. 

Objects contained in a shared folder will be displayed if user belongs to a user group 
which is mapped to an access type role with the corresponding folder. 

Objects contained in a private folder will be displayed only to the associated owner. 

You can access Segment Maintenance by expanding System Administrator section 
within the tree structure of LHS menu. The Segment Maintenance window displays a 
list of available segments with details such Domain, Segment Code, Segment Name, 
Segment Description, Segment/Folder Type, Owner Code, and the number of Users 
Mapped to the segment. You can view, create, modify, and delete segments within the 
Segment Maintenance window. 

You can also make use of Search and Pagination options to search for a specific role or 
view the list of existing roles within the system. 

 

Ho liday Maintenance 
 

No te : As part of OFSAAI 7.3.3.0.0 release, this feature will not be 
available if Authentication is configured to SSO Authentication and 
SMS Authorization. 

 

 

Holiday Maintenance facilitates you to create and maintain a schedule of holidays or 
non-working days within the Infrastructure system. On a holiday, you can provide 



Post Deployment Configurations 

Post Deployment Configurations 9-37 

 

 

 
access to the required users and restrict all others from accessing the system from the 
User Maintenance window. 

You can access Holiday Maintenance by expanding System Administrator section 
within the tree structure of LHS menu. The Holiday Maintenance window displays a 
list of holidays in ascending order. In the Holiday Maintenance window you can 
create and delete holidays. 

 

Res tric ted Pass words 
 

No te : As part of OFSAAI 7.3.3.0.0 release, this feature will not be 
available if Authentication Type is selected as SSO Authentication and 
SMS Authorization from System Configuration> Configuration. 

 

 

Restricted Passwords facilitates you to add and store a list of passwords using which 
users are not permitted to access the Infrastructure system. 

You can access Restricted Passwords by expanding System Administrator section 
within the tree structure of LHS menu. The Restricted Passwords window displays a 
list of restricted passwords and allows you to add and delete passwords from the list. 

You can also make use of Search and Pagination options to search for a specific 
password or view the list of existing passwords within the system. For more 
information, refer Pagination and Search & Filter. 

 

No te : While searching for any pre defined restricted password, you 
have to key in the entire password 

 

 

Creating Ap plication Us ers 

Create the application users in the OFSAA setup prior to use. 
 

No te : This step may not be required if you have already setup users 
in the OFSAA setup. 

For more information, see user creation section from the Oracle 
Financial Services Analytical Applications Infrastructure User Guide. 

Mapping Application User(s) to User Group 

Starting the OFSAA 8.0 release, with installation of ALM Application Pack, 
pre-configured application user groups are seeded. These user groups are unique to 
every OFSAA Application Pack and have application roles pre-configured. 

Map the application user (s) to the respective Application User Group (s) and 
subsequently authorize the entitlements by logging in as SYSAUTH (System 
Authorizer) user. 

For more information, see Mapping/Unmapping Users section from the Oracle 
Financial Services Analytical Applications Infrastructure User Guide. 

 

ALM Applications pecific User Group mappings 

User Groups seeded with the OFS ALM Application are listed below: 

• ALM Administrator 

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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• ALM BI Analyst 

• ALM Auditor 

The ALM Admin has following access to following screens and modules: 

ADCO Prepayments for ALM 

ALM Access code for AAI 

Application Preference: ALM Application Preference Admin, ALM Application 
Preference View 

Rate Management: Add Currency, Add Currency Rate, Add Economic Indicator, Add 
Interest Rate Copy Economic Indicator, Copy Interest Rate, Delete Currency, Delete 
Currency Rate, Delete Economic Indicator, Delete Interest Rate, Edit Currency, Edit 
Currency Rate, Edit Economic Indicator, Edit Interest Rate, Execute Economic 
Indicator Loader, Launch Currency Rate Validation, Launch Interest Rate Loader, 
View Currency, View Currency Rate, View Economic Indicator, View Interest Rate 

Process Tuning: Add, Delete, Edit, View 

Adjustment Rules: Add, Delete, Edit, SaveAs/Copy, View 

Admin BI 

Batch Maintenance: Add, Copy, Delete, Edit, Run, View, Batch Processing, Execute 
Batch 

Behavior Pattern: Add, Delete, Edit, SaveAs/Copy, View 

Migration Execution: Execute/Run, Cancel 

Cash Flow: Add, Delete, Edit, Run, SaveAs/Copy, View 

Authorize Map(s), Create Map, Delete Map, Modify Map 

Defi Administrator 

Detail Cash Flows: Add All Records/Products 

Discount Methods: Add, Delete, Edit, SaveAs/Copy, View 

Dynamic Deterministic: Add, Delete, Edit, Run, SaveAs/Copy, View 

Dynamic Stochastic Process: Add, Delete, Edit, Run, SaveAs/Copy, View 

FSAPPS Home Page Link 

Forecast Balances: Add, Delete, Edit, SaveAs/Copy, View 

Forecast Rates: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View 

Formula Results: Add, Delete, Edit, SaveAs/Copy, View 

Fusion Attributes: Add, Delete, Edit, View, View Dependent Data 

Fusion Expressions: Add, Delete, Edit, View, View Dependent Data 

Fusion Filters: Add, Delete, Edit, View, View Dependent Data 

Fusion Hierarchies: Add, Delete, Edit, View, View Dependent Data 

Fusion Members: Add, Delete, Edit, View, View Dependent Data 

Global Preferences: View 

Holiday Maintenance Screen: Add, Delete, Edit, Run, Save As, View 

MDB Screen, Metadata Publish 
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Maturity Mix: Add, Delete, Edit, SaveAs/Copy, View 

Moody Integration for ALM 

Object Migration: Copy Migration Ruleset, Create Migration Ruleset, Delete Migration 
Ruleset, Edit Migration Ruleset, Home Page, Source Configuration, View Migration 
Ruleset 

Operator Console 

Payment Pattern: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View 

Prepayment Models: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View 

Prepayments: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View  

Pricing Margin: Add, Delete, Edit, SaveAs/Copy, View 

Product Characteristics: Add, Delete, Edit, SaveAs/Copy, View 

Product Profiles: Add, Delete, Edit, SaveAs/Copy, View 

Rate Dependency Patterns: Add, Delete, Edit, SaveAs/Copy, View 

Repricing Pattern: Add, Delete, Edit, SaveAs/Copy, View 

Static Deterministic Process: Add, Delete, Edit, Run, SaveAs/Copy, View 

Static Stochastic Process: Add, Delete, Edit, Run, SaveAs/Copy, View 

Stochastic Rate Index: Add, Delete, Edit, SaveAs/Copy, View 

System Administrator 

Time Buckets: Add, Delete, Edit, SaveAs/Copy, View 

Transaction Strategy: Add, Delete, Edit, Run, SaveAs/Copy, View 

Transfer Pricing: Add, Delete, Edit, Run, SaveAs/Copy, View 

View ALM Tasks 

ALM Analyst: The ALM Analyst has following access to following screens and 
modules: 

ALM Access code for AAI 

ALM Application Preference: View 

Adjustments: Add, Delete, Edit, SaveAs/Copy, View 

Batch Maintenance: Add, Copy, Delete, Edit, Run, View 

Behavior Pattern: View 

Cash Flow Edits: Add, Delete, Edit, SaveAs/Copy, View 

Defi Administrator 

Discount Methods: Add, Delete, Edit, SaveAs/Copy, View 

Dynamic Deterministic Process: Add, Delete, Edit, Run, SaveAs/Copy, View 

Dynamic Stochastic Process: Add, Delete, Edit, Run, SaveAs/Copy, View 

FSAPPS Home Page Link 

Forecast Balances: Add, Delete, Edit, SaveAs/Copy, View 

Forecast Rates: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View 

Formula Results: Add, Delete, Edit, SaveAs/Copy, View 



Post Deployment Configurations 

9-40 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 
Fusion Attributes: View Dependent Data, View Attributes 

Fusion Filters: View Dependent Data, View Filters 

Fusion Hierarchies: View Dependent Data, View Hierarchies 

Fusion Members: View Dependent Data, Fusion View Members 

Fusion Expressions: View Dependency Expressions, View Expressions 

Global Preferences: View 

Maturity Mix: Add, Delete, Edit, SaveAs/Copy, View 

Moody Integration for ALM 

Payment Pattern: View 

Prepayment Models: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View 

Prepayments: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View 

Prepayments: Add, Delete, Edit, SaveAs/Copy, View 

Pricing Margin: Add, Delete, Edit, SaveAs/Copy, View  

Product Characteristics: Add, Delete, Edit, SaveAs/Copy, View 

Product Profiles: View 

Rate Dependency Patterns: Add, Delete, Edit, SaveAs/Copy, View 

Repricing Pattern: View 

Static Deterministic Process: Add, Delete, Edit, Run, SaveAs/Copy, View 

Static Stochastic Process: Add, Delete, Edit, Run, SaveAs/Copy, View 

Stochastic Rate Index: Add, Delete, Edit, SaveAs/Copy, View 

System Administrator: The System Administrator has following access to following 
screens and modules: 

Time Buckets: Edit, View 

Transaction Strategy: Add, Delete, Edit, SaveAs/Copy, View 

Transfer Pricing: Add, Delete, Edit, SaveAs/Copy, View 

View ALM Tasks 

View CFE Tasks 

Rate Management: View Currency, View Currency Rate, View Economic Indicator, 
View Interest Rate 

Process Tuning: View 

ALM Auditor: The ALM Auditor has following access to following screens and 
modules: 

ALM Access code for AAI 

ALM Application Preference View 

Adjustments: View 

Batch Maintenance: Copy, View 

Behavior Pattern: View 

Cash Flow Edits: View 
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Defi Administrator 

Discount Methods: View 

Dynamic Deterministic Process: View 

Dynamic Stochastic Process: View 

FSAPPS Home Page Link 

Forecast Balances: View 

Forecast Rates: View 

Formula Results: View 

Fusion Attributes: View Dependent Data, View Attributes 

Fusion Filters: View Dependent Data, View Filters 

Fusion Hierarchies: View Dependent Data, View Hierarchies 

Fusion Members: View Dependent Data, View Members 

Fusion Expressions: View Dependency Expressions, View Expressions 

Global Preferences: View 

Maturity Mix: View 

Object Migration: View Migration Ruleset 

Payment Pattern: View 

Prepayment Models: View 

Prepayments: View 

Pricing Margin: View 

Product Characteristics: View 

Product Profiles: View 

Rate Dependency Patterns: View 

Static Deterministic Process: View 

Static Stochastic Process: View 

Stochastic Rate Index: View 

System Administrator 

Time Buckets: Edit, view 

Transaction Strategy: View 

Transfer Pricing: View 

View ALM Tasks 

Rate Management: View Currency, View Currency Rate, View Economic Indicator, 
View Interest Rate 

Process Tuning: View 

 

ALMBI Application specific User Group mappings 

User Groups seeded with the OFS ALMBI Application are listed below: 

• ALMBI Administrator 
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• ALMBI BI Analyst 

• ALMBI Data Analyst 

 

Mapping ICC Batch Execution Rights  to User 

By default all users who are mapped to Admin and Analyst will have the permission 
to execute the seeded Batches in ALM Application Pack. However, if any other 
user-defined batches or any other application pack batches created during the 
respective installation application packs, the user need to map the Batch execution 
rights for each user/batch in the Batch Execution Rights menu under Object 
Administration >> Object Security. 

Note: Only SYSADMN user or any user who is mapped under Admin User Group 
will have the access to map the Batch execution rights menu access. 

 

Saving Pos t- Load Change Trans formations  

After creating users, Login to Infrastructure as any user who is mapped to ALM 
Admin or Analyst group. Navigate to Data Management Framework >> Post Load 
Changes. 

A New window will be displayed. Click on Each Transformation from 
Transformations List & Click on Stored Procedure in the Right Panel, Click on Edit in 
the Top Right Menu and Click on Finish Button in Bottom. 

Note: All the Transformation Stored Procedures are required to be edited and saved 
(Finish Button) once for getting it is available. 

 

Changes in .profile file for Solaris Operating System 
For Solaris operating system, do the following changes in .profile file present in user's 
home directory. 

1.  Add the Oracle Developer Studio 12.5 installed path in the beginning of LD_ 
LIBRARY_PATH variable in .profile file. 

For example: 

For Solaris sparc: 

LD_LIBRARY_ 

PATH=/opt/SunProd/studio12u5/developerstudio12.5/lib/compiler 

s/CCgcc/lib/sparcv9 

For Solaris X86: 

LD_LIBRARY_ 

PATH=/opt/SunProd/studio12u5/developerstudio12.5/lib/compiler 

s/CCgcc/lib/amd64 

2. Append the path $FIC_DB_HOME/lib/libC++11/ to LD_LIBRARY_PATH 

variable in .profile file. 

For example: 

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$FIC_DB_HOME/lib/libC++11 
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  A 
Configuring WebServer 

 
This section covers the following topics: 

• Configuring webserver 

• Configuring Web Application Servers 

 

Configuring WebServer 
This step assumes the installation of a webserver exists as per the prerequisites. 

See the product specific installation guide to install and configure the webserver. If an 
installation already exists, skip and proceed to the next step. 

 

No te : 

• Make a note of the IP Address/ Hostname and Port of the webserver. 
This information is required during the installation process. 

• See the Oracle Financial Services Analytical Applications Infrastructure 
Security Guide mentioned in the Related Documents section for 
additional information on securely configuring your webserver. 

• Ensure to enable sticky session/ affinity session configuration on the 
webserver. See the respective product specific Configuration Guide for 
more details. Additionally, you also need to enable the sticky session/ 
affinity session configuration at the Load Balancer level if you have 
configured a Load Balancer in front of the webserver (s). 

 

Configuring Web Application Servers 
This step assumes installation of a web application server exists as per the 
prerequisites. To configure the Web Application Server for OFSAA Deployment, see 
the following sections. 

This section includes the following topics: 

• Configuring WebSphere Application Server for Application Deployment 

• Configuring WebLogic for Application Deployment 

• Configuring Apache Tomcat Server for Application Deployment 
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No te : 

• Make a note of the IP Address/ Hostname and Port of the web 
application server. This information is required during the 
installation process (required if webserver is not configured). 

• Add umask 0027 in the .profile of the UNIX account which 
manages the webserver to ensure restricted access permissions. 

• Refer OFSAA Secure Configuration Guide/ Security Guide 
mentioned in the Related Documents section for additional 
information on securely configuring your webserver. 

 

Configuring Web Sphere Application Server for Application Deployment 

You can deploy multiple OFSAA applications on different profiles of a stand-alone 
WebSphere application server. To create multiple WebSphere "Profiles" in a 
stand-alone server, use the command line option as explained in the following section. 
A profile is the set of files that define the runtime environment. At least one profile 
must exist to run WebSphere Application Server. 

This section covers the following topics: 

• Creating a New Profile in WebSphere 

• Managing Applications in WebSphere 

• Configuring WebSphere Application Server to Use a Load Balancer or Proxy 
Server 

• Deleting WebSphere Profiles 

• Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x 
Libraries 

• Configuring WebSphere HTTPS 

• Configuring WebSphere Memory Settings 

• Configuring WebSphere for REST Services Authorization 

• Configuring Application Security in WebSphere 

 

Creating a New Profile in Web Sphere 

The Profile is created in WebSphere through the command line using the 
manageprofiles.sh that resides in the <WebSphere Install 
directory>/AppServer/bin folder. 

The command to create a profile without admin security through command line is as 
follows: 

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_ 

path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_ 

name> -hostName <host_name>" 

Example: 

$usr/home>./manageprofiles.sh -create -profileName mockaix 

-profilePath/websphere/webs64/Appserver/profiles/mockaix 

-templatePath/websphere/webs64/Appserver/profileTemplates/default 

-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName 

ipa020dor 
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The command to create a profile with admin security through command line is as 
follows: 

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_ 

path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_ 

name> -hostName <host_name> -enableAdminSecurity true -adminUserName 

<Admin User Name> -adminPassword < Admin User Password> -samplespassword 

<sample User Password>" 

Example: 

$usr/home>./manageprofiles.sh -create -profileName mockaix 

-profilePath/websphere/webs64/Appserver/profiles/mockaix 

-templatePath/websphere/webs64/Appserver/profileTemplates/default 

-nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName 

ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword 

ofsaai -samplespassword ofsaai" 

 
 

No te : While using the manageprofiles.sh command to create a 
New Profile in WebSphere, you can also use "-validatePorts" to 
validate if the specified ports are not reserved or in use. Additionally, 
you can specify new ports with "-startingPort <base port>" which 
specifies the starting port number to generate and assign all ports for 
the profile. For more information on using these ports, refer 
WebSphere manageprofiles command. 

 

 

Managing IBM Web Sphere S DK J ava Technology Edition Ve rs ions 

By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must 
upgrade to Java 7.X SDK or JAVA 8.X SDK. 

Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions 
1.7.X_64 or 1.8.X_64. 

Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK: 

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_ 

NUMBER/ibm/console (use https if SSL is enabled.). For example, 
http://192.168.1.0:9000/ibm/console. 

2. Log in with your administrator user ID and password. 

3. From the LHS menu, click Servers to expand and view the menu. 

4. Click Server Types to expand the menu further and then click WebSphere 
Enterprise Application Servers to view the Application servers window. 

5. On the Application servers window, click the required Application Server link. 
For example, server1 in the following illustration: 

http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Finfo%2Faes%2Fae%2Frxml_manageprofiles.html
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6. Click the Java SDKs link from Server Infrastructure to view the list of Java SDKs. 
 

 
 

7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to 
install OFSAA or have installed. 

 

8. Click the Make Default button and save to master repository. 

9. Restart the WebSphere Application Server to apply the changes to the IBM 
application profile. 

 

Managing App lic ations in WebSphere 

To manage the installed applications in WebSphere, follow these steps: 

1. Open the administrator console using the following URL: 

http://<ipaddress>:<Administrative Console Port>/ibm/console 

For example: http://10.111.222.333:9003/ibm/console (https if SSL is 
enabled.) 

 

No te : Administrative Console Port value is available in 
serverindex.xml file within <WebSphere Profile 
Directory>/config/cells/<Node Cell>/nodes/<Node Name> 

directory. 
 

 

The Integrated Solutions Console Login window is displayed. 

 
Figure A–3 Integrated So lutions Cons o le Log in 

2. Log on with the User ID provided with the admin rights. 

3. From the LHS menu, expand the Applications > Application Type> WebSphere 
Enterprise Applications. 
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The Enterprise Applications window is displayed. 

 
Figure A–4 Enterpris e Ap plications 

 
 

 

This Enterprise Applications window helps you to: 

n Install new application 

n Uninstall existing applications 

n Start or Stop the installed applications 

 

Con figuring Web Sphere Application Server to Use a Load Balancer or Proxy 

Server  

The configuration prevents the process server from redirecting to an internal port 
when using a load balancer or proxy server. 

The following steps describe the configuration: 

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_ 
NUMBER/ibm/console (use https if SSL is enabled.). For example, 
http://192.168.1.0:9000/ibm/console. 

2. Log in with your administrator user ID and password. 

3. From the LHS menu, click Servers to expand and view the menu. 

4. Click Server Types to expand the menu further and then click WebSphere 
Enterprise Application Servers to view the Application servers window. 

5. On the Application servers window, click the required Application Server link. 
For example, server1 in the following illustration: 
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Figure A–5 Ap plication Servers - Load Balancer Proxy Server 

 

6. Click Web Container Settings > Custom Properties. 

7. Add the following properties: 

n Name: trusthostheaderport 

Value: true 

n Name: com.ibm.ws.webcontainer.extractHostHeaderPort 

Value: true 

8. Restart the WebSphere Application Server to apply the changes. 

 

Deleting Web Sphere Profile s 

To delete a WebSphere profile, follow these steps: 

1. Select the checkbox adjacent to the required application and click Stop. 

2. Stop the WebSphere profile to be deleted. 

3. Navigate to WebSphere directory: 

<WebSphere_Installation_Directory>/AppServer/bin/ 

4. Execute the command: 

manageprofiles.sh -delete -profileName <profile_name> 

5. Delete the profile folder. 

Example: <WebSphere_Installation_ 
Directory>/AppServer/profiles/<profile_name> 

6. Execute the command: 

manageprofiles.sh -validateAndUpdateRegistry 

 

Configuring Web Sphere Shared Library to Support J ers ey 2x and J acks 

on 2.9x Libraries 

Perform the following configuration to set the WebSphere shared library to support 
jersey 2x and Jackson 2.9x libraries. 
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1. Click Environment from the menu on the left to expand and view the list. Click 
Shared Libraries to open the Shared Libraries window. 

2. Enter details as shown in the following: 

1. Name: Enter a unique identifiable name. 

2. Description: Enter a valid description. 

3. Classpath: Enter the absolute path where the JARs related to Jersey 2.x and 
Jackson 2.9x are copied. These jars are available in the <OFSAA_ 
HOME>/utility/externallib/WEB-INF/lib directory after creation of the EAR 
file. 

3. Select Use an isolated class loader for this library. 

4. Click OK to save to master configuration. 

5. From the Shared Library Mapping window, move the required shared libraries 
from Available to Selected. In the following illustration, JERSEY2x is selected. 

 
6. Select the application or module and map the shared libraries. Click OK. In the 

following illustration, ofsa is selected. 
 

7. Click OK. 

8. Similarly, select the next application or module and repeat the procedure from 
steps 5 to 7. 

 

9. Disable the built-in JAX-RS via JVM property. 

1. Go to WebSphere admin console in Servers > WebSphere Application Servers 

> yourServerName. 

2. In the Server Infrastructure section, go to Java and Process Management > 
Process definition > Java Virtual Machine > Custom properties. 

3. Add the following property: 

com.ibm.websphere.jaxrs.server.DisableIBMJAXRSEngine=true 

10. Restart the application. 

 

Configuring Web Sphere HTTPS 

To configure an HTTPS Transport on WebSphere, follow these steps: 

1. Create a profile using the Profile Creation Wizard in WebSphere. 
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No te : Note down the https port specified during this process and 
use the same as a servlet port or webserver port during OFSAAI 
installation. 

 

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ 
ENABLE" in OFSAAI_InstallConfig.xml for Silent mode OFSAAI installation. 

 

Configuring Web Sphere Memory Settings 

To configure the WebSphere Memory Settings, follow these steps: 

1. Navigate to Websphere applications server > Application servers > 
server1 > Process definition > Java Virtual Machine. 

2. Change the memory setting for Java Heap: 

Initial heap size = 512 

Maximum heap size = 3072 

 

 

Configure the following in WebSphere to enable REST API authorization by OFSAA: 

1. Log on to WebSphere console with the User ID provided with the admin rights. 
2. Expand the Security menu in the LHS and click Global security > Web and SIP 

security > General settings. 
3. De-select the Use available authentication data when an unprotected URI is 

accessed checkbox. 

4. Click OK. 



Configuring Web Application Servers 

Configuring webserver A-53 

 

 

 

 

 

5. Click Save to save the changes to master configuration. 

 

Configuring Application Security in WebSphere 

This is a mandatory security procedure for WebSphere to restrict the unauthorized 
access of configuration files in directories. For detailed information, see the Oracle 
Financial Services Analytical Applications Infrastructure Security Guide. 

 

Configuring WebLogic for Application Deployment 

You can deploy multiple Infrastructure applications on different domains of a 
stand-alone WebLogic application server. To create multiple WebLogic "Domains" in a 
stand-alone server, you can use the Domain Creation wizard. A domain is the set of 
files that define the runtime environment. At least one domain must exist to run 
WebLogic Application Server. 

 

No te : For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 

8, download and install patch 18729264. 
 

 

This section covers the following topics: 

• Creating Domain in WebLogic Server 

• Deleting Domain in WebLogic 

• Configuring WebLogic Memory Settings 

• Configuring WebLogic for REST Services Authorization 

 

Creating Domain in Web Logic Server 

To create a new domain using Configuration Wizard in WebLogic, follow these steps: 

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the 
command: 

./config.sh 

The Configuration Type window of the Configuration Wizard is displayed. 
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2. Select Create a new domain option and click Next. 

The Templates window is displayed. 

3. Select the Create Domain Using Product Templates option and click Next. 

The Administrator Account window is displayed. 

 

4. Enter the user name to be assigned to the administrator, the password and confirm 
the password. Click Next. 

The Domain Mode and JDK window is displayed. 

 

5. Select from the following options: 

In the Domain Mode section, select the required mode (Development or 
Production). 

In the JDK section, select the required option. If you select Other JDK Location, 
click Browse, navigate to the JDK location, and select. Click Next. 

The Advanced Configuration window is displayed 
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6. Select the Administration Server. A WebLogic Server domain must have an 
Administration Server. You can also select Manages Servers, Clusters and 
Machines and RDBMS Security Store, if required. Click Next. 

The Administration Server window is displayed. 

 
 

7. Enter Administration Server details such as the Server Name, Listen address, 
Listen Port, Enable SSL(for secure login using https, select this check box), and SSL 
listen port. Click Next. 

The Configuration Summary window is displayed. 

 

 

No te : Make a note of the Listen Port or SSL Listen Port value (for 
example: 7007), since the same has to be re-entered in the Servlet port 
field during Infrastructure installation. 
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8. Verify the configuration details of the WebLogic domain and click Create. 

The Configuration Progress window is displayed with the status indication of the 
domain creation process. 

 

9. Click Next when 100% of the activity is complete. 

The End of Configuration window is displayed 

 

 

10. Click Finish. The domain server is created enabling the deployment of multiple 
Infrastructure applications on a single WebLogic. 

 

No te : Note down the HTTPS port specified during this process and 
use the same as servlet port or webserver port during OFSAAI 
Installation. 

To enable https configuration on Infrastructure, assign value 1 to 
"HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for silent mode 
OFSAAI installation 

 

11. Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ 
"setDomainEnv.sh" file (Required only if self signed certificate is used). 

 

Deleting Domain in Web Logic 

To delete a domain in WebLogic, follow these steps: 

1. Navigate to the following directory: 

<WebLogic Installation directory>/user_projects/domains/<domain 

name>/bin 

2. Execute stopWebLogic.sh to stop the Weblogic domain. 

3. Delete the Weblogic domain. 

 

Configuring Web Logic Memory Settings 

To configure the WebLogic Memory Settings, follow these steps: 

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in 
setDomainEnv.sh file, which resides in the folder <DOMAIN_HOME>/bin and in 
CommEnv.sh file which resides in the folder common/bin. 

2. Edit this file for customizing memory settings and garbage collector settings 
depending on the available hardware configuration. 

Example 1: 
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if [ "${JAVA_VENDOR}" = "Sun" ] ; then 

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_64BIT 

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_32BIT 

else 

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_64BIT 

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m" 

export WLS_MEM_ARGS_32BIT 

Example 2: 

JAVA_VM= 

MEM_ARGS="-Xms256m -Xmx1024m" 

 

Configuring Web Logic for REST Services Authorization 

To enable REST API authorization by OFSAA in WebLogic, perform the following 
steps: 

1. Open the config.xml file located in the domain where OFSAA is deployed, that is 

<domain_home>/config/config.xml 

2. Add the following in the security-configuration tag: 

<enforce-valid-basic-auth-credentials>false</enforce-valid-ba 

sic-auth-credentials> 

 

Configuring Apache Tomcat Server for Application Deployment 

This section is applicable only when the Web Application Server type is Tomcat. 

This section includes the following topics: 

• Tomcat User Administration 

• Configuring Tomcat to use JAVA 64 bit Executables 

• Configuring Servlet Port 

• Configuring SSL Port 

• Configuring Apache Tomcat Memory Settings 

• Configuring Axis API 

• Configuring Tomcat for User Group Authorization and Data Mapping 

• Uninstalling WAR Files in Tomcat 

 

Tomcat User Administration  

The Tomcat administration and manager application does not provide a default login. 
You are required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as follows: 

This file contains an XML <user> for each individual user that will display the 
username and password used by the admin to log on to Tomcat, and the role names to 
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which the admin user is associated with. For example, <user name="admin" 
password="admin" roles="standard,manager" /> 

1. Add the manager role to any one of the existing username/password combination 
as shown in the preceding example. 

2. Use the same username/password to which the manager role has been assigned to 
access the Tomcat Application Manager. 

3. If the Tomcat server is already running, it requires a re-start after the preceding 
configuration is done. 

 

Configuring Tomcat to use JAVA 64 bit Executables 
To configure Tomcat to use JAVA 64 bit, follow these steps: 

1. Navigate to the $CATALINA_HOME/bin folder. 

2. Edit the setclasspath.sh file as follows: 

3. Replace the following block of text 

# Set standard commands for invoking Java. 

_RUNJAVA="$JRE_HOME"/bin/java 

if [ "$os400" != "true" ]; then 

_RUNJDB="$JAVA_HOME"/bin/jdb 

With: 

# Set standard commands for invoking Java. 

_RUNJAVA="$JAVA_BIN"/java 

if [ "$os400" != "true" ]; then 

_RUNJDB="$JAVA_BIN"/jdb 

4. If the Tomcat server is already running, it requires a re-start after the preceding 
configuration is done. 

 
 

No te : In case tomcat is installed under different Unix profile, set 
JAVA_BIN environment variable in .profile to include the Java 
Runtime Environment absolute path. 

For example: 

export JAVA_BIN /usr/java7_64/jre/bin 

export JAVA_BIN = /usr/java7_64/jre/bin//sparcv9 for Solaris 

Sparc 

 

Configuring Servlet Port 

The default servlet port configured for the Tomcat installation is 8080. Ignore this 
section if you need to use the default port. 

If you need to use a different port number, you must first configure the port in the 

server.xml file in the conf directory of the Tomcat Installation directory. 

To configure the Servlet Port, follow these steps: 

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag: 
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"Define a non-SSL HTTP/1.1 Connector on port 8080 " 

Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this 
value to the new port number that was used during the Infrastructure installation 
process. 

2. Save your changes in the server.xml file. 

 
 

No te : Make a note of the servlet port configured. This information is 
required during the installation of the OFSAA Application Pack. 

 

 

Configuring SSL Port 

If you need to configure and access your OFSAA setup for HTTPS access, ensure that 
the following connect tag under Define a SSL HTTP/1/1 Connector on port 8443 in 
<Tomcat_installation_folder>/conf/server.xml file is uncommented for SSL 
Configuration. (By default, it is commented). 

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 

maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslProtocol="TLS" 

No te : 

n Make a note of the servlet port configured. This information 
would be required during the installation of OFSAA Application 
Pack. 

n To enable https configuration on Infrastructure, assign value 1 to 
"HTTPS_ENABLE" in OFSAAI_InstallConfig.xml file for 
SILENT mode OFSAAI installation. 

 

For more information related to SSL Configuration on Tomcat, see 

http://tomcat.apache.org/. 

 

Configuring Apache Tomcat Memory Settings 

To configure the Apache Tomcat Memory Settings, follow these steps: 

1. Locate the catalina.sh file that resides in the <CATALINA_HOME>/bin folder. 

2. Edit this file for customizing the memory settings and garbage collector settings 
depending on the available hardware configuration. 

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m. 

For example: 

if [ -z "$LOGGING_MANAGER" ]; then 

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m 

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager" 

else 

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER" 

fi 

http://tomcat.apache.org/
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Configuring Axis API 

Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_ 
4/webapps/axis/WEB-INF/lib and place it inside the <Tomcat Installation 
Directory>/lib folder and restart the Tomcat Server. 

 

Configuring Tomcat for User Group Authorization and Data Mapping 

Users with system authorization roles can access User Group Authorization. However, 
to make it available on the Tomcat webserver, you have to perform the following 
configuration steps: 

1. Navigate to the $CATALINA_HOME/conf folder and open the web.xml file. 

2. Enter the following in the web.xml file. 

<init-param> 

<param-name>mappedfile</param-name> 

<param-value>false</param-value> 

</init-param> 

3. Save and close the file. 

 

Uninstalling WAR Files in Tomcat 

To uninstall WAR files in Tomcat, refer Uninstalling WAR Files in Tomcat. 
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  B 
Configuring Resource Reference in Web 

Ap p lic atio n Servers 

 
This section covers the following topics: 

• Configuring Resource Reference in WebSphere Application Server 

• Configuring Resource Reference in WebLogic Application Server 

• Configuring Resource Reference in Tomcat Application Server 

 

Configuring Resource Reference in Web Sphere Application 
Server  

This section is applicable only when the Web Application Server type is WebSphere. 

This section covers the following topics: 

• Creating JDBC Provider 

• Creating a Data Source 

• Creating J2C Authentication Details 

• Defining JDBC Connection Pooling 

 

Creating JDBC Provider  

1. Open the WebSphere admin console in the browser window: 
http://<ipaddress>:<administrative console port>/ibm/console. (https if 
SSL is enabled). The Login window is displayed. 

2. Log in with the user id that has admin rights. 

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. 
The JDBC Providers window is displayed. 
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Figure B–1 J DBC Providers 

 
 

 

4. Select the Scope from the drop-down list. The Scope specifies the level at which 
the resource definition is visible. 

5. Click New to add new JDBC Provider under the Preferences section. The Create 
new JDBC provider window is displayed. 
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Figure B–2 Create a new J DBC Provider 

 

 

 

6. Enter the following details: 
 

Table B–1 Fields and their des cription 
 

Field De s cription 

Database Type Oracle 

Provider Type Oracle JDBC Driver 

Implementation Type Connection pool data source 

Name The required display name for the resource 

Description The optional description for the resource 

 

7. Click Next. 
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Figure B–3 Enter databas e clas s path in fo rmation 

 

 

 

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do 
not use the trailing slash file separators. 

The Oracle JDBC driver can be downloaded from the following Oracle Download 
site: 

• Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers 

• Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers 

Once downloaded, you need to copy the file in the required folder on the server. 
 

No te : Refer Appendix J for identifying the correct 

ojdbc<version>.jar version to be copied. 

9. Click Next. The Summary window is displayed. 

 
 

http://www.oracle.com/technetwork/apps-tech/jdbc-112010-090769.html
http://www.oracle.com/technetwork/database/features/jdbc/jdbc-drivers-12c-download-1958347.html
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Figure B–4 Summary 

 

 

 

10. Verify the details and click Finish to create the JDBC Provider. 

11. The options to Save and Review are displayed. Click Save. 

 

Creating a Data Source  

The following steps are applicable for both config and atomic data source creation. 

1. Open this URL in the browser window: http://<ipaddress>:<administrative 
console port>/ibm/console. (https if SSL is enabled). The Login window is 
displayed. 

2. Login with the user id that has admin rights. 

3. Expand the Resources option in the LHS menu and click JDBC > Data sources 

option. The Data sources window is displayed. 
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Figure B–1 Data Sources  

 
 

 

4. Select the Scope from the drop-down list. The Scope specifies the level at which 
the resource definition is visible. 

5. Click New. The Create a Data Source window is displayed. 
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Figure B–2 Create Data Source 

 
 

 

6. Specify the Data Source name and JNDI name for the new "Data Source". 

The JNDI and Data Source name are case sensitive and ensure that JNDI name is 
same as the "Information Domain" name. 

7. Click Next. The Select JDBC provider window is displayed. 

 
Figure B–3 Se lect J DBC provider  

 
 

 

8. Select the option Select an Existing JDBC Provider and select the required JDBC 
provider from the drop-down list. Click Next. 
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Figure B–4 Enter databas e s pecific properties 

 
 

 

9. Specify the database connection URL. 

For example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID> 

10. Select Data Store Helper Class Name from the drop-down list and ensure that the 
checkbox Use this data source in container managed persistence (CMP) is 
selected. 

 

No te : For RAC configuration, provide the RAC URL specified 
during installation. 

 

 

Example: jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_ 
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.13)(port=1521))(ADDRESS=(PRO 

TOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(LOAD_ 

BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb))) 

11. Click Next. 

 
Figure B–5 Enter Da tabas e s pecific properties 
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12. Map the J2C authentication alias, if already created. If not, you can create a new 
J2C authentication alias by accessing the link given (Global J2C authentication 
alias) or you can continue with the data source creation by clicking Next and then 
Finish. 

 
Figure B–6 Summary 

 

 

 

You can also create and map J2C authentication alias after creating the data 
source. 

13. You must create another Data source by following the preceding procedure with 
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of 
Infrastructure. 

 

Creating J2C Authentication Details 

The following steps are applicable for creating both config and atomic J2C 
Authentication. 

To create J2C Authentication details, follow these steps: 

1. Select the newly created Data Source and click JAAS - J2C authentication data 

link under Related Items. 

 
 



Configuring Resource Reference in WebSphere Application Server 

B-74 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 
Figure B–7 J AAS- J 2C authentication data 

 
 

 

2. Click New under the Preferences section. 

 
Figure B–5 J AAS - J 2C authentication data- Ne w 

 

 

 

3. Enter the Alias, User ID, Password, and Description. Ensure the following: 

• User ID is the Oracle user ID created for the respective Config and Atomic 
Schema for the "Information Domain". 
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• Specify the Config database user ID and password information for the 
jdbc/FICMASTER data source, and specify the Atomic database user ID and 
password information for the Atomic schema data source that you created 
earlier. 

4. Click Apply and save the details. 

 

Defining JDBC Connection Pooling 

To define the JDBC connection pooling ensure that you have created JDBC Provider 
and Data source to access the data from the database. 

1. Expand the Resources option in the LHS menu and click JDBC > Data sources 
option. The Data sources window is displayed. 

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data 
sources>$DATA_SOURCE$>Connection pools. 

 
Figure B–8 Connection poo ls 

 
 

 

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100 
connections, and Minimum connections to 10 connections as shown in the 
preceding figure. You can also define Reap Time, Unused Timeout, and Aged 
Timeout as required. 
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Configuring Resource Reference in WebLogic Application Server 
This section is applicable only when the Web Application Server type is 
WebLogic.This section includes the following topics: 

• Creating Data Source 

• Creating GridLink Data Source 

• Configuring Multi Data Sources 

• Configuring Advanced Settings for Data Source 

• Defining JDBC Connection Pooling 

In WebLogic, you can create "Data Source" in the following ways: 

• "For a Non RAC Database instance, Generic Data Source has to be created. See 
Create Data Source. 

• "For a RAC Database instance, Gridlink Data Source has to be created. See Create 
GridLink Data Source. 

• "When Load Balancing/Fail over is required, Multi Data Source has to be created. 
See Configure Multi Data Sources. 

 

Creating Data Source  

The following steps are applicable for both config and atomic data source creation. 

1. Open the following URL in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Welcome window is displayed. 

2. Login with the Administrator Username and Password. 

 
Figure B–9 Welcome 
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3. From the LHS menu (Domain Structure), click Services > Data Sources. The 

Summary of JDBC Data Sources window is displayed. 

 
Figure B–10 Summary of J DBC Data Sources  

 
 

 

4. Click New and select Generic Data Source option. The Create a New JDBC Data 
Source window is displayed. 

You can also select GridLink Data Source or Multi Data Source while creating a 
Data Source. For more information, see Creating Data Source or Configuring Multi 
Data Sources. 
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Figure B–6 Create a Ne w J DBC Da ta Source 

 
 

 

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from 
the drop-down list. Click Next. 

Ensure the following: 

• The JNDI Name field should be in the format "jdbc/informationdomain" 

• Same steps needs to be followed to create a mandatory data source pointing to 
the "configuration schema" of infrastructure with jdbc/FICMASTER as JNDI 
name. 

• JNDI Name is the same as mentioned in web.xml file of OFSAAI Application. 

• Required "Database Type" and "Database Driver" should be selected. 

 
Figure B–11 J DBC Data Source Properties 

 
 

 

6. Select the Database Driver from the drop-down list. You need to select the 
Database Driver depending on database setup, that is, with or without RAC. Click 
Next. 
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Figure B–12 Trans action Options  

 
 

 

7. Select the Supports Global Transactions checkbox and the One-Phase Commit 

option. 

8. Click Next. The Connection Properties window is displayed. 

 
Figure B–13 Connection Properties 
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9. Enter the required details such as the Database Name, Host Name, Port, Oracle 
User Name, and Password. 

10. Click Next. The Test Database Connection window is displayed. 

 
Figure B–14 Tes t Databas e Connection  

 
 

 

11. Verify the details and click Test Configuration and test the configuration settings. 

A confirmation message is displayed stating "Connection test succeeded." 

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources. 
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No te : 

• "User ID" is the Oracle user ID that is created for the respective 
"Information Domain". 

• "User ID" to be specified for data source with "FICMASTER" as 
"JNDI" name should be the Oracle user ID created for the 
"configuration schema". 

 

13. Select the new Data Source and click the Targets tab. 

 
Figure B–15 Select Targets 

 
 

 

14. Select the AdminServer option and click Finish. 

 

Creating Grid Link Data Source 

If you have selected the option, New > GridLink Data Source while creating the "Data 
Source", you can directly specify the JDBC URL as indicated. 
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Figure B–7 Create a New JDBC GridLinkData Source 

 

1. Enter Data Source Name, and JNDI Name. 

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and 
the XA Driver checkbox is not selected. Click Next. 

 
Figure B–8 JDBC GridLinkData Source- Connection Properties 
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2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. 
The created "Data Source" is displayed in the list of Data Sources. 

 

Con figuring MultiData Sources 

A JDBC multi data source is an abstraction around a group of data sources that 
provides load balancing and failover between data sources. As with data sources, 
multi data sources are also bound to the JNDI tree. Applications can look up a multi 
data source on the JNDI tree and then reserve a database connection from a data 
source. The multi data source determines from which data source to provide the 
connection. 

When the database used is Oracle RAC (Real Application Clusters) which allows 
Oracle Database to run across a set of clustered servers, then group of data sources can 
be created for instances running on a set of clustered servers and a JDBC multi data 
source can be created so that applications can look up a multi data source on the JNDI 
tree to reserve database connection. If a clustered server fails, Oracle continues 
running on the remaining servers. 

1. Open WebLogic Admin Console in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Login window is displayed. 

2. Login with the "User ID" that has admin rights. 

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data 
Sources. The Summary of JDBC Multi Data Sources window is displayed. 

 
Figure B–9 Summary of J DBC Multi Da ta Sources 

 

4. Click New. The New JDBC Multi Data Source window is displayed. 
 

No te : Ensure that the Data Sources which needs to be added to new 
JDBC Multi Data Source has been created. 
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Figure B–10 Con fig ure the Multi Da ta Source 

 
 

5.  Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from 
the drop-down list. Click Next. 

 

No te : 

• The JNDI Name has to be specified in the format 

jdbc/infodomname. 

• JNDI Name of the Data Sources that will be added to new JDBC 
Multi data source should be different from the JNDI name 
specified during Multi Data Source. 

• Same steps needs to be followed to create a mandatory data 
source pointing to the "configuration schema" of infrastructure 
with jdbc/FICMASTER as JNDI name for Data Source. 

• JNDI Name provided in multi data source should be the same 
name that will be mentioned in the web.xml file of OFSAAI 
Application. 

• You can select the Algorithm Type as Load-Balancing. 
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Figure 2–11 Select Targets 

 
 

6. Select the AdminServer check box and click Next. 

 
Figure 2–12 Select Da ta Source Type 

 

7.  Select the type of data source which will be added to new JDBC Multi Data 
Source. Click Next. 

 
Figure B–13 Ad d Da ta Sources 

 
 

8. Map the required Data Source from the Available Data Sources. Click Finish. 

The New JDBC Multi Data Source is created with added data sources. 



Configuring Resource Reference in WebLogic Application Server 

B-86 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 

Configuring Advanced Settings for Data Source 

Perform the following steps for advanced settings for Data Source: 

1. Click the new Data Source from the Summary of JDBC Data Sources window. The 

Settings for <Data Source Name> window is displayed. 

2. Select the Connection Pooling tab given under Configuration. 

3. Go to the Advanced option at the bottom of the window, and check the Test 
Connection of Reserve checkbox (Enables Weblogic Server to test a connection 
before giving it to a client). 

To verify if the data source is valid, select "Data Source name". For example, 
FICMASTER. 

 
Figure B–14 Settings fo r <Da ta Source Na me> 

 
 

4. Select the server and click Test Data Source. 

A message is displayed indicating that the test was successful. 

5.  Once the "Data Source" is created successfully, the following messages are 
displayed: 

• All changes have been activated. No restart is necessary. 

• Settings updated successfully. 

If not, follow the preceding steps to recreate the data source. 

 

Defining JDBC Connection Pooling 

To define the JDBC connection pooling, ensure that you have created JDBC Provider 
and Data source to access the data from the database. 

1. Click the newly created Data Source $DATA_SOURCE$and navigate to the path 
Home >Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC 
Data Source-<INFODDOM_NAME> 

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity 
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10. 
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3. Click Save. 

 

Configuring Resource Reference in Tomcat Application 
Server  

This section is applicable only when the Web Application Server type is Tomcat. 

This section covers the following topics: 

• Creating Data Source 

• Defining JDBC Connection Pooling 

• Configuring Class Loader for Apache Tomcat 

Copy the Oracle JDBC driver file, ojdbc<version>.jar from <Oracle 
Home>/jdbc/lib and place it in <Tomcat Home>/lib. 

 

No te : Refer Appendix J for identifying the correct 

ojdbc<version>.jar version to be copied. 

Creating Data Source  

To create "data source" for Infrastructure application, navigate to <Tomcat Home>/conf 

and edit the following block of text by replacing the actual values in server.xml. 
 

No te : The User-IDs for configuration/ atomic schemas have the 
prefix of setupinfo depending on the value set for PREFIX_SCHEMA_ 
NAME in <<APP Pack>>_SCHEMA_IN.XML file of Schema Creator 
Utility. 

For example: if the value set for PREFIX_SCHEMA_NAME is DEV and 
the schema name was mentioned as ofsaaconf, then the actual 
schema created in the database would be DEV_ofsaaconf. 

 

<Context path ="/<context name>" docBase="<Tomcat Installation 

Directory>/webapps/<context name>" debug="0" reloadable="true" 

crossContext="true"> 

<Resource auth="Container" 

name="jdbc/FICMASTER" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="<user id for the configuration schema>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>" 

maxTotal="100" 

maxIdle="30" 

maxWaitMillis="10000"/> 

<Resource auth="Container" 
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name="jdbc/< INFORMATION DOMAIN NAME >" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="<user id for the atomic schema>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>" 

maxTotal="100" 

maxIdle="30" 

maxWaitMillis="10000"/> 

</Context> 

 
 

No te : 

• The <Resource> tag must be repeated for each Information 
Domain created. 

• After the preceding configuration, the "WAR" file has to be 
created and deployed in Tomcat. 

 

Defining JDBC Connection Pooling 

To define the JDBC connection pooling, do the following: 

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT_ 
DIRECTORY/lib/. 

 

No te : Refer Appendix J for identifying the correct 
ojdbc<version>.jar version to be copied. 

 

 

2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the 
following changes, which is required for connection pooling. 

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " debug="0" 

reloadable="true" crossContext="true"> 

<Resource auth="Container" 

name="jdbc/ $INFODOM_NAME$" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username=" $ATOMICSCHEMA_USERNAME$" 

password="$ATOMICSCHEMA_PASSWORD$" 

url="$JDBC_CONNECTION_URL" 

maxTotal="100" 

maxIdle="30" 

maxWaitMillis="10000" 

removeAbandoned="true" removeAbandonedTimeout="60" 
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logAbandoned="true"/> 

</Context> 

Note the following: 

 
 

No te : 

• $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application 
deployed path. 

• $INFODOM_NAME$ should be replaced by Infodom Name. 

• $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema 
database user name. 

• $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema 
database password. 

• $JDBC_CONNECTION_URL should be replaced by JDBC connection 
string jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, 
jdbc:oracle:thin 10.80.50.53:1521:soluint 

• The User-IDs for configuration/ atomic schemas have the prefix of 
setupinfo depending on the value set for PREFIX_SCHEMA_NAME in 
<<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility. 
For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the 
schema name was mentioned as ofsaaconf, then the actual schema 
created in the database would be DEV_ofsaaconf. 

 
 

Configuring Class Loader for Apache Tomcat 

1. Edit the server.xml available in $TOMCAT_HOME/conf/ folder. 

2. Add tag <Loader delegate="true" /> within the <Context> tag, above the 
<Resource> tag. This is applicable only when the web application server is Apache 
Tomcat 8. 

 

No te : This configuration is required if Apache Tomcat version is 8. 
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  C 
Creating and Deploying EAR/ WAR File 

 
This section covers the following topics: 

• Creating EAR/WAR File 

• Deploying EAR/WAR File 

 

Creating EAR/WAR File 
To create EAR/WAR File, follow these steps: 

1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server. 

2. Execute ./ant.sh to trigger the creation of EAR/ WAR file. 

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time 
taken" message is displayed and you will be returned to the prompt. 

 
Figure C–1 Creating EAR/ WAR File 

 
 

4. The EAR/ WAR file - <contextname>.ear/ .war - is created. 
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No te : The <contextname> is the name given during installation. 
This process overwrites any existing version of EAR file that exists in 
the path. 

In case of OFSAA configured on Tomcat installation, 

<contextname>.war is created. 

ANT warning for tools.jar can be ignored while executing 
./ant.sh 

 

Deploying EAR/WAR File 
This section covers the following topics: 

• Deploying EAR/WAR Files on WebSphere 

• Deploying EAR/WAR files for WebLogic 

• Deploying Tomcat WAR Files on Tomcat 

 

No te : Ensure to clear the application cache prior to the deployment 
of Applications Pack Web Archive. This is applicable to all Web 
Servers (WebSphere, WebLogic, and Tomcat). For more information, 
refer Clearing Application Cache section. 

 

 

Deploying EAR/WAR Files on  WebSphere 

To deploy Infrastructure application in WebSphere: 

1. Start WebSphere Profile by navigating to the path "/<Websphere_Installation_ 
Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and 
execute the command: 

./startServer.sh server1 

2. Open the following URL in the browser: http://<ipaddress>:<Administrative 
Console Port>/ibm/console. (https if SSL is enabled). The login window is 
displayed. 
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Figure C–2 Login Window  

 

3. Enter the user credentials which has administrator rights and click Log In. 

4. From the LHS menu, select Applications and click New Application. The New 
Application window is displayed. 

 
Figure C–3    Ne w Ap plication 

 

5. Click New Enterprise Application. The Preparing for the application installation 

window is displayed. 
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Figure C–4 Preparing fo r the application ins ta lla tion 

 
 

 

6. Select Remote File System and click Browse. Select the EAR file generated for 
OFSAAI to upload and install. Click Next. 

 
Figure C–5 Ins talla tion Options  

 

7. Select the Fast Path option and click Next. The Install New Application window is 
displayed. 
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Figure C–6 Ins ta ll Ne w Ap plication 

 

8. Enter the required information and click Next. The Map Modules to Servers 

window is displayed. 
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Figure C–7 Map Modu les to Servers 

 

9.  Select the Web Application and click Next. The Map Resource References to 
Resources window is displayed. 

 
Figure C–8 Map Res ource References to Res ources  

 

 

10. Map each resource defined in the application to a resource JNDI name defined 
earlier. 
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11. Click Modify Resource Authentication Method and specify the authentication 
method created earlier. 

You can specify "config" for FICMASTER resource or "atomic" for atomic resource 
as the authentication method. 

12. Select the OFSAAI Web Application check box and click Next. The Map Virtual 
hosts for Web Modules window is displayed. 

 
Figure C–9 Map Virtual hos t fo r Web Modules 

 
 

 

13. Select the Web Application check box and click Next. The Summary window is 
displayed. 
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Figure C–10 Summary 

 

14. Click Finish and deploy the Infrastructure Application on WebSphere. 

On successful installation, a message is displayed. 

15. Click Save and save the master file configuration. The details are displayed in the 

Master File Configuration window. 

 

Starting the Ap plication 

To start the application, follow these steps: 

1. Expand Applications > Application Type > WebSphere enterprise applications. 
The Enterprise Applications window is displayed. 
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Figure C–11 Enterpris e Ap plication 

 

2. Select the installed application and click Start. 

 
 

No te : 

n <profile name> is the profile name given while creating the 
WebSphere profile. 

n <cell name > is the cell name given during profile creation. 

n <contextname> is the context name given during installation. 

 

Exploding EAR File 

To explode EAR, follow these steps: 

1. Create the "applications" folder under domain name. For example, "/Bea/user_ 
projects/domains/ <Domain _name>/applications". 

2. Create <context_name>.ear folder under "applications" folder. 

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to <WEBLOGIC_INSTALL_ 
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_ 

name>.ear. 

4. Explode the <context_name>.ear file by executing the command: 

jar -xvf <context_name>.ear 

5. Delete the <context>.ear and <context>.war files (recently created) <WEBLOGIC_ 
INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_ 

NAME>/applications/<context_name>.ear. 

6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_ 
DIR>/Bea/user_projects/domains/<DOMAIN_ 

NAME>/applications/<context>.ear./<context>.war 

7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_ 
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_ 

name>.ear/<context_name>.war. 



Deploying EAR/WAR File 

C-100 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 

8. Explode the <context_name>.war file by executing the following command to get 
the directory structure: 

jar -xvf <context_name>.war 

 
Deploying EAR/WAR files for WebLogic 

Following are the steps for deploying Infrastructure application that would be created 
during installation: 

1. Navigate to the path <WebLogic Installation directory>/user_ 
projects/domains/<domain name>/bin in the machine in which WebLogic 
is installed. 

2. Start WebLogic by executing the command: 

./startWebLogic.sh -d64 file 

3. Open the URL in the browser window: http://<ipaddress>:<admin 
server port>/console (https if SSL is enabled). The Sign in window of the 
WebLogic Server Administration Console is displayed. 

 
 

No te : Ensure that you have started Infrastructure Server by executing 
"./startofsaai.sh" as mentioned in Starting/ Stopping Infrastructure 

Services section. 
 

 

4. Log on to the WebLogic Server by entering the user credentials having privileges 
to deploy the EAR file. 

5. From the Domain Structure LHS menu, click Deployments. The Summary of 
Deployments window is displayed. 

 

6. Click Install. The Install Application Assistant window is displayed. 

7. Select the Exploded EAR directory after browsing to the directory where it is 
saved and click Next. 
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Installing Application 

To install Application, follow these steps: 

1. Open the Install Application Assistant. 

 
Figure C–13 Ins ta ll Ap plication As s is tant 

 
 

 

2. Click Next. 

 
Figure C–14 Ins ta ll Ap plication As s is tant 

 
 

 

3. From the Choose targeting style section, select the Install this deployment as an 
application option and click Next. 

The Optional Settings window is displayed. 
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Figure C–15 Optional Settings  

 
 

 

4. Enter a Name for the deployment if required. 

5. Under the Security section, select the DD only option to specify that only roles 
and policies that are defined in the deployment descriptors should be used. 

8. Select the I will make the deployment available from the following location 

option under the Source accessibility section. 

1. Click Next to continue. 

The Deployment Summary window is displayed. 
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Figure C–16 Deployment Summary 

 
 

 

2. Select the Yes, take me to the deployment's configuration screen option and 

clickFinish. 

The Settings for <Deployment Name> window is displayed. 
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Figure C–17 Settings fo r <De ployment Na me> 

 
 

 

3. Review the general configuration details of the deployment. You can also update 
the configuration of the deployment in this window. In the Overview tab, you can 
view the complete deployment configuration. 

4. Click Save to update the changes, if any. 

5. From the LHS menu, click Deployments. 

The Summary of Deployments window is displayed. 
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Figure C–18 Summary of Deployments 

 
 

 

6. Select the newly deployed Infrastructure application and click Start > Servicing 
all requests. Ensure that the Infrastructure server is up and running. 

 
Figure C–19 Summary of Deployments 

 
 

 

7. The State of the deployed application will be displayed as Active if started 
successfully. 

 
Deploying Tomcat WAR Files on Tomcat 

Before deploying the WAR files, ensure that the previously deployed applications of 
Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in 
Tomcat for the procedure to uninstall the previously deployed Infrastructure war files. 

On the machine that hosts Tomcat, follow these steps to deploy Infrastructure 
application: 
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1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to 

<Tomcat Installation Directory>/webapps/ directory. 

 
Figure C–20 Tomcat Home window  

 

2. Click Manager App. The Connect to dialog box is displayed. 

3. Enter the User Id and Password that has admin rights and click OK. (For user 
creation in tomcat, see Tomcat User Administration. The Tomcat Web Application 
Manager window is displayed with the list of all the applications deployed. 
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Figure C–21 Tomcat Web Ap plication Manager 

 

4. In the Deploy section, enter the Context Path provided during the installation as 
"/<context-name>". 

5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_ 
HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy. 

6. On successful application deployment, a confirmation message is displayed. 

Start the Tomcat server. Refer Starting/ Stopping Infrastructure Services for more 
details. 
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  D 
Additional Configuration 

 
This section gives detailed information about the Additional Configuration regarding 
OFSAA Installation. 

 

Additional Configuration Topics 
This section covers the following topics: 

• Configuring FTP/SFTP 

• Configuring Infrastructure Server Memory 

• Configuring Internet Explorer Settings 

• Retrieving Patch Information 

• Setting OLAP Data Server Configuration 

• Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance 

• Executing OFSAAI Setup Information Fetching Tool 

• Executing Encryption Changer 

• Setting Infrastructure LDAP Configuration 

• Configuring OFSAAI Web Services 

• Deploying OFSAAI Web Services 

• Configuring Message Details in Forms Designer 

• Clearing Application Cache 

• Configuring Password Changes 

• Configuring Java Virtual Machine 

• Configuring Internal Service (Document Upload/ Download) 

 

Configuring FTP/SFTP 

This section details about the configurations required for FTP/SFTP. 

 

In OFSAA, certain modules require transfer of files from the web application server to 
the OFSAA server over SSH. 

Follow these steps to ensure the OFSAA server recognizes the web application server 
during file transfers. 
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1. Log in to the web application server. 

2. Type sftp <user>@<OFSAA Server>. 

3. Specify Yes when prompted for permission. 

Are you sure you want to continue connecting (Yes/No)? 

This will add an entry into the "known_hosts" file. 

4. A confirmation message is displayed: 

Permanently added <OFSAA Server> RSA) to the list of known hosts. 

 
Setting Up SFTP Private Ke y 

Log in to OFSAA Unix user using Putty tool, where you plan for installation and 
generate a pair of authentication keys using the ssh-keygen command. If required, 
set passphrase. Otherwise OFSAAI_SFTP_PASSPHRASE tag in the OFSAAI_ 
InstallConfig.xml file should be set to NA. 

To generate private key, enter the commands as shown: 

ofsaapp@OFSASERVER:~> ssh-keygen -t rsa 

Generating public/private rsa key pair. 

Enter file in which to save the key (/home/ofsaapp/.ssh/id_rsa): 

Created directory '/home/ofsaapp/.ssh'. 

Enter passphrase (empty for no passphrase): 

Enter same passphrase again: 

Your identification has been saved in /home/ofsaapp/.ssh/id_rsa. 

Your public key has been saved in /home/ofsaapp/.ssh/id_rsa.pub. 

The key fingerprint is: 

3e:4f:05:79:3a:9f:96:7c:3b:ad:e9:58:37:bc:37:e4 

ofsaapp@OFSASERVER:~> cat /home/ofsaapp/.ssh/id_rsa.pub >> 

/home/ofsaapp/.ssh/authorized_keys 

In case, you are generating SFTP Private key for Hive server, append the content of 
/home/ofsaapp/.ssh/id_rsa.pub to Hiveserver authorized_keys file located at 
$HOME_DIR_HIVE/.ssh folder. 

Ensure the following permissions exist for the given folders: 

• Permission of .ssh should be 700 

• Permission of .ssh/authorized_keys should be 640 

• Permission of .ssh/id_rsa should be 400 

• Permission of Unix user created should be 755 

 

Configuration for Dimension and Hierarchy Management 

These configuration changes are applicable when Dimension Management features 
provided in OFSAAI are used. You can open AMHMConfig.properties file present in 
the $FIC_WEB_HOME/webroot/conf directory to set the properties for the following: 

This section includes the following topics: 
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Configuration for Dimension and Hierarchy Management has to be done only after the 
application/solution installation is done. The properties specific to Information 
Domain are: 

• $INFODOM$=<Name of the Information Domain> 

• $DIMENSION_ID$=<Dimension ID for which the property to be set> 

 

Configure Member Deletion 

This property should be set to allow the user to delete the Members for the Dimension. 
 

Value Code  Example 

# Member Deletion 
Configuration - VALUE- Y/N 

MEMBER_ 
DEL-$INFODOM$-$DIMENSI 
ON_ID$=$VALUE$ 

MEMBER_ 
DEL-ORAFUSION-1=Y 

 
Configure Attribute Default Date Format 

This property should be set to display the Default Date Format for Date type Attribute 
in Attributes window. 

 

Value Code  Example 

# Attribute Default Date 
Format - DB_DATE_ 
FORMAT:DD-MON-YYYY 

ATTR_DEF_DATE_ 
FORMAT-$INFODOM$=$DB 
_DATE_FORMAT$ 

ATTR_DEF_DATE_ 
FORMAT-ORAFUSION=DD/ 
MON/YYYY 

 
Configure Members Reverse Population 

This property should be set for reverse population of Members for the Dimensions in 
required Information Domains. 

 

Value Code  Example 

# Members Reverse 
population - VALUE- Y/N 

MEMBER_REVERSE_ 
POP-$INFODOM$-$DIMENSI 
ON_ID$=$VALUE$ 

MEMBER_REVERSE_ 
POP-ORAFUSION-1=Y 

 
Configure Hierarchy Reverse Population 

This property should be set for reverse population of Hierarchies for the Dimensions 
in required Information Domains. 

 

Value Code  Example 

#Hierarchy Reverse 
population - VALUE- Y/N 

HIERARCHY_REVERSE_ 
POP-$INFODOM$-$DIMENSI 
ON_ID$=$VALUE$ 

HIERARCHY_REVERSE_ 
POP-ORAFUSION-1=Y 

 
Configure Maximum Levels allowed in Hierarchies 

This property is required to set the maximum levels allowed to build the Hierarchies 
tree structure. 

 

Value Code  Example 

#Hierarchy Maximum level 
allowed for the hierarchy in 
particular Information 
Domain - VALUE - Integer 
number 

MAX_ 
DEPTH-$INFODOM$=$VAL 
UE$ 

MAX_DEPTH-FUSION=15 
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Hierarchies greater than 15 levels are not supported within OFSAA EPM applications 
(ALM, FTP, PFT, HM). If the hierarchy data contains more than 15 levels, OFSA_IDT_ 
ROLLUP will not be populated. The number of hierarchy levels allowed for OFSAA 
EPM key dimensions must be less than or equal to 15. 

If the Hierarchy Reverse Population setting is set to “Y” and more than 15 levels exist 
in the data, then following alert is displayed “The number of levels exceeds the limit”. 

If the maximum level allowed setting is set greater than 15 and Hierarchy Reverse 
Population is set to “Y”, then following error is displayed “Error occurred in Reverse 
Populating the hierarchy”. 

 

Configure Node Limit for a Hierarchy Tree 

This property is required to display the Hierarchy as a small or a large hierarchy. If the 
tree node limit exceeds the set limit, the Hierarchies are treated as large Hierarchy. 

 

Value Code  Example 

#Tree node limit for the 
hierarchy - Values is Integer 
number 

TREE_NODE_ 
LIMIT=$VALUE$ 

TREE_NODE_LIMIT=30 

 

Configuring Infrastructure Server Memory 

The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and 
WebLogic can be edited for customizing memory settings and garbage collector 
settings depending on the available hardware configuration as explained in the 
following section. These settings are base minimum and has to be incremented 
considering the deployment metrics into account. The increments are usually handled 
in multiples of 128 MB for heap and 64 MB for stack. 

 

Configuring Infrastructure Application Server Memory Settings 

You can configure the Infrastructure Application Memory settings as follows: 

1. Locate .profile file. 

2. Edit X_ARGS field in this file for customizing memory settings and garbage 
collector settings depends on the hardware configuration. 

This has a default value X_ARGS="-Xms200m" 

X_ARGS=" "$X_ARGS" $DELIM -Xmx2048m" 

 

No te : Modify X_ARGS_APP variable in the .profile file to customize 
Java Memory Settings for Model Upload based on the Data Model 
size. 

For Run and Rule executions, the following value is recommended: 

X_ARGS_RNEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy 

-XX:MaxPermSize=512M -XX:+UseParallelOldGC 

-XX:+DisableExplicitGC" 

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy 

-XX:MaxPermSize=512M -XX:+UseParallelOldGC 

-XX:+DisableExplicitGC" 
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Configuring Internet Explorer Settings 
 

No te : OFSAAI supports only default zoom setting in Internet 
Explorer, that is, 100%. 
Cookies should be enabled. 

 

The following browser settings must be specified at every client machine prior to 
accessing the Infrastructure application. 

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options 

window is displayed. 

2. Click Settings. The Settings window is displayed. 

3. Select the Every time I Visit the webpage option and click OK. 

 
Figure D–1 Internet Options 

 

4. In the Internet Options window, select the Security tab and select the Internet 
option under Select a zone to view or change the security settings. 

5. Click Default Level under Security level for this zone. 
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Figure D–2 INTERNET Options -S ecurity tab 

 

6. Click Apply to save. 

7. In the Internet Options window, select the Privacy tab and select the Turn on 
Pop-up Blocker option under Pop-up Blocker settings. 
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Figure D–3 Internet Options -Popup Blocker Settings  

 

8. Click Settings. The Pop-up Blocker Settings window is displayed. 

9. Enter the URL of the OFSAA Application in the Address of website to allow: 

field. 

10. Click Add. The OFSAA URL is displayed in the Allowed sites section. 

11. Click Close. 

12. Click OK in the Internet Options window. 

 

Retrieving Patch In fo rmation 

To identify the list of patches installed on your OFSAA setup, follow these steps: 

1. Log in to the OFSAA application as a user with Object AdminAdvanced Role. 

2. Navigate to Object Administration tab, expand Utilities and click Patch 
Information. 

3. The window displays the list of patches installed on the OFSAA setup across 
Applications/ Platform. 
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Setting OLAP Data Server Configuration 

This section is applicable if you are using the OLAP feature of OFSAAI. 

The following parameters must be set to ensure that the system limitations are not 
exceeded at any stage. The values for these OS parameters should be specified based 
on the expected load at each implementation site. 

For example: 

Process Memory Limit 

Max Thread Stack Size 

Max Number of Threads per Process 

• Sort Buffer settings: This must be set at the Essbase application level appropriate 
to the anticipated load. 

• Shutdown and Restart: During shutdown of OFSAAI Server that has an instance 
of Data Services that is communicating with an OLAP Data Server, it is imperative 
to ensure that the cleanup of the old instance is completed on the OLAP Data 
Server before restarting the OFSAAI Server. Pause for a period of time based on 
the load the system was subjected to, before restarting the Data Services 
subsystem. 

 

Changing IP/ Hostname, Ports , Deployed Paths of the OFSAA Instance 

For information on this section, see OFS Analytical Applications Infrastructure 
Administration User Guide in OTN. 

 

Executing OFS AAI Setup In fo rmation Fetching Tool 

Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve 
the related information about the OFSAAI Set up such as Operating System Name and 
Version, Database Type and Version, OFSAAI architecture, Log file locations and so 
on. 

To execute SetupInfo.jar in console, follow these steps: 

1. Navigate to the path $FIC_HOME. 

2. Enter the command: 

java -jar SetupInfo.jar 

After execution, the output file location is displayed in the console. 

 

Executing Encryption Changer  

For more information on Encryption Changer, see Key Management section in 
OFSAAI Administration Guide. 

 

Setting Infrastructure LDAP Configuration 

For more information on LDAP configuration, see OFSAAI Administration Guide. 

 

Configuring OFS AAI Web Services 

Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or 
"synchronously" execute requested tasks offered by OFSAAI. The following 

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/books/8.0.0.0.0/OFSAAI_Administration_Guide_8.0.pdf
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configuration steps are to be done only if you are using the Web Services feature of 
OFSAAI. 

 

Configuring DynamicWSConfig.xml File 

For each third party web service that needs to be accessed using the OFSAAI Web 
services framework and the operations to be invoked, corresponding entries are to be 
made in the DynamicWSConfig.xml template file. 

The variable <WebServer> denotes any one of the application server, that is, 
WebSphere, WebLogic, or Tomcat. 

The DynamicWSConfig.xml file will be available in the <OFSAAI Installation 
Directory>/EXEWebService/ <WebServer>/ROOT/conf directory. This file can be 
placed in any directory that is accessible by the application and this location must be 
specified in the web.xml file, as WSCONFIGFILE parameter. 

The DynamicWSConfig.xml template file will be in <WebServer Deployment Path>/ 
EXEWebService.ear/EXEWebService.war/conf directory. 

This template is as follows: 

<XML> 

<WEBSERVICES> 

<WEBSERVICE CODE="$CODE" 

ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE" 

XMLNS_XSD="$XMLNS_XSD" ENCODINGSTYLE="$ENCODINGSTYLE" 

SERVICENAME="$SERVICENAME" PORTTYPENAME="$PORTTYPENAME" 

SESSION_MAINTAIN_PROPERTY="$SESSION_MAINTAIN_PROPERTY" 

USERNAME="$USERNAME" 

PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE" 

STUBIMPLEMENTATION="$STUBIMPLEMENTATION"> 

<OPERATION CODE="$CODE" 

NAME="$NAME" 

SOAPACTION="$SOAPACTION" 

STYLE="$STYLE" 

PACKAGENAME="$PACKAGENAME"> 

<INPUT ORDER="$ORDER" 

PARAMNAME="$PARAMNAME" 

ARGTYPE="$ARGTYPE" 

CLASSNAME="$CLASSNAME"/> 

<OUTPUT PARAMNAME="$PARAMNAME" 

RETURNTYPE="$RETURNTYPE" 

CLASSNAME="$CLASSNAME"/> 

</OPERATION> 

</WEBSERVICE> 
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</WEBSERVICES> 

</XML> 

The DynamicWSConfig.xml has the placeholders as shown in the following table. These 
have to be updated depending on the web service chosen and the mode of accessing it. 
For each Web service to be accessed, the entire webservice tag in the 
DynamicWSConfig.xml file must be repeated. The placeholders tabulated as follows 
should be set in accordance to the parameters published in the third party wsdl files 
(webservices) to be accessed. The stub class specified must implement the 
"com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF" interface. 

 

Attrib utes of WEBSERVICE tag 
Table D–1 WEBSERVICE tag Attrib utes 

 

P laceho lder  De s cription 

$CODE Unique number within the xml file and cannot be 999 or 0. 

$ENDPOINT soap: address location in the wsdl: service name tag of 
the wsdl file. 

$TARGETNAMESPACE The attribute value for the targetNamespace of the wsdl: 
definitions tag. 

$XMLNS_XSD The attribute value for the xmlns:s of the wsdl:definitions 
tag 

$ENCODINGSTYLE The attribute value for the xmlns:soapenc of the 
wsdl:definitions tag. 

$SERVICENAME Name of the service found under the wsdl:service name tag 
of the wsdl file. 

$PORTTYPENAME wsdl port type name as mentioned in the wsdl file. 

$SESSION_MAINTAIN_PROPERTY This could be given as "" also. 

$USERNAME User name to access the web services. Enter "" if no user 
name is required. 

$PASSWORD Password to access the web services. Enter "" if no password 
is required. 

$WEBSERVICESTYLE This can take either "rpc" in case of DII mode of invoking 
web services or "stub" in case of static mode. This is a 
mandatory parameter. 

$STUBIMPLEMENTATION Fully qualified class name (package name.classname). 

 
Attrib utes of OPERATION tag 

Ensure that the OPERATION tag attributes are repeated for each of the OPERATION 
tags. 

 

Table D–2 OPERATION tag Attrib utes 
 

P laceho lder  De s cription 

$CODE Should be unique within the Webservice tag. 

$NAME The name of the Function that is to be called by the wsdl file. 

$SOAPACTION The URL for the Operation to access. This is associated with 
the Operation tag of the wsdl file. 
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Table D–2 (Cont.) OPERATION tag Attrib utes 
 

P laceho lder  Des cription  

$STYLE This can take "rpc" if the web services invoking is in 
DII mode or "stub" if it is in static mode. This is a 
mandatory parameter. 

$PACKAGENAME Represents the JAXB package of input object. 

 
Attrib utes of INP UT tag 
Table D–3 INP UT tag Attrib utes 

 

P laceho lder  De s cription 

$ORDER The sequential number of the INPUT tag. Should 
start from 0. This is in line with the input order of 
the arguments that the API accepts which is called 
by this operation. 

$PARAMNAME Input parameter name to be called by the wsdl file. 

$ARGTYPE Input Parameter Data Type. If the input argument 
type is complex object, specify $ARGTYPE as 
"xmlstring". 

$CLASSNAME Represents class name of input object parameter. 

 
Attrib utes of OUTP UT tag 
Table D–4 OUTP UT tag Attrib utes 

 

P laceho lder  De s cription 

$PARAMNAME Output parameter name to be returned by the web 
service. 

$RETURNTYPE Output parameter Data Type. If the web service response is 
a complex object, then specify $RETURNTYPE as "object". 

$CLASSNAME Represents class name of output object parameter. 

 

Adding web.xml Entries 

1. This step is optional and required only if the web application server used is 
Tomcat. In case of any other application server, skip and proceed with next step. 

Navigate to $FIC_HOME/webroot/WEB-INF/ and edit the web.xml file. Set parameter 
value DOCSERVICEAPP to EXEWebServiceAXIS. 

2. Navigate to <OFSAAI Installation 
Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit the web.xml 
file as follows: 
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No te : In case of Java 7 when WebLogic is used as web application 
server, replace following line of <OFSAAI Installation 
Directory>/EXEWebService/Weblogic/ROOT/WEB-INF/web.xml file 

<?xml version='1.0' encoding='UTF-8'?> 

<web-app id="WebApp_ID" version="3.0" 

xmlns="http://java.sun.com/xml/ns/javaee" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

xsi:schemaLocation="http://java.sun.com/xml/ns/javaee 

http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd" 

metadata-complete="true"> 

with 

<?xml version='1.0' encoding='UTF-8'?> 

<web-app xmlns="http://java.sun.com/xml/ns/j2ee" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"> 

 

Configuring WSConfig File 

The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer 
Deployment Path>/ EXEWebService.ear/EXEWebService.war/conf 

directory. This file can be placed in any directory that is accessible by the application. 

The path where the WSCONFIG file is placed must be specified in place of 

$WSCONFIGFILELOCATION$in the following block of text in web.xml. 

<context-param> 

<description>WebServices Configuration File</description> 

<param-name>WSCONFIGFILE</param-name> 

<param-value>$WSCONFIGFILELOCATION$</param-value> 

<!--Specify the Location of DynamicWSConFig.xml--> 

</context-param> 

 

Configuring Proxy Settings 

Replace the following <param-value> given in bold in the following block of text in 

web.xml file, with appropriate values. 

If no values are required, leave the <param-value> blank. 

<context-param> 

<description>http Proxy Host</description> 

<param-name>http.proxyHost</param-name> 

<param-value>$PROXYHOST$</param-value> 

<!-- Specify the IP address or hostname of the http proxy server--> 

</context-param> 

<context-param> 

<description>http Proxy Port</description> 

http://java.sun.com/xml/ns/javaee
http://www.w3.org/2001/XMLSchema-instance
http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd
http://java.sun.com/xml/ns/j2ee
http://www.w3.org/2001/XMLSchema-instance
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<param-name>http.proxyPort</param-name> 

<param-value>$PROXYPORT$</param-value> 

<!--Port Number for the Proxy Server--> 

</context-param> 

<context-param> 

<description>http proxy UserName</description> 

<param-name>http.proxyUserName</param-name> 

<param-value>$PROXYUSERNAME$</param-value> 

<!-- User ID To get authenticated by proxy server--> 

</context-param> 

<context-param> 

<description>http proxy Password</description> 

<param-name>http.proxyPassword</param-name> 

<param-value>$PROXYPASSWORD$</param-value> 

<!-- User Password To get authenticated by proxy server--> 

</context-param> 

<context-param> 

<description>http non-ProxyHosts</description> 

<param-name>http.nonProxyHosts</param-name> 

<param-value>$NONPROXYHOST$</param-value> 

<!--Hosts for which the proxy settings should get by-passed (Note: 

Separate them by "|" symbol) --> 

</context-param> 

 

Configuring OFSAAI Home Entry 

This entry should point to the Application layer / Web layer of the OFSAAI 
installation and should be accessible. 

Replace $FIC_HOME$ in the following block of text in web.xml with <WebServer 
Deployment Path>/EXEWebService.ear/EXEWebService.war. 

<context-param> 

<description>OFSAAI Web Home</description> 

<param-name>FIC_HOME</param-name> 

<param-value>$FIC_HOME$</param-value> 

<!--OFSAAI Installation Folder--> 

</context-param> 

<context-param> 

<description>OFSAAI Web Home</description> 

<param-name>FIC_PHYSICAL_HOME</param-name> 

<param-value>$FIC_HOME$</param-value> 



Additional Configuration Topics 

D-122 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 

<!--OFSAAI Installation Folder--> 

</context-param> 

 

Configuring DynamicWSConfig.xml File 

For each third party web service that needs to be accessed using the OFSAAI Web 
services framework, and the operation to be invoked, make corresponding entries into 
this file. This file is to be placed in the location that is specified in the web.xml, as 
WSCONFIGFILE parameter. 

 

Deploying OFS AAI Web Services 

You can deploy OFSAAI Web Services separately if you had not configured OFSAAI 
Web Services as part of the installation. 

1. Complete the manual configuration of OFSAAI Web Services. 

2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> 

and execute the command: 

./ant.sh 

This will trigger the EAR/WAR file creation, which is required for the 
deployment. 

3. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the 
WebServer. 

If you have already configured OFSAAI Web Services as part of the installation, 
deploy the generated EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI 
Deployment area in WebServer profile. 

 

Enabling Parallel Execution of DML statements 

A configuration file, OracleDB.conf has been introduced to accommodate any 
configurable parameter related to operations on oracle database. If you do not want to 
set a parameter to a specific value, then the respective parameter entry can be 
removed/commented off form the OracleDB.conf file that resides in the path $FIC_ 
DB_HOME/conf. 

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_ 
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML 
operation if parallel DML is explicitly enabled in the session with the ENABLE 
PARALLEL DML clause of the ALTER SESSION statement. The default mode of a 
session is DISABLE PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not 
set, then the default degree, as decided by Oracle will be used. 

 

 

Configuring Message Details in Forms Designer 

You can configure the Message Details in Forms Designer under Data Entry Forms 
and Queries module by updating the details of mail server in the 
NotificationConfig.cfg file that resides in the path $FIC_APP_ 
HOME/common/FICServer/conf. 

Ensure that the "authorized User details" for whom you need to configure the Message 
details are included in Administration > Security Management > User Administrator 
> User Maintenance window. 
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Update the following parameters in the "NotificationConfig.cfg" file: 
 

Table D–5 No tific a tion Con fig .c fg File Attrib utes 
 

Parameter De s cription 

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server. 

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 
'true', otherwise set value to 'false'. 

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be 
authenticated, otherwise set to 'false'. 

SMTP_USERNAME Username required for logging into SMTP server, if 
authentication is not required use a dummy value. 

SMTP_PASSWORD Password required for logging into SMTP server, if 
authentication is not required use a dummy value. 

SMTP_MAILID If the Messages has to go from a Particular ID that 
ID need to be added. Exchange server forces you set 
a valid ID that is there in the exchange server. 
(Based on Security settings) 

 

Clearing Application Cache 

This is applicable to all Web Servers (that is, WebSphere, WebLogic, and Tomcat). 

Prior to the deployment of Infrastructure or Application Service Packs / One-off 
patches, navigate to the following path depending on the WebServer configured and 
clear the cache: 

• Tomcat: <Tomcat installation 
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp 

• WebLogic: <Weblogic installation location>/domains/<Domain 
name>/servers/<Server name>/tmp/_WL_user/<Application name>/qaelce/jsp_ 

servlet 

• WebSphere: <Websphere installation 
directory>/AppServer/profiles/<Profile name>/temp/<Node 

name>/server1/<Application name>/<.war file name> 

 

Configuring Password Changes 

This section explains about how to modify the OFSAA Infrastructure Config Schema 
and Atomic Schema passwords. 

 

Modifying OFS AA In fra s tructure Con fig Schema Pas s word 

To change the Config Schema password, perform the following steps: 

1. Change the Config schema User Password in the database. 

2. Delete the $FIC_HOME/conf/Reveleus.SEC file. 

3. Shutdown the OFSAAI App service: 

cd $FIC_APP_HOME/common/FICServer/bin 

./stopofsaai.sh 

4. Start the Infrastructure Server in foreground directly on the server or through 
X-Windows software using the command: 

./startofsaai.sh 
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5. At the prompt, enter System Password. Enter the "new Config schema" password. 
The service will start and initialize itself if it is able to successfully connect to the 
DB. 

6. If you are using Apache Tomcat as Web server, update the <Context> -> 
Resource tag details in Server.xml file from the $CATALINA_HOME/conf folder. 
(In case of Tomcat only Atomic <Resource> will exist). 

If you are using WebSphere as Web server: 

a. Login to the WebSphere Administration Console, from the left side menu. 

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources will need to be modified). 

If you are using WebLogic as Web server: 

a. Login to the WebLogic Administration Console, from the left side menu 

b. Under Domain Structure list box, expand the appropriate Domain and 
navigate to Services > JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified). 

7. Post successful startup of the service, if required, the Infrastructure server may be 
shut down and restarted in the background using nohup mode. 

 

Modifying OFS AA In fra s tructure Ato mic Schema Pas s word 

To change the Atomic Schema password, perform the following steps: 

1. Change the Atomic schema User Password in the database. 

2. Login to the application from the browser using SYSADMN account or any user 
id, which has System Administrator role mapped. 

3. Navigate to System Configuration > Database Details window. Modify the 
password as explained in the following steps: 

a. From the Database Master window, select the connection whose password 
you want to modify and click  button from the toolbar. 

a. Click  button corresponding to the Alias Name. The Alias Details window 
is displayed. 

b. Modify the password in the Auth String field. 

4. If you are using Apache Tomcat as Web server, update the <Context> -> 
Resource tag details in Server.xml file from the $CATALINA_HOME/conf folder. 
(In case of Tomcat only Atomic <Resource> will exist). 

If you are using WebSphere as Web server: 

a. Login to the WebSphere Administration Console, from the left side menu. 

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources will need to be modified). 

If you are using WebLogic as Web server: 
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a. Login to the WebLogic Administration Console, from the left side menu 

b. Under Domain Structure list box, expand the appropriate Domain and 
navigate to Services > JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified). 

5. Restart the OFSAAI services. 

 

Configuring Java Virtual Machine 

While running several database intensive tasks in parallel, fetching the database 
connection from connection pool may face an error. To ensure no such error is 
encountered, add the line securerandom.source=file:/dev/./urandom in the 
java.security configuration file available in $JAVA_HOME/jre/lib/security/ path. 

This needs to be configured on all the machines or virtual machines where the 
OFSAAI database components (ficdb layer) are installed. 

 

Configuring Internal Service (Document Upload/ Download) 

This step can be ignored if it has already been configured as part of any previous IR 

/ML installation. 

The Document Upload /Download feature has undergone a change and can now be 
configured to use Internal service for document upload / download instead of the 
earlier ExeWebService. 

To facilitate Internal service for document upload/ download, perform the following 
configurations: 

1. Create the folders download, upload, TempDocument and Temp in the local path 
of Web application server and provide Read/Write permission. 

• To find the exact location, execute the following query in CONFIG schema: 

select localpath from web_server_info 

• To create folders with Read/Write permission, execute the command: 

mkdir -m 777 download upload TempDocument Temp 

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide 

Read/Write permission. 

• To find the exact location, execute the query in CONFIG schema: 

select ftpdrive from app_server_info 

• To create folder with Read/Write permission, execute the command: 

mkdir -m 777 DocStorage 
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Grants for Atomic / Config Schema 

 
This section mentions about the various grants required for the CONFIG, ATOMIC 
schemas. 

This section discusses the following sections: 

• Configuring Grants for Atomic Schema 

• Configuring Grants for Config Schema 

• Configuring Grants for Config Schema Entities for Atomic Users 

 

Configuring Grants for Atomic Schema 
Atomic Schema creation requires certain grants for object creation. This can be located 
in $FIC_HOME/privileges_atomic_user.sql file. 

The following are the Grants for Atomic Schema: 

grant create SESSION to &database_username 

/ 

grant create PROCEDURE to &database_username 

/ 

grant create SEQUENCE to &database_username 

/ 

grant create TABLE to &database_username 

/ 

grant create TRIGGER to &database_username 

/ 

grant create VIEW to &database_username 

/ 

grant create MATERIALIZED VIEW to &database_username 

/ 

grant select on SYS.V_$PARAMETER to &database_username 

/ 

grant create SYNONYM to &database_username 

/ 
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No te : If you intend to use Oracle OLAP feature, execute the 
following grant on all ATOMIC schema (s): 

grant olap_user to &database_username 

 

Configuring Grants for Config Schema 
Config Schema creation requires certain grants for object creation. This can be located 
in $FIC_HOME/privileges_config_user.sql file. 

The following are the Grants for Config Schema: 

grant create SESSION to &database_username 

/ 

grant create PROCEDURE to &database_username 

/ 

grant create SEQUENCE to &database_username 

/ 

grant create TABLE to &database_username 

/ 

grant create TRIGGER to &database_username 

/ 

grant create VIEW to &database_username 

/ 

grant create MATERIALIZED VIEW to &database_username 

/ 

grant select on SYS.V_$PARAMETER to &database_username 

/ 

grant create SYNONYM to &database_username 

/ 
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Configuring Application Pack XML Files 

 
This section explains configuration of <<App Pack>>_PACK.xml and <<App_ 
Pack>>_SCHEMA_IN.xml files. 

This section includes the following topics: 

• Configuring <<APP Pack>>_PACK.xml File 

• Configuring <<APP Pack>>_SCHEMA_IN.xml File 

 

Configuring <<APP Pack>>_PACK.xml File 
The <<APP PACK>>_PACK.xml file holds details on the various OFSAA products 
that are packaged in a particular Application Pack. 

The following table gives details about the various tags/ parameters available in the 
file and the values that need to be updated. Prior to installing the OFSAA Application 
Pack in SILENT mode, it is mandatory to update this file. 

 

No te : If you are installing in the GUI mode, then this file need not be 
updated. 

 

 
Table F–1 <<AP P PACK>>_PACK.xm l Parameters 

 

 
Tag Na me/ 
Attrib ute Na me 

 

De s cription 

Ma ndat 
ory 
(Y/N) 

 

De fa u lt Va lue/ 
Permis s ible Value 

 

Comments 

APP_PACK_ID Unique Application Pack 
Identifier 

Y Unique Seeded Value DO NOT modify this 
value. 

APP_PACK_ 
NAME 

Unique Application Pack 
Name 

Y Unique Seeded Value DO NOT modify this 
value. 

APP_PACK_ 
DESCRIPTION 

Unique Application Pack 
Description 

Y Unique Seeded Value DO NOT modify this 
value. 

VERSION Unique release version Y Unique Seeded Value DO NOT modify this 
value. 

APP Unique Application 
Entries 

Y Unique Seeded Value DO NOT remove these 
tags. 

APP_ID Unique Application 
Identifier 

Y Unique Seeded Value DO NOT modify this 
value. 
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Table F–1 <<APP PACK>>_PACK.xm l Parameters 
 

 
Tag Na me/ 
Attrib ute Na me 

 

De s cription 

Ma ndat 
ory 
(Y/N) 

 

De fa u lt Va lue/ 
Permis s ib le Value 

 

Comments 

APP_ID/ 
PREREQ 

Prerequisite Application/ 
Product 

Y Unique Seeded Value For most applications 
Infrastructure would be 
the prerequisite set. For 
certain other applications, 
an appropriate 
Application ID would be 
set. 

DO NOT modify this 
value. 

APP_ID/ DEF_ 
SEL_FLAG 

Default Selected Flag Y Default - YES In all Application Packs, 
Infrastructure would have 
this value set to "YES". DO 
NOT modify this value. 

APP_ID/ 
ENABLE 

Enable Application/ 
Product 

YES if 
installin 
g in 
SILENT 
mode. 

Default - 

YES for Infrastructure 

NO for Others 

Permissible - YES or NO 

Set this attribute-value to 
YES against every APP_ 
ID which is licensed and 
should be enabled for use. 

Note: Application/ 
Product once enabled 
cannot be disabled. 
However, Application/ 
Product not enabled 
during installation can be 
enabled later through the 
Administration UI. 

APP_NAME Unique Application/ 
Product Name 

Y Unique Seeded Value DO NOT modify this 
value. 

APP_ 
DESCRIPTION 

Unique Application/ 
Product Name 

Y Unique Seeded Value DO NOT modify this 
value. 

VERSION Unique release version Y Unique Seeded Value DO NOT modify this 
value. 

 

Configuring <<APP Pack>>_SCHEMA_IN.xml File 
Creating database schemas, objects within schemas and assigning appropriate grants 
are the primary steps in the installation process of OFSAA Applications. The <<APP 
PACK>>_SCHEMA_IN.xml file contains details on the various application schemas 
that should be created prior to the Application Pack installation. 

The following table gives details about the various tags/ parameters available in the 
file and the values that need to be updated. Prior to executing the schema creator 
utility, it is mandatory to update this file. 
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Table F–2 <<APP PACK>>_SCHEMA_IN.xml Parameters 
 

 
Tag Na me/ 
Attrib ute Na me 

 

De s cription 

Ma ndat 
ory 
(Y/N) 

 
De fa u lt Value/ 
Permis s ible Value 

 

Comments 

<APP_PACK_ 
ID> 

Seeded unique ID for the 
OFSAA Application Pack 

Y Seeded DO NOT modify this 
value. 

<JDBC_URL> Enter the JDBC URL 

Note: You can  enter 
RAC/ NON-RAC enabled 
database connectivity 
URL. 

Y Example, 

jdbc:oracle:thin:@< 
DBSERVER 
IP/HOST>:<PORT>:<SID 
> 

or 

jdbc:oracle:thin:@//[HOS 
T][:PORT]/SERVICE 

Ensure to add an entry 
(with SID/ SERVICE 
NAME) in the 
tnsnames.ora file on the 
OFSAA server. The entry 
should match with the 
SID/ SERVICE NAME 
used in the JDBC URL. 

   or  

   jdbc:oracle:thin:@(DESCRI 
PTION=(ADDRESS_ 
LIST=(ADDRESS=(PROT 
OCOL=TCP)(HOST=[HO 
ST])(port=[PORT]))(ADD 
RESS=(PROTOCOL=TCP) 
(HOST=[HOST])(PORT=[ 
PORT]))(LOAD_ 
BALANCE=yes)(FAILOV 
ER=yes))(CONNECT_ 
DATA=(SERVICE_ 
NAME=[SERVICE]))) 

 

   For example, 
jdbc:oracle:thin:@//dbhos 
t.server.com:1521/service 
1 

 

   or  

   jdbc:oracle:thin:@//dbsho 
st.server.com:1521/scan-1 

 

   or  

   jdbc:oracle:thin:@(DESCRI 
PTION=(ADDRESS_ 
LIST=(ADDRESS=(PROT 
OCOL=TCP)(HOST=dbho 
st1.server.com)(port=1521 
))(ADDRESS=(PROTOCO 
L=TCP)(HOST=dbhost2.s 
erver.com)(PORT=1521))( 
LOAD_ 
BALANCE=yes)(FAILOV 
ER=yes))(CONNECT_ 
DATA=(SERVICE_ 
NAME=service1))) 

 

<JDBC_ 
DRIVER> 

By default this driver 
name is seeded. 

Note: Do not edit this 
attribute value. 

Y Example, 

oracle.jdbc.driver.OracleD 
river 

Only JDBC Thin Driver is 
supported. 

DO NOT modify this 
value. 

<HOST> Enter the Hostname/ IP 
Address of the system on 
which you are installing 
the OFSAA components. 

Y Host Name/ IP Address  



Configuring <<APP Pack>>_SCHEMA_IN.xml File 

F-132 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 

Table F–2 <<APP PACK>>_SCHEMA_IN.xml Parameters 
 

 
Tag Na me/ 
Attrib ute Na me 

 

De s cription 

Ma ndat 
ory 
(Y/N) 

 

De fa u lt Value/ 
Permis s ib le Value 

 

Comments 

<SETUPINFO>/ Identifies if the value N YES or NO Default value is YES. 
PREFIX_ specified in    

SCHEMA_ <SETUPINFO>/ NAME    

NAME attribute should be    

 prefixed to the schema    

 name.    

<SETUPINFO>/ 
NAME 

Enter the acronym for the 
type of implementation. 
This information will be 
displayed in the OFSAA 
Home Page. 

Note: On executing the 
schema creator utility, this 
value will be prefixed 
with each schema name. 
For example: dev_ 
ofsaaconf, uat_ofsaaatm. 

Y Accepts strings with a 
minimum length of two 
and maximum of four. 

Example, 

DEV, SIT, PROD 

This name would appear 
in the OFSAA Landing 
Page as "Connected To: 
xxxx" 

The schemas being 
created would get this 
prefix. For E.g. dev_ 
ofsaaconf, uat_ofsaaconf 
etc. 

<PASSWORD>/ 
DEFAULT* 

Enter the password if you 
want to set a default 
password for all schemas. 

Note: You also need to set 
APPLYSAMEFORALL 
attribute as Y to apply the 
default password for all 
the schemas. 

N The maximum length 
allowed is 30 characters. 
Special characters are not 
allowed. 

 

<PASSWORD>/ 
APPLYSAMEFO 
RALL 

Enter as Y if you want to 
apply the password 
specified in DEFAULT 
attribute for all the 
schemas. 

Y Default - N 

Permissible - Y or N 

Note: Setting this attribute 
value is mandatory, If 
DEFAULT attribute is set. 

 If you enter as N, you 
need to provide 
individual passwords for 
all schemas. 

   

 Note: In case you have 
entered Y in 
APPLYSAMEFORALL 
attribute and also have 
specified individual 
passwords for all the 
schemas, then the 
specified individual 
passwords will take 
precedence. 
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Table F–2 <<APP PACK>>_SCHEMA_IN.xml Parameters 
 

 
Tag Na me/ 
Attrib ute Na me 

 

De s cription 

Ma ndat 
ory 
(Y/N) 

 

De fa u lt Value/ 
Permis s ib le Value 

 

Comments 

<SCHEMA>/ 
TYPE 

The different types of 
schemas that are 
supported in this release 
are ATOMIC, CONFIG, 
SANDBOX, and ADDON. 

By default, the schemas 
types are seeded based on 
the Application Pack. 

Note: Do not edit this 
attribute value. 

Y ATOMIC/CONFIG/SAN 
DBOX/ADDON 

Note: 

SANDBOX AND 
ADDON schemas are not 
applicable for OFS ALM 
Application Pack. 

Only One CONFIG 
schema can exist in the 
file. 

This schema identifies as 
the CONFIGURATION 
schema that holds the 
OFSAA setup details and 
other metadata 
information. 

Multiple ATOMIC/ 
SANDBOX/ ADDON 
schemas can exist in the 
file. 

ATOMIC schema refers to 
the Information Domain 
schema. SANDBOX 
schema refers to the 
SANDBOX schema. 
ADDON schema refers to 
other miscellaneous 
schema (not applicable for 
this Application Pack). 

<SCHEMA>/ 
NAME 

By default, the schemas 
names are seeded based 
on the Application Pack. 

You can edit the schema 
names if required. 

Note: 

The Schema Name will 
have a prefix of the 
SETUPINFO/ NAME 
attribute. 

SCHEMA NAME must be 
same for all the ATOMIC 
Schemas of applications 
within an Application 
Pack. 

Y The permissible length is 
15 characters and only 
alphanumeric characters 
allowed. No special 
characters allowed except 
underscore '_'. 

SETUPINFO/ NAME 
attribute value would be 
prefixed to the schema 
name being created. 

For E.g. if name is set as 
'ofsaaatm' and setupinfo 
as 'uat' then schema being 
created would be 'uat_ 
ofsaaatm'. 

NAME should be same 
where APP_GRP=1 for all 
SCHEMA tags (Not 
applicable for this 
Application Pack). 

<SCHEMA>/ 
PASSWORD 

Enter the password of the 
schema to be created. 

Note: 

If this attribute is left 
blank, then the password 
specified in the 
<PASSWORD>/DEFAUL 
T attribute is applied as 
the Schema Password. 

N The maximum length 
allowed is 30 characters. 
Special characters are not 
allowed. 

Note: You need to 
mandatorily enter the 
password if you have set 
the <PASSWORD>/ 
APPLYSAMEFORALL 
attribute as N. 

<SCHEMA>/ 
APP_ID 

By default, the 
Application ID is seeded 
based on the Application 
Pack. 

Note: Do not edit this 
attribute value. 

Y Unique Seeded Value Identifies the 
Application/ Product for 
which the schema is being 
created. 

DO NOT modify this 
value. 
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Table F–2 <<APP PACK>>_SCHEMA_IN.xml Parameters 
 

 
Tag Na me/ 
Attrib ute Na me 

 

De s cription 

Ma ndat 
ory 
(Y/N) 

 

De fa u lt Value/ 
Permis s ib le Value 

 

Comments 

<SCHEMA>/ 
DEFAULTTABL 
ESPACE 

Enter the available default 
tablespace for DB User. 

Note: 

N Default - USERS 

Permissible - Any existing 
valid tablespace name. 

Modify this value to 
associate any valid 
tablespace with the 
schema. 

 If this attribute is left 
blank, then USERS is set 
as the default tablespace. 

   

<SCHEMA>/ 
TEMPTABLESP 
ACE 

Enter the available 
temporary tablespace for 
the DB User. 

Note: 

N Default - TEMP 

Permissible - Any existing 
valid temporary 
tablespace name. 

Modify this value to 
associate any valid 
tablespace with the 
schema. 

 If this attribute is left 
blank, then TEMP is set as 
the default tablespace. 

   

<SCHEMA>/ 
QUOTA 

Enter the quota to be set 
on 
DEFAULTTABLESPACE 
attribute for the schema/ 
user. By default, the quota 
size is set to 500M. 
Minimum: 500M or 
Unlimited on default 
Tablespace 

N Example, 

600M/m 

20G/g 

UNLIMITED/unlimited 

Modify this value to grant 
the specified quota on the 
mentioned tablespace to 
the user. 

<SCHEMA>/ 
INFODOM 

Enter the name of the 
Information Domain to 
associate this schema. 

The schema creator utility 
automatically derives an 
Information Domain 
Name based on the 
Application Pack if no 
value is specified for this 
attribute. 

N Permissible length is 16 
characters and only 
alphanumeric characters 
allowed. No special 
characters allowed. 

 

<ADV_SEC_ 
OPTIONS>/ 

Parent tag to hold 
Advance Security 
Options. 

N  Uncomment the tag and 
edit if you want to add 
security options. For 
example, TDE and Data 
Redact. 

   For details, see the 
example following the 
table. 

<ADV_SEC_ Tag to enable/disable N Default is FALSE. To Ensure this tag is not 
OPTIONS>/TD TDE.  enable TDE, set this to commented if you have 
E   TRUE. uncommented <ADV_ 

    SEC_OPTIONS> 

<ADV_SEC_ Tag to enable/disable N Default is FALSE. To Ensure this tag is not 
OPTIONS>/ Data Redaction feature.  enable DATA_REDACT, commented if you have 
DATA_   set this to TRUE uncommented <ADV_ 
REDACT    SEC_OPTIONS> 
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Table F–2 <<APP PACK>>_SCHEMA_IN.xml Parameters 
 

 
Tag Na me/ 
Attrib ute Na me 

 

De s cription 

Ma ndat 
ory 
(Y/N) 

 

De fa u lt Value/ 
Permis s ib le Value 

 

Comments 

<TABLESPACE 
S> 

Parent tag to hold 
<TABLESPACE> 
elements 

N NA Uncomment the tag and 
edit. ONLY if tablespaces 
are to be created as part of 
the installation. 

     

For details, see the 
example following the 
table. 

     

Note: When TDE is TRUE 
in ADV_SEC_OPTIONS, 
then it is mandatory for 
the <TABLESPACES> tag 
to be present in the xml 
file. 

<TABLESPACE 
>/ NAME 

Logical Name of 
tablespace to be created. 

Y  Name if specified should 
be referred in the 
<SCHEMA 
DEFAULTTABLESPACE= 
“##NAME##”> attribute. 

   Note the ## syntax. 

<TABLESPACE 
>/ VALUE 

Physical Name of the 
tablespace to be created 

Y NA Value if specified will be 
the actual name of the 
TABLESPACE. 

<TABLESPACE 
>/ DATAFILE 

Specifies the location of 
the data file on the server 

Y NA Enter the absolute path of 
the file to be created. 

<TABLESPACE Specifies if the tablespace Y ON or OFF Set to ON to ensure that 
>/ should be extensible or   the tablespace does not 
AUTOEXTEND have a hard limit   run out of space when 

    full. 

<TABLESPACE Specifies if the Y ON or OFF Set to ON to ensure that 
>/ ENCRYPT tablespace(s) should be   the tablespaces when 

 encrypted using TDE.   created are encrypted 
    using TDE. 
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No te : Encryption of tablespaces requires to enabling Transparent 
Data Encryption (TDE) on the Database Server. 

Example: (The following snippet shows that TDE is enabled and 
hence the tablespace has been shown with encryption ON.) 

<ADV_SEC_OPTIONS> 

<OPTION NAME="TDE" VALUE="TRUE"/> 

<OPTION NAME="DATA_REDACT" VALUE="FALSE" /> 

</ADV_SEC_OPTIONS> 

<TABLESPACES> 

<TABLESPACE NAME="OFS_AAI_TBSP_1" VALUE="TS_USERS1" 
DATAFILE="<HOME_ 
DIR>/ora12c/app/oracle/oradata/OFSPQA12CDB/ts_users1.dbf" 
SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" /> 

<TABLESPACE NAME="OFS_AAI_TBSP_2" VALUE="TS_USERS2" 
DATAFILE="<HOME_ 
DIR>/ora12c/app/oracle/oradata/OFSPQA12CDB/ts_users2.dbf" 
SIZE="500M" AUTOEXTEND="ON" ENCRYPT="ON" /> 

</TABLESPACES> 

<SCHEMAS> 

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" 
APP_ID="OFS_AAI" DEFAULTTABLESPACE="##OFS_AAI_TBSP_ 
1##" TEMPTABLESPACE="TEMP" QUOTA="unlimited"/> 

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" 
APP_ID="OFS_AAAI" DEFAULTTABLESPACE="##OFS_AAI_TBSP_ 
2##" TEMPTABLESPACE="TEMP" QUOTA="unlimited" 
INFODOM="OFSAAAIINFO"/> 

</SCHEMAS> 
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  G 
OBIEE Upgrade 

 
Repository and Catalog upgrade Steps 

 
Repository Upgrade  

• Install OBIEE Client version 11.1.1.9.0 onto your desktop 

• Open the 11.1.1.7.1 repository in the OBIEE Administration client version 
11.1.1.9.0 

• Run a consistency check (to check if any errors/warnings) 

• Save the repository 

The above steps will auto-update the repository to 11.1.1.9 version 

 

Catalog Upgrade 

Unarchive the catalog folders provided as part of Code drop 

1. Open the presentation services link for OBIEE setup version 11.1.1.9.0 

2. Click on “Catalog” link [top right side] 

3. Click on “Shared Folders”, in the left side pane 
 

4. Click on “Unarchive” option provided at the bottom of same left pane 

5. Provide the catalog path in the pop up window. Do not change the 
other options[unless required. Details on options(Replace and ACL) 
are provided below], and click on OK. 

 

Replace 

It is used to specify if and how to replace an existing folder or object with the same 
name. Following options are available: 

All — Select this option to replace any existing folders or objects with the same 
names as folders or objects included in the archive file that you are uploading. 

Old — Select this option to replace folders or objects except those folders or objects 
that exist, unless they are older than the source. 

None — Select this option to add any new folders or objects, but preserve any 
existing folders or objects. 

Force — Select this option to add and replace all folders or objects. 

ACL 

It is used to specify how the folders or objects are assigned permissions using 
Access Control Lists (ACLs) when unarchived. Following options are available: 

Inherit — Inherits the folder or object's permissions (ACL) from its new parent 
folder. 



F-138 OFS ALM Application Pack Installation and Configuration Guide 

Post RPD Upgrade Steps 
 

 

Preserve — Preserves the folder or object's permissions (ACL) as it was in the 
original, mapping accounts as necessary. 

Create — Preserves the folder or object's permissions (ACL) as it was in the 
original, creating and mapping accounts as necessary. 

This will unarchive the catalog folder under “Shared Folders”/”shared” folder. 
Repeat the steps, incase of multiple catalog folders if needed to be copied. 

Note: All the catalog folders should be under “Shared Folders”/”shared” 

The dashboards will now be accessible in OBIEE ver 11.1.1.9 

 

Post RPD Upgrade Steps 
1. Check Global Consistency, that is, click Ctrl+k 

2. Click on the below warning.  

3. Click on Reset for default values and then click OK. 

4. Save the RPD. 

5. Check for Global Consistency. There should not be any warning 
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Migrating Excel Upload Functionality 

 
This section provides detailed instructions to migrate excel upload functionality. 

 

Prerequisites 
The following are the prerequisites for migration. 

• Data model in ATOMIC schemas should be same on the source and target setups. 

• OFS AAI (platform) patch level version should be same on the source and target 
setups. 

• PL/SQL Developer to connect and query the database. 

• WinSCP to connect and access server file system. 

 

Migrating Excel Upload 
To migrate, follow these steps: 

1. Open PL/SQL Developer and logon to the source setup's configuration (CONFIG) 
schema by entering the appropriate username and password. 

2. In a new SQL window, query the data of table EXCEL_MAPPING_MASTER. 

3. Open a new session in PL/SQL developer and logon to the target setup's 
configuration (CONFIG) schema by entering the appropriate username and 
password. 

4. Insert the records from Step 1 in to this table. 

5. In V_INFODOM column of EXCEL_MAPPING_MASTER table, update the infodom name 
with the target infodom name. 

 

No te : If all the mappings can work out of the single target Infodom, 
update same Infodom value across all rows. If only few mappings will 
work out of the target infodom, update the infodom value for 
selective records. Excel upload mappings will work only if the target 
infodom has same data model entities as used in the mappings 
defined on source setup. 

 

 

6. Update V_CREATED_BY column with the name of any user present in the target 
setup that has appropriate roles to perform Excel Upload tasks. 
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No te : It is mandatory to update values for V_INFODOM and V_ 
CREATED_BY columns. 

 

7. Open WinSCP and login a new session by entering the host name, port number, 
user name and password to access the source setup. 

8. Navigate to the folder referred as FTPSHARE. 

9. Copy the excel-entity mapping xml file(s) which are located in this folder 
according to their folder structure on to your desktop. For example: /ftpshare 
/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml 

 

No te : Actual file name of Excel Sheet is mentioned in the V_EXCEL_ 
NAME column of EXCEL_MAPPING_MASTER table. 

 

 

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder 
according to their folder structure on to your desktop. For example: 
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx 

 
 

No te : .xls/.xlsx files should be copied to the path as per the local 
path given in your webserverinfo table of config schema. Ignore this 
step if files are not present at the location. 

 

 

11. Log into a new session in WinSCP by entering the host name, port number, user 
name and password to access the target setup. 

12. Copy the XML file(s) from Step 3 to the following location in the target setup. For 

example: /ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_ 

NAME.xml. 

 
 

No te : $TARGET_INFODOM_NAME should be target setup infodom in 
which you have uploaded the appropriate data model and the name 
should be same as the V_INFODOM column value updated in EXCEL_ 
MAPPING_MASTER table. 

 

 

13. Copy the xls/ xlsx file(s) from Step 3 to the following location in target setup. For 
example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx. 

 
 

No te : Ignore this step if files are not present at the location. 
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Configuring OFSAAI_InstallConfig .xml File 

 
This section gives details about the OFSAAI_InstallConfig.xml file. 

 

Configuring OFSAAI_InstallConfig .xml file 
To configure the OFSAAI_InstallConfig.xml file, follow these steps. 

1. Navigate to OFS_ALM_PACK/OFS_AAI/conf/ directory. 

2. Open the file OFSAAI_InstallConfig.xml in text editor. 

3. Configure the OFSAAI_InstallConfig.xml as mentioned in the below Table. 

You must manually set the InteractionVariable parameter values as mentioned in 
the table. If a value is not applicable, enter NA and ensure that the value is not 
entered as NULL. 

 

 
Table I–1 OFS AA In fra s tructure Ins ta lla tion Tas ks and De s criptions 

 

In teraction Variable 
Na me 

 
Significance and Expected Value 

Mandator 
y 

<Layer name="GENERAL"> 

InteractionGroup name="WebServerType" 

WEBAPPSERVERTYPE Identifies the web application server on which the OFSAA Infrastructure 
web components would be deployed. 

The following numeric value should be set depending on the type: 

• Apache Tomcat = 1 

• IBM WebSphere Application Server = 2 

• Oracle WebLogic Server = 3 

For example, <InteractionVariable 
name="WEBAPPSERVERTYPE">3</InteractionVariable> 

Yes 

InteractionGroup name="OFSAA Infrastructure Server Details" 

DBSERVER_IP Identifies the hostname or IP address of the system on which the 
Database Engine is hosted. 

Note: For RAC Database, the value should be NA. 

For example, <InteractionVariable name="DBSERVER_ 
IP">14.15.16.17</InteractionVariable> or <InteractionVariable 
name="DBSERVER_IP">dbhost.server.com</InteractionVariable> 

Yes 

InteractionGroup name="Database Details" 
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Table I–1 (Cont.) OFS AA In fra s tructure Ins ta lla tion Tas ks and De s criptions 
 

In teraction Variable 
Na me 

 
Significance and Expected Value 

Mandator 
y 

ORACLE_ 
SID/SERVICE_ NAME 

Identifies the Oracle DB Instance SID or SERVICE_NAME 

Note: The Oracle_SID value should be exactly the same as it is mentioned 
in JDBC_URL. 

For example, <InteractionVariable name="ORACLE_SID/SERVICE_ 
NAME">ofsaser</InteractionVariable> 

Yes 

ABS_DRIVER_PATH Identifies the directory where the JDBC driver (ojdbc<version>.jar) 
exists. This would typically be the $ORACLE_HOME/jdbc/lib 

For example, <InteractionVariable name="ABS_DRIVER_ 
PATH">">/oradata6/revwb7/oracle </InteractionVariable> 

Note: Refer Appendix O for identifying the correct "ojdbc<version>.jar" 
version to be copied. 

Yes 

InteractionGroup name="OLAP Detail" 

OLAP_SERVER_ 
IMPLEMENTATION 

Identifies if the OFSAA Infrastructure OLAP component needs to be 
configured depending on whether you intend to use the OLAP feature. 
The following numeric value should be set depending on the choice: 

• YES - 1 

• NO - 0 

No 

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set 
in.profile: 

ARBORPATH, HYPERION_HOME and ESSBASEPATH. 

InteractionGroup name="SFTP Details" 

SFTP_ENABLE Identifies if the SFTP (Secure File Transfer Protocol) feature is to be 
enabled. The following numeric value should be set depending on the 
choice: 

• For SFTP -1. 

• For FTP - 0 

Yes 

Note:The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using 
SFTP instead of FTP because SFTP is considered more secure. However, a client may choose to ignore this 
recommendation and to use FTP by setting SFTP_ENABLE to 0. You can change this selection later by using the 
OFSAAI administration interface. 

Set SFTP_ENABLE to -1 to configure ftpshare and weblocal path as local path mounted for OFSAAI server. 

FILE_TRANSFER_PORT Identifies the port used for the file transfer service. The default value 
specified is 22 (SFTP). Specify default value as 21 (FTP) if SFTP_ENABLE 
is 0. Alternatively, this value can be any Port configured by System 
Administrators to support SFTP/FTP. 

For example, <InteractionVariable name="FILE_TRANSFER_ 
PORT">21</InteractionVariable> 

Yes 

InteractionGroup name="Locale Detail" 

LOCALE Identifies the locale information to be used during the installation. This 
release of the OFSAA Infrastructure supports only US English. 

For example, <InteractionVariable name="LOCALE">en_ 
US</InteractionVariable> 

Yes 

InteractionGroup name="OFSAA Infrastructure Communicating ports" 

Note: The following ports are used internally by the various OFSAA Infrastructure services. The default values 
mentioned are set in the installation. If you intend to specify a different value, update the parameter value 
accordingly and ensure this port value is in the range of 1025 to 65535 and the respective port is enabled. 

JAVAPORT 9999 Yes 
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Table I–1 (Cont.) OFS AA In fra s tructure Ins ta lla tion Tas ks and De s criptions 
 

In teraction Variable 
Na me 

 
Significance and Expected Value 

Mandator 
y 

NATIVEPORT 6666 Yes 

AGENTPORT 6510 Yes 

ICCPORT 6507 Yes 

ICCNATIVEPORT 6509 Yes 

OLAPPORT 10101 Yes 

MSGPORT 6501 Yes 

ROUTERPORT 6500 Yes 

AMPORT 6505 Yes 

InteractionGroup name="Web Details" 

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA 
and the same is configured on your web application server. 

HTTPS_ENABLE Identifies if the UI should be accessed using HTTP or HTTPS scheme. 
The default value set is 0. The following numeric value should be set 
depending on the choice: 

• YES - 1 

• NO - 0 

For example, <InteractionVariable name="HTTPS_ 
ENABLE">0</InteractionVariable> 

Yes 

WEB_SERVER_IP Identifies the HTTP Server IP/ Hostname or Web Application Server IP/ 
Hostname, to be used for accessing the UI. This IP would typically be the 
HTTP Server IP. 

If no separate HTTP Server is available, the value should be Web 
Application Server IP/Hostname. 

For example, <InteractionVariable name="WEB_SERVER_ 
IP">10.11.12.13</InteractionVariable> 

or 

<InteractionVariable name="WEB_SERVER_ 

IP">myweb.server.com</InteractionVariable> 

No 

WEB_SERVER_PORT Identifies the Web Server Port. This would typically be 80 for non SSL 
and 443 for SSL. If no separate HTTP Server exists, the value should be 
the port configured for Web Server. 

Note: The port value will not be accepted as 80 if HTTPS_ENABLE is 1 and 
as 443, if HTTPS_ENABLE is 0. 

For example, <InteractionVariable name="WEB_SERVER_ 
PORT">80</InteractionVariable> 

No 

CONTEXT_NAME Identifies the web application context name which will be used to built 
the URL to access the OFSAA applications. The context name can be 
identified from a URL as follows: 

<scheme>://<host>:<port>/<context-name>/login.jsp 

Sample URL: https://myweb:443/ofsaadev/login.jsp 

For example, <InteractionVariable name="CONTEXT_ 
NAME">ofsaadev</InteractionVariable> 

Yes 
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Table I–1 (Cont.) OFS AA In fra s tructure Ins ta lla tion Tas ks and De s criptions 
 

In teraction Variable 
Na me 

 
Significance and Expected Value 

Mandator 
y 

WEBAPP_CONTEXT_ 
PATH 

Identifies the absolute path of the exploded .ear file on the web 
application server. 

For Tomcat, specify the Tomcat directory path till /webapps, such as 
/oradata6/revwb7/tomcat/webapps/. 

For WebSphere, enter the WebSphere path as <WebSphere profile 
directory>/installedApps/ <NodeCellName>. For example, 
/data2/test//WebSphere/AppServer/profiles/<Profile_ 

Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host name. 

For WebLogic, provide the WebLogic home directory path as /<WebLogic 
home directory path>/bea/wlserver_10.3 

Note: For WebLogic, value specified for this attribute is ignored and 
value provided against attribute WEBLOGIC_DOMAIN_HOME is 
considered. 

Yes 

WEB_LOCAL_PATH Identifies the absolute path to any directory on the web application 
server that can hold temporary files being uploaded as part of the 
applications usage. 

Note: In case of a clustered deployment, ensure this path and directory is 
same on all the nodes. 

Yes 

InteractionGroup name="Weblogic Setup Details" 

WEBLOGIC_DOMAIN_ 
HOME 

Identifies the WebLogic Domain Home. 

For example, <InteractionVariable name="WEBLOGIC_DOMAIN_ 

HOME">/home/weblogic/bea/user_ projects/domains/mydomain 

</InteractionVariable> 

Yes 
Specify 
the value 
only if 
WEBSER 
VERTYPE 
is set as 3 
(WebLogi 
c) 

InteractionGroup name="OFSAAI FTP Details" 

OFSAAI_FTPSHARE_ 
PATH 

Identifies the absolute path to the directory identified as file system stage 
area. 

Note: 

• The directory should exist on the same system on which the OFSAA 
Infrastructure is being installed (can be on a separate mount). 

• The user mentioned in the following APP_SFTP_USER_ID 
parameter should have RWX permission on the directory. 

For example, <InteractionVariable name="APP_FTPSHARE_ 
PATH">">/oradata6/revwb7/ftpshare</InteractionVariable> 

Yes 

OFSAAI_SFTP_USER_ 
ID 

Identifies the user who has RWX permissions on the directory identified 
under the preceding parameter APP_FTPSHARE_PATH. 

Yes 

OFSAAI_SFTP_ 
PRIVATE_KEY 

Identifies the SFTP private key for OFSAAI. 

For example, 

<InteractionVariable name="OFSAAI_SFTP_PRIVATE_ 
KEY">/home/ofsaapp/.ssh/id_rsa</InteractionVariable> 

By default, the value is NA, which indicates password will be prompted 
for the user <OFSAAI_SFTP_USER_ ID> for authentication. 

For more information on generating SFTP Private key, see the Setting Up 
SFTP Private Key section. 

No 
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Table I–1 (Cont.) OFS AA In fra s tructure Ins ta lla tion Tas ks and De s criptions 
 

In teraction Variable 
Na me 

 
Significance and Expected Value 

Mandator 
y 

OFSAAI_SFTP_ 
PASSPHRASE 

Identifies the passphrase for the SFTP private key for OFSAAI. 

For example, 

InteractionVariable name="OFSAAI_SFTP_PASSPHRASE">enter a pass 
phrase here</InteractionVariable> 

By default, the value is NA. 

If OFSAAI_SFTP_PRIVATE_KEY value is given and this is kept as NA, 
then it is assumed as empty passphrase. 

No 

InteractionGroup name="Hive Details" 

The default value set for the interaction variables under this group is set as NA. These are required only for Hive 
Configuration. 

HIVE_SERVER_PORT Identifies the port used for the file transfer service. The default value set 
is 22 (SFTP). Set this value as 21 for FTP. 

For example, 

InteractionVariable name="HIVE_SERVER_ 
PORT">22</InteractionVariable> 

Yes, only 
for HIVE 
Configura 
tion 

HIVE_SERVER_ 
FTPDRIVE 

Identifies the absolute path to the directory identified as file system stage 
area of HIVE server. 

For example, 

InteractionVariable name="HIVE_SERVER_ 
FTPDRIVE">/scratch/ofsaa/ftpshare</InteractionVariable> 

Yes, only 
for HIVE 
Configura 
tion 

HIVE_SERVER_FTP_ 
USERID 

Identifies the user who has RWX permissions on the directory identified 
under the preceding parameter HIVE_SERVER_FTPDRIVE. 

For example, 

InteractionVariable name="HIVE_SERVER_FTP_ 
USERID">ofsaa</InteractionVariable> 

Yes, only 
for HIVE 
Configura 
tion 

HIVE_SERVER_FTP_ 
PROTOCOL 

If the HIVE_SERVER_PORT is 21, then set value as FTP, else set it as 
SFTP. 

For example, 

InteractionVariable name="HIVE_SERVER_FTP_ 
PROTOCOL">SFTP</InteractionVariable> 

Yes, only 
for HIVE 
Configura 
tion 

HIVE_SFTP_PRIVATE_ 
KEY 

Identifies the SFTP private key for the HIVE server. 

For example, 

<InteractionVariable name="HIVE_SFTP_PRIVATE_ 
KEY">/scratch/testuser/.ssh/id_rsa</InteractionVariable> 

By default, the value is NA, which indicates password will be prompted 
for the user <HIVE_SERVER_FTP_USERID> for authentication. 

For more information on generating SFTP Private key, see the Setting Up 
SFTP Private Key section. 

Yes, only 
for HIVE 
Configura 
tion 

HIVE_SFTP_ 
PASSPHRASE 

Identifies the passphrase for the SFTP private key for HIVE. 

For example, 

<InteractionVariable name="HIVE_SFTP_ 

PASSPHRASE">NA</InteractionVariable> 

By default, the value is NA. 

If HIVE_SFTP_PRIVATE_KEY value is given and this is kept as NA, then 
it is assumed as empty passphrase. 

Yes, only 
for HIVE 
Configura 
tion 
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JDBC Jar Files 

 
The ojdbc<version>.jar file should be copied based on the Oracle Database version 
and the supported Java (JDK/JRE) version. See the following table for details: 

 
Table J –1 J DBC J ar file s vers ion details 

 

Oracle Da tabas e 
Vers ion 

J DK/J RE Vers ion 
Supported 

J DBC J ar file s s pecific to the 
releas e 

12.1 or 12cR1 JDK 8 and JDK 7 ojdbc7.jar for JDK 7 and JDK 8 

11.2 or 11gR2 JDK 7 and JDK 8 supported 
in 11.2.0.3 and 11.2.0.4 

ojdbc6.jar for JDK 8 and JDK 7 
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Removing OFSAA 
 

 

 

This chapter includes the following sections: 

• Uninstalling OFSAA Infrastructure 

• Uninstalling EAR Files in WebSphere 

• Uninstalling EAR Files in WebLogic 

• Uninstalling WAR Files in Tomcat 

 

Uninstalling OFSAA Infrastructure 
This section will guide you through the necessary steps to uninstall the OFSAA 
Infrastructure product. 

Before you start the uninstallation process, ensure that no open connections exist to 
the OFSAA Infrastructure Config and Atomic Schemas and Infrastructure services are 
brought down. 

To uninstall OFSAA Infrastructure: 

1. Log in to the system as non-root user. 

2. Navigate to the $FIC_HOME directory and execute the command: 

./Uninstall.sh 

3. Enter the password for OFSAAI Configuration Schema when prompted as shown 
in the following figure. 

 
Figure 2–15 Uninstalling OFSAA Infrastructure 
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No te : 

• Uninstallation does not remove the Infrastructure application 
from the Web Application Server. This has to be done manually. 

• The entries in the .profile file will have to be removed manually. 

• The files/ folders under the file system staging area (ftpshare) 
have to be deleted manually. 

• All the Database objects from Atomic Schemas have to be 
dropped manually. 

 

Uninstalling EAR Files in Web Sphere 
Following are the steps to uninstall any previously deployed application: 

1. Open the URL in the browser window: http://<ipaddress>:<Administrative 
Console Port>/ibm/console (https if SSL is enabled). The Login window is 
displayed. 

2. Login with the user id that has admin rights. 

3. Expand Applications > Application Types > WebSphere enterprise applications 
from the LHS. The Enterprise Applications window is displayed with all the 
deployed applications. 

 
Figure 2–16 Enterprise Applications 

 

4. Select the checkbox adjacent to the application to be uninstalled and click Stop. 

5. Click Uninstall. The Uninstall Application window is displayed. 
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Figure 2–17 Uninstall Application 

 

6. Click OK to confirm. 

7. Click Save to save the master file configuration. 

 

Uninstalling EAR Files in Web Logic 
On the machine that hosts WebLogic, perform the following steps to uninstall any 
previously deployed application: 

1. Open the URL in the browser window: http://<ipaddress>:<admin server 
port>/console (https if SSL is enabled). The Login window of the WebLogic 
Server Administration Console is displayed. 

2. Login with the WebLogic user credentials having administrator privileges. 

3. From the Domain Structure LHS menu, click Deployments. The Summary of 
Deployments window is displayed. 

 
Figure 2–18 Summary of Deployments 

 

4. Select the checkbox adjacent to the application to be uninstalled and click Stop> 
Force Stop Now. 

5. Click Yes in the confirmation dialog to stop the selected deployment. 
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Figure 2–19 Summary of Deployments- Messages 

 

6. Select the checkbox adjacent to the application and click Delete to delete the 
selected deployment. 

7. Click Yes in the confirmation dialog to remove the selected deployment from the 
domain configuration. 

 

Uninstalling WAR Files in Tomcat 
On the machine that hosts Tomcat, perform the following steps to uninstall any 
previously deployed application: 

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf 

directory to avoid conflict during undeploy and re-deploy of the WAR file. 

Place comment <!-- --> in between the context path section. For example: 

<!-- 

<Context path ="/pr2test" 

docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" debug="0" 

reloadable="true" crossContext="true"> 

<Resource auth="Container" 

name="jdbc/PR2ATM" 

type="javax.sql.DataSource" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

username="pr2atm" 

password="pr2atm" 

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST" 

maxTotal="100" 

maxIdle="30" 

maxWaitMillis="10000"/> 

</Context> 

--> 

Restart the Tomcat service by doing the following: 
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a. Login to the "Unix server" through a terminal emulator. 

b. Navigate to $catalina_home/bin directory. 

c. Stop the tomcat services using the command: 

./shutdown.sh 

d. Start the tomcat services using the command: 

./startup.sh 

2. Open the URL in a browser window: http://<IP address>:<Tomcat server 
port>. (https if SSL is enabled). The Tomcat home window is displayed. 

3. Click the Manager App. The Connect to window is displayed. 

4. Login with the user credentials having admin rights. The Tomcat Web Application 
Manager window is displayed with the list of all applications deployed in Tomcat. 

 
Figure 2–20 Tomcat Web Application Manager 

 

5. Click the Undeploy link against the deployed Infrastructure application. A 
confirmation message is displayed on the application /Infrastructure being 
uninstalled. 
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  L 
Upgrading an Existing OFSAA 8.0.x Java 7 

In stance to Java 8 
 

This section explains the configurations required to upgrade an existing OFSAA 8.0.x 
Java 7 instance to Java 8. It consists of the following topics: 

• Prerequisites 

• Upgrading OFSAA 8.0.x Java 7 instance to Java 8 

• Configuring Web Application Server 

• OFSAA Generic Configurations 

• Configuring OFSAA for New Web Application Server Installation 

 

Prerequisites 
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 
8: 

• Java 8 should be installed on the OFSAA server and Web Application Server. 

 

 
 

Upgrading OFSAA 8.0.x Java 7 instance to Java 8 
To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps: 

1. Configure Web Application Server to Java 8. For more information, refer 
Configuring Web Application Server. 

2. Configure the OFSAA instance to Java 8. For more information, refer OFSAA 
Generic Configurations. For a newly installed Web Application Server, refer 
Configuring OFSAA for New Web Application Server Installation 

3. Restart the OFSAA services. For more information, refer the Start/ Stop 
Infrastructure Services section in Appendix D 

4. Generate the application EAR/WAR file and redeploy the application onto your 
configured web application server. For more information on generating and 
deploying EAR/WAR file, refer Appendix C. 
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Configuring Web Application Server 
This section describes the changes to be made in the Web Application Server. 
Following are the two options to perform Web Application Server Configurations 
which are listed as follows: 

• Upgrade the existing Web Application Server installation to Java 8 

• Install a new instance of the Web Application Server with Java 8 

This section consists of the following topics: 

• Upgrading Oracle WebLogic Server 

• Upgrading Apache Tomcat Server 

 

Up grading Oracle Web Logic Server 

Perform the following configurations to upgrade the existing WebLogic server 
instance to Java 8: 

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver. 

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, 
JAVAHOME properties to the new Java path and java.vm.version to the new 
Java version. For example, 

JAVA_HOME=/usr/java/jre1.8.0_45 

WLS_JAVA_HOME=/usr/java/jre1.8.0_45 

JAVAHOME=/usr/java/jre1.8.0_45 

java.vm.version=1.8.0_45 

3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_ 
projects/domains/<domain>/bin. Update SUN_JAVA_HOME, DEFAULT_ 
JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file to point to the new Java 
path. For example, 

SUN_JAVA_HOME="/usr/java/jre1.8.0_45" 

DEFAULT_SUN_JAVA_HOME="/usr/java/jre1.8.0_45" 

JAVA_HOME="/usr/java/jre1.8.0_45" 

4. Clear the Application cache. Navigate to the following path and delete the files: 

<Weblogic installation location>/domains/<Domain name>/servers/<Server 

name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet 

 

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps: 

1. Install Oracle WebLogic Server 12.1.3.x on Java 8. 

2. Perform the configurations for the newly installed WebLogic server. For more 
information refer Configuring Resource Reference in Weblogic Application Server. 

 
 

No te : While creating WebLogic Domain, the Listen Port should be 
set same as that of the existing Domain. 

Note down the new Domain path to perform OFSAA Configurations. 
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Upgrading Apache Tomcat Server 

Perform the following configurations to upgrade the existing Apache Tomcat Server 
from Java 7 to Java 8: 

1. Login to the Apache Tomcat Server as a non-root user. 

2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. 
For Example, 

JAVA_HOME=/usr/java/jre1.8.0_45 

3. Clear the Application cache. Navigate to the following path and delete the files: 

<Tomcat installation folder>/work/Catalina/localhost/<Application 
name>/org/apache/jsp 

 

If you wish to install a new instance of the Apache Tomcat Server, follow these steps: 

1. Install Apache Tomcat Server 8 with Java 8. 

2. Perform the configurations for the newly installed Tomcat server. For more 
information refer Configuring Resource Reference in Tomcat Application Server. 

 
 

No te : Update the Connector Port in 
/apache-tomcat-8.0.21/conf/server.xml file to that of the 
existing Tomcat instance. 

Note down the new deployment path to perform OFSAA 
Configurations. 

 

OFSAA Generic Configurations 
This section consists of the following topics: 

• Configuring User .profile Settings 

• Configuring Java 8 

 

Configuring User .profile Settings 
Perform the following configurations: 

1. Log in to the OFSAA server as a non-root user. 

2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 

1.8. For example, 

PATH=/usr/java/jre1.8.0_45/jre 

JAVA_BIN=/usr/java/jre1.8.0_45/jre/bin 

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jre1.8.0_ 

45/jre/lib/amd64/server 
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Configuring Java 8 

1. If the Oracle Database version is 12c, copy ojdbc7.jar from $ORACLE_ 
HOME/jdbc/lib to the following locations: 

• $FIC_HOME/utility/OFSAAGenerateRepository/lib/ 

• $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/ 

• $FIC_HOME/ficdb/lib/ 

• $FIC_HOME/ficapp/icc/lib/ 

• $FIC_HOME/ficapp/common/FICServer/lib/ 

• $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/ 

• $FIC_HOME/ficweb/webroot/WEB-INF/lib/ 

• $FIC_HOME/ficdb/etl/classes/ 

 
 

No te : If ojdbc6.jar is already present in any of the aforementioned 
folders, you need to remove it. 

 

 

2. If the Oracle Database version is 11g, copy ojdbc6.jar from $ORACLE_ 
HOME/jdbc/lib to the following locations: 

• $FIC_HOME/utility/OFSAAGenerateRepository/lib/ 

• $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/ 

• $FIC_HOME/ficdb/lib/ 

• $FIC_HOME/ficapp/icc/lib/ 

• $FIC_HOME/ficapp/common/FICServer/lib/ 

• $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/ 

• $FIC_HOME/ficweb/webroot/WEB-INF/lib/ 

• $FIC_HOME/ficdb/etl/classes/ 

 

Configuring OFSAA for New Web Application Server 
Installation 

This configuration is required only if you have freshly installed Oracle WebLogic 

12.1.3 or Apache Tomcat Server 8.0. Follow these steps: 

1. Modify the following parameters in the Configuration table present in the Config 
Schema with the new Domain Path in case of WebLogic or with the new 
deployment path in case of Tomcat: 

• DeFiHome 

• REV_IMG_PATH 

• EMBEDDED_JSP_JS_PATH 

2. Log in to the OFSAA server as a non-root user. 

3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following 
parameters in the web.xml file with the new Domain path in case of WebLogic or 
with the new deployment path in case of Tomcat: 
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• FIC_PHYSICAL_HOME_LOC 

• FIC_HOME 

• ICC_SERVLET_LOG_FILE 

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path 
in case of WebLogic or with the new deployment path in case of Tomcat: 

• OFSAALogger.xml 

• MDBLogger.xml 

• RevLog4jConfig.xml 

• RFDLogger.xml 

• ExportLog4jConfig.xml 

• RFDLogger.xml 

• PR2Logger.xml 
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  M 
Configuring Work Manager in Web Application 

Servers 

 
Process Modelling framework requires creation of Work Manager and mapping it to 
OFSAA instance. This configuration is required for WebSphere and WebLogic Web 
Application Server types. 

This section covers the following topics: 

• Configuring Work Manager in WebSphere Application Server 

• Configuring Work Manager in WebLogic Application Server 

 

Configuring Work Manager in Web Sphere Application Server 
This section is applicable only when the Web Application Server type is WebSphere. 

This section covers the following topics: 

• Creating Work Manager 

• Mapping Work Manager to OFSAA WebSphere Instance 

 

Creating Work Manager  

1. Open the WebSphere admin console in the browser window: 
http://<ipaddress>:<administrative console port>/ibm/console. 

(https if SSL is enabled). The Login window is displayed 

2. Login with the user id that has admin rights. 

 
3. From the LHS menu, expand Resources > Asynchronous beans and 

select Work Managers. 
 

4. Select the required Scope from the drop-down list. 

For example, Node=whf00aqnNode01, Server=server1. 

5. Click New in the Preferences section. 

 
6. Enter the Name as ‘wm’ and JNDI name as ‘wm/WorkManager ‘ in the respective 

fields. 

7. Enter the Thread pool properties. 

8. Click Apply. 
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9. Click Save. 

 

After creating work manager successfully, you have to map it to OFSAA instance. 

 

Mapp ing Work Manager to OFS AA WebSphere Ins tance  

1. From the LHS menu, expand Applications > Application Types and 

select WebSphere enterprise applications. 

2. Click OFSAAI instance hyperlink. 

3. Click Resource references link under References section. 

4. Click Browse corresponding to the Work Manager Resource 
Reference. The available resources are displayed. 

5. Select the newly created Work Manager (‘wm’) and click Apply. 

6. Select the Work Manager (‘wm/WorkManager’) and click OK. 
 

7. Click Save. 

 

Configuring Work Manager in WebLogic Application Server 
This section is applicable only when the Web Application Server type is WebLogic. 

 

Creating Work Manager  
1. Open the WebLogic admin console in the browser window: 

http://<ipaddress>:<administrative console port>/console. (https if SSL is enabled). 

The Welcome window is displayed. 

2. Login with the user id that has admin rights. 

3. From the Domain Structure menu in the LHS, expand Environment and select 

4. Work Managers. The Summary of Work Managers window is displayed. 

5. Click New to create a new work manager component. 

6. Select Work Manager and click Next. 

7. Enter the Name as ‘wm/WorkManager’. 

8. Click Next. 

9. Select the required deployment target and click Finis h. 
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  N 
Configuring TDE, Data Redaction and the 

Corresponding Settings in OFSAA 

 
Two features comprise Oracle Advanced Security: Transparent Data Encryption and 
Oracle Data Redaction. 

This section details about the configurations required in case you want to enable TDE 
or Data Redaction in OFSAA applications. 

 

 

Transparent Data Encryption (TDE) 
Transparent Data Encryption (TDE) enables you to encrypt sensitive data, such as 
Personally Identifiable Information (PII), that you store in tables and tablespaces. After 
the data is encrypted, this data is transparently decrypted for authorized users or 
applications when they access this data. To prevent unauthorized decryption, TDE 
stores the encryption keys in a security module external to the database, called a 
Keystore. For more details on TDE, see the Database Advanced Security Guide. 

TDE tablespace encryption enables you to encrypt all of the data stored in a 
tablespace. To control the encryption, you use a Keystore and TDE master encryption 
key. Oracle Database supports both software keystores and hardware, or HSM-based, 
keystores. A software keystore is a container for the TDE master encryption key, and it 
resides in the software file system. 

 

Configuring TDE Du ring OFS ALM Installation Using Full Installer 

This section provides information on how to enable TDE (Transparent Data 
Encryption) in the database. This section consists of the following sub sections: 

• Configuring a Software Keystore and Encrypted Tablespace Creation 

• Running the Schema Creator Utility with Encryption 

• Testing the Encryption 

 

Configuring a Software Keystore and Encrypted Table space Creation 

A software keystore is a container for the TDE master encryption key, and it resides in 
the software file system. You must define a location for the key in the sqlnet.ora file so 
that the database locates the keystore (one per database) by checking the keystore 
location in the sqlnet.ora file. After defining the location, create the keystore and open 
it. Set the TDE master key after opening it and then encrypt the data. 

To find whether a wallet is already existing, check the following entries: 
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1. The location specified by the ENCRYPTION_WALLET_LOCATION parameter in the 
sqlnet.ora file. 

2. The location specified by the WALLET_LOCATION parameter in the sqlnet.ora file. 

Encrypted tablespaces can share the default database wallet. However, Oracle 
recommends that you use a separate wallet for transparent data encryption 
functionality by specifying the ENCRYPTION_WALLET_LOCATION parameter in the 
sqlnet.ora file. 

You should have proper privileges to perform the following actions. 

For details to configure the software keystore, perform the following steps: 

Step 1: Set the Software keystore location in the sqlnet.ora file 

The first step is to designate a location for software keystore in the sqlnet.ora file. The 
Oracle Database will check the sqlnet.ora file for the directory location of the keystore 
to determine whether it is a software keystore or a hardware module security (HSM) 
keystore. 

NOTE: Ensure that the directory location which you want to set for software keystore 
exists beforehand. Preferably, this directory should be empty. 

In a multitenant environment, the keystore location is set for the entire multitenant 
container database (CDB), not for individual pluggable databases (PDBs). 

By default, the sqlnet.ora file is located in the ORACLE_HOME/network/admin 
directory or in the location set by the TNS_ADMIN environment variable. Ensure that 
you have properly set the TNS_ADMIN environment variable to point to the correct 
sqlnet.ora file. 

To create a software keystore on a regular file system, use the following format when 
you edit the sqlnet.ora file: 

ENCRYPTION_WALLET_LOCATION= 

(SOURCE= 

(METHOD=FILE) 

(METHOD_DATA= 

(DIRECTORY=<<path to keystore>>))) 

Examples: 

For regular file system in which the database name is orclb: 

ENCRYPTION_WALLET_LOCATION= 

(SOURCE= 

(METHOD=FILE) 

(METHOD_DATA= 

(DIRECTORY=/etc/ORACLE/WALLETS/orcl))) 

When multiple databases share the sqlnet.ora file: 

ENCRYPTION_WALLET_LOCATION= 

(SOURCE= 

(METHOD=FILE) 

(METHOD_DATA= 



Transparent Data Encryption (TDE) 

Configuring TDE, Data Redaction and the Corresponding Settings in OFSAA N-177 

 

 

 

(DIRECTORY=/etc/ORACLE/WALLETS/orcl))) 

 

 

When Oracle Automatic Storage Management (ASM) is configured: 

ENCRYPTION_WALLET_LOCATION= 

(SOURCE= 

(METHOD=FILE) 

(METHOD_DATA= 

(DIRECTORY=+disk1/mydb/wallet))) 

For ASM Diskgroup: 

ENCRYPTION_WALLET_LOCATION= 

(SOURCE= 

(METHOD=FILE) 

(METHOD_DATA= 

(DIRECTORY=+ASM_file_path_of_the_diskgroup))) 

Step 2: Create the Software Keystore 

There are three different types of Software Keystores: 

• Password-based Software Keystores 

• Auto-login Software Keystores 

• Local Auto-login Software Keystores 

Perform the following steps to create a software keystore: 

1. Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM 
privilege. 

2. Use the following command to create password-based software keystore: 

CONN sys/password@serviceid AS SYSDBA 

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE 'keystore_location' 
IDENTIFIED BY software_keystore_password; 

• keystore_location is the path of the keystore directory you want to create 

• software_keystore_password is the password of the keystore that you want to 
create. 

For example, to create the keystore in the /etc/ORACLE/WALLETS/orcl 
directory: 

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE 

'/etc/ORACLE/WALLETS/orcl' IDENTIFIED BY password; 

After you run this statement, the ewallet.p12 file, which is the keystore, appears in 
the keystore location. 

• Alternatively, you can create an Auto-Login or Local-Login Keystore to avoid 
opening the Keystore manually every time. Use the following command: 

ADMINISTER KEY MANAGEMENT CREATE [LOCAL] AUTO_LOGIN 

KEYSTORE FROM KEYSTORE 'keystore_location' IDENTIFIED BY 

keystore_password; 
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• LOCAL enables you to create a local auto-login software keystore. Otherwise, 
omit this clause if you want the keystore to be accessible by other computers. 

After you run this statement, the cwallet.sso file appears in the keystore location. 

NOTE: It is important to remember the master key password (<keystore_ 
password>) used during creation of the keystore. There are no ways to retrieve the 
password if forgotten. 

Step 3: Open the Software Keystore 

Depending on the type of keystore you create, you must manually open the keystore 
before you can use it. 

You do not need to manually open auto-login or local auto-login software keystores. 
These keystore are automatically opened when it is required, that is, when an 
encryption operation must access the key. If necessary, you can explicitly close any of 
these types of keystores. You can check the status of whether a keystore is open, 
closed, open but with no master key, or open but with an unknown master key by 
querying the STATUS column of the V$ENCRYPTION_WALLET view. 

NOTE: After you open a keystore, it remains open until you manually close it. Each 
time you restart a database instance, you must manually open the password keystore 
to re-enable encryption and decryption operations. 

Perform the following steps to open the software wallet: 

1. Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM 
privilege. 

2. Use the following command to open password-based software keystore: 

CONN sys/password@serviceid AS SYSDBA 

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY 

software_keystore_password [CONTAINER = ALL | CURRENT]; 

• software_keystore_password is the same password that you used to create the 
keystore in "Step 2: Create the Software Keystore". 

• CONTAINER is for use in a multitenant environment. Enter ALL to set the 
keystore in all of the PDBs in this CDB, or CURRENT for the current PDB. 

NOTE: In a CDB, open the Keystore in the ROOT (CDB$ROOT) container and in 
all the associated PDBs, where TDE is enabled. 

You do not need to manually open auto-login or local auto-login software 
Keystores. 

Step 4: Set the Software TDE Master Encryption Key 

Once the keystore is open, you can set a TDE master encryption key for it. The TDE 
master encryption key is stored in the keystore. This key protects the TDE table keys 
and tablespace encryption keys. By default, the TDE master encryption key is a key 
that Transparent Data Encryption (TDE) generates. 

In a multitenant environment, you can create and manage the TDE master encryption 
key from either the root or the PDB. 

Ensure that the database OPEN_MODE is set as READ WRITE. To find the status for a 
non-multitenant environment, query the OPEN_MODE column of the V$DATABASE 
dynamic view. If you are using a multitenant environment, then query the V$PDBS 
view. (If you cannot access these views, then connect as SYSDBA and try the query 
again. In order to connect as SYSKM for this type of query, you must create a 
password file for it. See Oracle Database Administrator's Guide for more information.) 



Transparent Data Encryption (TDE) 

Configuring TDE, Data Redaction and the Corresponding Settings in OFSAA N-179 

 

 

 
Perform the following steps to set the encryption key: 

1. Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM 
privilege. 

2. Use the following command to set the encryption key: 

CONN sys/password@serviceid AS SYSDBA 

ADMINISTER KEY MANAGEMENT SET KEY [USING TAG 'tag'] 

IDENTIFIED BY password [WITH BACKUP [USING 'backup_ 

identifier']] [CONTAINER = ALL | CURRENT]; 

• tag is the associated attributes and information that you define. Enclose this 
setting in single quotation marks (' '). 

• password is the mandatory keystore password that you created when you 
created the keystore in "Step 2: Create the Software Keystore". 

• WITH BACKUP creates a backup of the keystore. You must use this option for 
password-based keystores. Optionally, you can use the USING clause to add a 
brief description of the backup. Enclose this description in single quotation 
marks (' '). This identifier is appended to the named keystore file (for example, 
ewallet_time_stamp_emp_key_backup.p12, with emp_key_backup being the 
backup identifier). Follow the file naming conventions that your operating 
system uses. 

• CONTAINER is for use in a multitenant environment. Enter ALL to set the 
key in all of the PDBs in this CDB, or CURRENT for the current PDB. 

For example, 

ADMINISTER KEY MANAGEMENT SET KEY IDENTIFIED BY password WITH 

BACKUP USING 'emp_key_backup'; 

Step 5: Encrypting your Data 

After completing the keystore configuration, encrypt the data. You can encrypt 
individual columns in a table or entire tablespaces. OFSAA recommends encrypting 
entire tablespaces and the description in this section covers encrypting entire 
tablespaces. 

Note the following restrictions on using Transparent Data Encryption when you 
encrypt a tablespace: 

• Transparent Data Encryption (TDE) tablespace encryption encrypts or decrypts 
data during read and write operations, as compared to TDE column encryption, 
which encrypts and decrypts data at the SQL layer. This means that most 
restrictions that apply to TDE column encryption, such as data type restrictions 
and index type restrictions, do not apply to TDE tablespace encryption. 

• To perform import and export operations, use Oracle Data Pump. 

Encrypting data involves the following steps: 

Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption 

Step 2: Setting the tablespace TDE master encryption key 

Step 3: Creating the Encrypted Tablespace 

Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption 

Prerequisite- You must set the COMPATIBLE initialization parameter for the database 
to 11.2.0.0 or later. Once you set this parameter to 11.2.0.0, the change is irreversible. 
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Perform the following steps to set the COMPATIBLE initialization parameter: 

1. Log into the database instance. In a multitenant environment, log into the PDB. 

2. Check the current setting of the COMPATIBLE parameter. 

For example: 

SHOW PARAMETER COMPATIBLE 

 

 

NAME  TYPE VALUE 

compatible 

noncdbcompatible 

 

string 

BOOLEAN 

 

12.0.0.0 

FALSE 

3. If you want to change the COMPATIBLE parameter, perform the following steps: 

1. a.Locate the initialization parameter file for the database instance. 

UNIX systems: This file is in the ORACLE_HOME/dbs directory and is 
named initORACLE_SID.ora (for example, initmydb.ora). 

2. In SQL*Plus, connect as a user who has the SYSDBA administrative privilege, 
and then shut down the database. 

For example: 

CONNECT /AS SYSDBA 

SHUTDOWN 

3. Edit the initialization parameter file to use the correct COMPATIBLE setting. 

For example: 

COMPATIBLE = 12.2.0.0 

4. In SQL*Plus, ensure that you are connected as a user who has the SYSDBA 
administrative privilege, and then start the database. 

For example: 

CONNECT /AS SYSDBA 

STARTUP 

5. If tablespace encryption is in use, then open the keystore at the database 
mount. The keystore must be open before you can access data in an encrypted 
tablespace. 

STARTUP MOUNT; 

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY 

password; 

ALTER DATABASE OPEN; 

Step 2: Setting the tablespace TDE master encryption key 

Make sure that you have configured the TDE master encryption key as shown in Step 
4: Setting the software TDE master encryption key. 

Step 3: Creating the Encrypted Tablespace 

After you have set the COMPATIBLE initialization parameter, you are ready to create 
the encrypted tablespace. 

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
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Follow the instruction given in Running the Schema Creator Utility with Encryption 
section for configuring the schema creator file to create tablespaces. 

If you are enabling TDE in case of upgrade or you did not enable it during installation 
and want to enable at a later point of time, see 

the following reference link for details on manually creating encrypted tablespaces: 

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_ 
config.htm#ASOAG9555 

 

Running the Schema Creator Utility with Encryption 
Run the schema creator utility by including the encrypt=on option in the Tablespace 
tag in the <<APP PACK>>_SCHEMA_IN.xml Schema in xml file. You have to perform 
this procedure manually as it is’s not a part of the schema <<APP PACK>>_SCHEMA_ 
IN.xml.TEMPLATE template originally.Run the schema creator utility by including 
the encrypt=on option in the Tablespace tag in the <<APP PACK>>_SCHEMA_IN.xml 
file. You have to perform this procedure manually as it is not a part of the <<APP 
PACK>>_SCHEMA_IN.xml.TEMPLATE originally. 

Following is an example for OFS _ALM_PACK_ SCHEMA_IN.xml 

<APPPACKSCHEMA> 

<APP_PACK_ID>OFS_AAAI_PACK</APP_PACK_ID> 

<JDBC_URL>jdbc:oracle:thin:@<DB_Server_IP>:1521:<DB_NAME></JDBC_ 

URL> 

<JDBC_DRIVER>oracle.jdbc.driver.OracleDriver</JDBC_DRIVER> 

<HOST><OFSAA_Server_IP/HOST Name></HOST> 

<SETUPINFO NAME="<PREFIX_NAME>" PREFIX_SCHEMA_NAME="Y"/> 

<PASSWORD APPLYSAMEFORALL="Y" DEFAULT="<PASSWORD>"/> 

<TABLESPACES> 

<TABLESPACE NAME="OFS_AAI_TBSP" VALUE="TS_USERS1" 

DATAFILE="<ABSOLUTE PATH to TABLESPACE>/<TABLESPACE_DATA_FILE_ 

NAME>.dbf" SIZE="500M" AUTOEXTEND="OFF" ENCRYPT="ON" /> 

</TABLESPACES> 

<SCHEMAS> 

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_ID="OFS_ 

AAI" DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 

QUOTA="unlimited"/> 

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_ 

AAAI" DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 

QUOTA="unlimited" INFODOM="OFSAAAIINFO"/> 

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_ 

IPE" DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 

QUOTA="unlimited" INFODOM="OFSAAAIINFO"/> 

</SCHEMAS> 

</APPPACKSCHEMA> 

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
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Testing the Encryption 
Test the encryption by checking if a tablespace is encrypted or not. Execute the 
following query to check: 

SELECT tablespace_name, encrypted FROM dba_tablespaces; 

The following result is displayed, which indicates whether the TABLESPACE is 
encrypted (ENCRYPTED TS - YES) or not (ENCRYPTED TS - NO) in the 
ENCRYPTED column: 

TABLESPACE_NAME ENCRYPTED 

 

 

SYSTEM NO 

SYSAUX NO 

UNDOTBS1 NO 

TEMP NO 

USERS NO 

ENCRYPTED_TS YES 

6 rows selected. 

 

Configuring TDE in case of Upgrade 

This section details about the configurations required in case you want to enable TDE 
in OFSAA applications after upgrade to OFSAA 8.0.6.0.0 version from a previous 
version. Additionally, these configurations are required in case you did not enable 
TDE during 8.0.6.0.0 installation and want to enable at a later point of time. 

1. Create a new PDB (12c)/ instance (11g) on same or different Database Server for 
TDE. For more information, see Configuring Software Keystore and Encrypted 
Tablespace Creation. 

2. Shutdown the OFSAAI Services. 

3. Export all Configuration, Atomic and Sandbox Schemas as per the applications 
installed in your OFSAA instance. 

For example: 

expdp SYSTEM/oracle@OFSA12C2DB DIRECTORY=data_pump_dir 

DUMPFILE=ofsaaconf_ofsaaatm_%U.dmp filesize=2G 

SCHEMAS=ofsaaconf,ofsaaatm LOGFILE=ofsaaconf_ofsaaatm_exp.log 

 

No te : The above command will create data dumps as files of 2GB 
size each (multiples). Any other commands/ tools as appropriate may 
be used to archive the schemas. 

 

 

4. Import all schemas that are exported using the above command, into the new DB 
instance. 

For example: 

impdp SYSTEM/oracle@OFSA12nDB DIRECTORY=data_pump_dir 

DUMPFILE=ofsaaconf_ofsaaatm_%U.dmp 

SCHEMAS=ofsaaconf,ofsaaatm LOGFILE=ofsaaconf_ofsaaatm_imp.log 
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No te : Restoring the exported dumps creates Configuration and Atomic 
Schema(s) with the same user credentials as that of the source, along with the 
existing grants. 

If schemas are restored using a tool/ mechanism other than as mentioned in 
the Step 1 and 2, retain the user credentials of Configuration and Atomic 
Schemas same as in the Source environment, along with the Schema grants. 

 

5. Provide select grants on sys.V_$parameter to view Configuration and Atomic 
Schemas of Target Environment database 

For example: 

Login as sys user: 

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaconf; 

Grant succeeded 

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaatm; 

Grant succeeded 

6. Update .profile for ORACLE_SID environment variable with new ORACLE_ 
SID. 

7. Update JDBC URL by executing Port Changer utility. For details on how to 
execute Port Changer utility, see Changing IP/ Hostname, Ports, Deployed paths, 
Protocol of the OFSAA Instance section. 

8. Navigate to the $FIC_WEB_HOME directory and execute the following command 
to trigger the creation of EAR/WAR file: 

./ant.sh 

9. The EAR/WAR file - <contextname>.ear/.war - is created in $FIC_WEB_HOME 

directory. 

10. On completion of EAR/WAR file creation, the message "BUILD SUCCESSFUL" 
will be displayed. 

11. Edit the existing Connection Pool settings to point to new JDBC URL and verify 
connections. 

12. Clear the webserver cache and redeploy the application onto your configured web 
application server. 

13. Restart the OFSAA Services. For more information, refer to the Start/Stop 
Infrastructure Services section. 

 

Data Redaction 
OFSAA is enhanced to enable masking of sensitive data and Personal Identification 
Information (PII) to adhere to Regulations and Privacy Policies. Oracle Data Redaction 
provides selective, on-the-fly redaction of sensitive data in database query results 
prior to display by applications so that unauthorized users cannot view the sensitive 
data. The stored data remains unaltered, while displayed data is transformed to a 
pattern that does not contain any identifiable information. 
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Enabling Data Redaction in case of Upgrade 

This section details about the configurations required in case you want to enable Data 
Redaction in OFSAA applications after upgrade to OFSAA 8.0.6.0.0 version from a 
previous version. Additionally, these configurations are required in case you did not 
enable TDE during OFS ALM 8.0.6.0.0 installation and want to enable at a later point 
of time. 

Perform the following steps: 

1. Login as SYSDBA into the database. 

2. Execute the file $FIC_HOME/utility/data_security/scripts/create_ 
data_sec_roles.sql only once per database (PDB in case of 12c). 

3. Execute the following sql statement to find out the list of atomic users from the 
table: 

select v_schema_name from aai_db_detail where V_DB_NAME <> 

'CONFIG' AND V_DB_TYPE = 'ORACLE' 

4. Execute the file $FIC_HOME/utility/data_security/scripts/grant_ 
data_sec_roles.sql for all atomic users found in the previous step. 

5. From the Configuration window in the System Configuration module, select the 
Allow Data Redaction checkbox. 

6. Run the Data Redaction utility. For more details on how to run the utility, see Data 
Redaction section under Data Security and Data Privacy chapter in OFS Analytical 
Applications Infrastructure Administration Guide 8.0.6.0.0. 
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  O 
FAQs and Error Dictionary 

 
This section of the document consists of resolution to the frequently asked questions 
and error codes noticed during OFSAAI installation. 

• Frequently Asked Questions 

• Error Dictionary 

OFSAAI installer performs all the pre-requisite validation check during installation. 
Any errors encountered in the process is displayed with an appropriate Error Code. 
You can refer to the Error Dictionary to find the exact cause and resolution to rectify 
the error. 

 

Frequently Asked Questions 
You can refer to the Frequently Asked Questions which has been developed with the 
interest to help you resolve some of the OFSAAI Installation and configuration issues. 
This intends to share the knowledge of problem resolution to a few of the known 
issues. This is not an official support document and just attempts to share the 
knowledge of problem resolution to a few of the known issues. 

This section includes the following topics: 

• OFSAAI FAQs 

• Application Pack 8.0.6.0.0 FAQs 

• Forms Framework FAQs 
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OFSAAI FAQs 
What are the different components that get installed during OFSAAI? 

The different components of OFSAAI are illustrated in Figure 1–2, "Components 
of OFSAAI". 

What are the different modes of OFSAAI installation? 

OFSAAI can be installed in two modes, Silent Mode, and GUI mode. 

Can the OFSAA Infrastructure components be installed on multi-tier? 

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed 
on multi-tier. By default, they will be installed on single-tier. However, OFSAA 
Infrastructure can be deployed within the n-Tier architecture where the Database, 
Web Server and Web Application Server is installed on separate tiers. 

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be 
uninstalled after OFSAA installation? 

JDK is not required during installation of OFSAA and only a run time is needed. 
For details, see Hardware and Software Requirements, Java Runtime Environment 
section. 

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI 
installation? 

Only JRE (Java Runtime Environment) is required during installation of OFSAA 
and cannot be uninstalled as the JRE is used by the OFSAA system to work. 

How do I know what are the Operating system, webservers and other software 
versions that OFSAA supports? 

Refer to OFSAA Technology Stack Matrices. 

What are the different files required to install OFSAAI? 

The following files are required: 

• setup.sh. 

• envCheck.sh 

• preinstallcheck.sh 

• VerInfo.txt 

• OFSAAInfrastructure.bin 

• validatedXMLinputs.jar 

• MyResources_en_US.properties 

• log4j.xml 

• OFSAAI_PostInstallConfig.xml 

• OFSAAI_InstallConfig.xml 

• privileges_config_user.sql 

• privileges_atomic_user.sql 

What should I do if I get the following error message during installation: 

“Execute Permission denied"? 

Check whether all the files provided for OFSAAI installation has execute 
permissions. 

http://docs.oracle.com/cd/E55339_01/homepage.htm
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To give execute permissions, 

• Navigate to the path OFSAAI_80200 and execute the command 

chmod 755 

"Graphical installers are not.." 

If error resembles "Graphical installers are not supported by the VM. The console 
mode will be used instead..." then check whether any of the X-windows software 
has been installed. 

Example: Hummingbird Exceed is started and configured to Graphical mode 
installation. 

 

No te : Type 'xclock' from prompt and this should display clock in 
graphical mode. 

 

 

"No Java virtual machine could be…" 

If the error message reads "No Java virtual machine could be found from your 
PATH environment variable. You must install a VM prior to running this 
program", then 

• Check whether "java path" is set in PATH variable. See the Table 3–1, 
" Prerequisite Information"section in this document. 

• Check whether sufficient temporary space is available. 

• Ensure that the movement of OFSAAI Installer text files to the target system is 
done in the Text mode so that setup.sh file does not contain control line feed 
characters (^M). 

What should I do if I get the following error message during installation, 
"OracleDriver Files Not Found, Please Choose the Right Path To Continue"? 

Check whether the provided path for Oracle Driver files is correct and whether the 
user has permissions to access the files. 

What should I do if I get the following error message during installation, "User must 
have CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, 
CREATE SEQUENCE, CREATE PROCEDURE" even though the oracle schema user 
created has the mentioned privileges? 

OFSAAI installer validates the database details provided during installation, so 
ensure: 

• Whether the oracle schema user has the required set of privileges for 
successful installation. 

• Whether the oracle schema user has been created with quota privileges on 
tablespace to create database objects. 

See the Table 3–1, " Prerequisite Information"section in this document. 

Installation of OFSAAI was completed successfully! What next? 

Post the successful completion of OFSAAI installation, one has to perform the Post 
Installation steps. See Post Installation Configurations. 

What is to be done when OFSAAI Installation is unsuccessful? 

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the 
Infrastructure Installation Directory. There is also another log file created in the 
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path configured in Log4j.xml. If the logs of any of these reported Warnings, Non 
Fatal Errors, Fatal Errors or Exceptions, they should be brought to the notice of the 
OFSAAI Oracle Support Services. It is recommended not to proceed, until the 
reported problems are adequately addressed. 

How do I completely uninstall OFSAAI? 

OFSAAI can be completely uninstalled by performing the steps provided in 
Uninstalling OFSAA Infrastructure section in this guide. 

Can OFSAAI config and atomic schemas be on different databases? 

OFSAAI requires both config and atomic schemas to be present on the same 
database instance. 

How do I grant privileges if a new information domain is created? 

If you are creating a new information domain, provide a set of privileges (database 
permissions) to the new Atomic schema. 

• Log into the database as sys and connect as sysdba user. 

• Execute the file privileges_config_user.sql available under $FIC_HOME 

directory 

• Enter the database schema for which you want to grant privileges. 

When should I run the MLS utility? 

See the Multiple Language Support (MLS) Utility section in OFS AAI 
Administration Guide available on OTN. 

Does OFSAAI support Oracle Linux versions other than 5.5? 

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 
and above. 

What should I do if I get the following error message on the UNIX System terminal 
while executing ./setup.sh, "Insert New Media. Please insert Disk1 or type its 
location"? 

1. Login as root user on the Unix machine where OFSAAI is getting installed. 

2. Navigate to the path /etc/security/. 

3. Edit the file limits.conf to add/edit a row for the unix user installing 
OFSAA: 

<Unix User> soft nofile 9216 

4. After saving the changes, log in as unix user with which OFSAAI is getting 
installed and execute the command: 

ulimit -n 

The command should return the value 9216. 

How do I verify if the system environment is ready for OFSAAI installation? 

To verify the system environment meets the minimum requirements for the 
installation, a Pre-Install Check utility is available within the Install Kit archive 
file. This utility can also be obtained separately by contacting Oracle Support. 

See Verifying System Environment section for additional information. 

How do I know if the installation is completed successfully? 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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The OFSAA Infrastructure installation performs a post install health check 
automatically on successful installation of the product. To rerun the post install 
verification at a later time, perform the following steps: 

1. Navigate to the path $FIC_HOME (Product Installation Directory). 

2. Execute the command: 

./piverify.sh 

What should I do if the installation in GUI mode is not invoked? 

There are set of configuration steps required to be performed during the 
installation in GUI mode. Verify whether the steps mentioned under Configuring 
for GUI Mode Installation section are done correctly. 

What should I do if there are any exceptions or errors in installation and how to 
proceed? 

1. Please backup the installation logs. 

2. Share the backup logs with Oracle Support Services. 

What should I do if I get the following error message during OFSAAI installation on 
Solaris 11 system?: 

"Error: OFSAAI-1108 

ORA-00604: error occurred at recursive SQL level 1 

ORA-01882: timezone region not found" 

Or 

"Time zone cannot be set as null or 'localtime' " 

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set 
the environment variable TZ to a valid time zone region in the .profile file. For 
example, 

TZ=Asia/Calcutta 

export TZ 

What should I do if the installation process is abruptly terminated or aborted? 

If the installation process is abruptly terminated, then the installation will be 
incomplete. To recover from this, follow these steps: 

1. Drop the DB objects in the config schema created by OFSAAI installation. 

2. Open the .profile and remove the entries made by the OFSAAI installation 
which are made between the comment statements, #Beginning of entries by 
OFSAA Infrastructure installation and #End of entries by OFSAA 
Infrastructure installation. 

3. Delete the OFSAA install directory created by the OFSAAI installer. 

4. Perform the OFSAAI installation again. 

Does OFSAA support any other web server types, other than the ones stated in Tech 
Matrix and Installation Guide? 

No, all the supported softwares and versions are stated in the OFSAA Technology 
Stack Matrices. 

http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E55339_01/homepage.htm


Frequently Asked Questions 

O-190 OFS ALM Application Pack Installation and Configuration Guide 

 

 

 

What should I do if the database connection from connection pool displays the 
following error message, "java.sql.SQLRecoverableException: IO Error: Connection 
reset"? 

This happens while running several database intensive tasks in parallel. To correct 
this error, add the line securerandom.source=file:/dev/./urandom in the 
java.security configuration file available in $JAVA_HOME/jre/lib/security/ 
path. 

 

No te : This needs to be configured on all the machines or VMs where 
the OFSAAI components are installed. 

 

 

If the issue is not resolved even with the preceding settings, check the 
MTU(Maximum Transmission Unit) settings on the linux box. For details on MTU 
settings and updating them, contact your system Administrator. 

What should I do when I get syntax errors/file not found error messages while 
invoking setup.sh file from my install archive? 

This could mostly happen: 

• When installer was not unzipped rightly or corrupted during unzip. 

• setup.sh file which resides within the install archive was not transferred in 
ASCII or text mode, which could have corrupted the file. 

To correct this, follow the steps: 

1. Copy the installer (in BINARY mode) to the system on which the OFSAA 
Infrastructure components will be installed. 

2. Unzip the installer using the command: 

unzip <OFSAAI_Installer>.zip 

3. The corrupted setup.sh file would have introduced certain ̂ M characters into 
the file. You can remove ^M characters from setup.sh file by following these 
steps: 

a. Login to the server where the installer is copied. 

b. Navigate to the directory OFSAAI_80200. 

c. Open the setup.sh file in the vi editor using the command: vi setup.sh. 

d. Inside vi editor in Esc mode, type: %s/^M//g 
 
 

No te : To enter ^M, hold the CTRL key then press V and M in 
succession. 

 

 

e. Save the setup.sh file by typing: wq! 

Does OFSAA support Oracle DB 11g Standard edition? 

The OCI client and the jdbc driver does not change depending on whether it is a 
standard or enterprise edition. So, OFSAAI will work with standard edition as 
well. 

We do not recommend standard edition because it will not scale and does not 
support partition pack, database security vault, or advanced analytics. 
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What should I do if I get the following error message while executing ./startofsaai.sh 
file on the UNIX System terminal "./startofsaai.sh: /java: Execute permission denied"? 

• Ensure JAVA_BIN environment variable path is set on the "unix user" terminal 
from where the startofsaai.sh file is invoked. 

• Ensure the .profile where the environment/ path settings are made has 
been executed successfully. 

What should I do if the OFSAAI Application Server does not proceed even after 
providing the system password? 

Ensure that, the System Password provided when prompted is "password0" 
provided during installation. Also check whether the connection to the 
"configuration schema" can be established through sqlplus. 

Although the OFSAAI installation has completed successfully, when OFSAAI servers 
are started, and the application URL is accessed, it gives an error message "the page 
cannot be found or displayed" or "Could not retrieve list of languages from Server. 
Please contact the system administrator". What should one do? 

Ensure OFSAAI servers have been started and are running successfully. For 
details on start up parameters options, see Starting Infrastructure Services section. 

For more details on the issue, refer to the Revappserver log in $FIC_APP_ 
HOME/common/FICServer/logs directory or the Web Server log files. 

Is it necessary to provide the specified grants to the Oracle schema user before 
installation? If yes, can it be revoked after completing the installation? 

The "Oracle schema" user requires the necessary grants specified before, during, 
and after the installation process. Grants provided should never be revoked as the 
application makes use of these grants all the time. 

Can we have distributed OFSAAI Application Server for load balancing? 

OFSAAI Application server can be scaled out/distributed across different JVM's 
(machines) based on the various services and Information Domains, in other 
words, Load balancing could be achieved with distribution of services. 

Why do we need FTPSHARE on all the layers? Can we have ftpshare on another 
machine other than the machines where OFSAAI is installed? 

FTPSHARE is a Metadata Repository directory. All the metadata related files used 
in Infrastructure are stored in the FTPSHARE directory. The ftpshare contains 
folders for each Information Domain, with each Information Domain folders 
holding Erwin, log, and scripts folder. The transfer of data among the Web, 
Application, and Database servers in Infrastructure takes place through 
FTP/SFTP. 

You need to configure FTP/SFTP and enable communication between the servers 
by providing App server's FTP/SFTP credentials to the Web server and DB server 
users. 

Yes, you can have FTPSHARE on another machine other than the machines where 
OFSAAI is installed. 

Is it mandatory to provide the FTP/SFTP password? 

Yes, OFSAAI needs credentials of the user who has complete permissions on 
FTPSHARE directory, and the user should be able to independently login to the 
unix server. 

What are the permissions required for FTPSHARE and when should I give them? 
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It is recommended to provide permissions on FTPSHARE in case of installations 
done across different machines or VMs (multitier installation). 

In case of single tier installation, 770 permissions can be provided if the Unix users 
of OFSAAI and web server belong to the same Unix group. 

Additionally, any new file that is created in the FTPSHARE folder of any 
installation layer should be granted specific/explicit permission. 

Port Change utility can be used to have the Port number modified, which are 
currently being used by the Infrastructure application. For more information, refer 
Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance section in 
OFS Analytical Applications Infrastructure Administration User Guide in OTN. 

Are there any in-built system administration users within OFSAAI Application? 

The three in-built system administration users are provided to configure and setup 
OFSAAI. 

• SYSADMN 

• SYSAUTH 

• GUEST 

Does OFSAAI Application support both FTP and SFTP? 

OFSAAI supports both FTP and SFTP configuration. 

Is it necessary to enable the FTP/SFTP services to use the OFSAAI? 

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards 
using the OFSAAI. 

OFSAAI Configuration: Unable to save the server details? 

• Ensure the input User ID, Password, and Share Name are correct. 

• Ensure FTP/SFTP services are enabled. 

• Have a test FTP/SFTP connection made and confirm if they are successful. 

What should I do if I get the following message while creating Information Domain, 
"Please create a database and then create the information domain"? 

Information Domain is mapped to only one Database; and thus before the creation 
of Information Domain, at least one database details should exist. 

What should I do if I get the following message during the startup of backend engine 
message server, "ConnectToDatabase: FatalError, could not connect to the DB server"? 

• Verify whether connection to the Configuration Schema can be established 
through SQL*PLUS. 

• Verify Configuration Schema password is modified post installation. 

• Ensure Oracle Database Alias Name created for Oracle Instance and Oracle 
Service Name are same. 

• On a multi tier installation mode, ensure TNSNAME and SID are same in both 
the Application and Database Layers. 

What should I do if I get the following message during the startup of backend engine 
message server, "Fatal Error, failed to get user ID from LibSmsConnect"? 

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the 
Database components are installed. 

http://docs.oracle.com/cd/E54637_01/homepage.htm
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Does OFSAAI Application support LDAP authentication? 

OFSAAI supports LDAP configuration and authentication. 

Does OFSAAI support multiple languages? 

Yes, OFSAAI supports multiple languages. 

Does OFSAAI provide any data back-up features? 

OFSAAI does not have built-in back up facility. External Storage Infrastructure is 
recommended for back-up. 

What kind of security features does the OFSAAI provide? 

OFSAAI provides security at: 

• Segment Level - Users can access only the segment they are mapped to. 

• Application Level - Users can perform an operation only if mapped to 
appropriate role and functions. 

Does OFSAAI have the ability to enforce periodic password change? 

OFSAAI provides configurable parameters to define number of days after which 
the user password would expire and then the user is forced to change the 
password after expiration period. 

What is the password policy followed in OFSAAI? 

OFSAAI enforces a minimum password length with a combination of Upper and 
Lower case characters and alpha-numeric strings. 

Which version of Erwin Data Modeller does OFSAAI support? 

OFSAAI framework supports Data Modeler Erwin versions 9.0, 9.2, 9.6, and 9.7 for 
backward compatibility. However, the data models shipped with version 8.0.6.0.0 
of the application packs are compatible with Erwin 9.5, 9.64, and 9.7. 

Does OFSAAI provide the mechanism to upload Business Data model? 

OFSAAI provides two mechanisms for business data model upload: 

• Easy to use GUI based Model upload mechanism to upload the Business Data 
Model through Data Model Management -->Data Model Maintenance --> 
Import Model. 

• OFSAAI also provides a model upload utility "upload.sh" for uploading the 
business data model through the command line parameter by executing this 
shell script file under the path <FIC_HOME>/ficapp/common/FICServer/bin. 

For more details, see Configuration for Model Upload Utility section of the OFS 
Analytical Applications Infrastructure User Guide available on OTN. 

How do I apply incremental change to the existing model when the Business Data 
model undergoes a change? 

Modified data model can be uploaded into the system and OFSAAI has the ability 
to compare the changes within the data model with respect to the one already 
present in the system and enables propagation of incremental changes in a 
consistent manner. 

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also 
by picking up the data model from the server location. 

http://docs.oracle.com/cd/E60058_01/homepage.htm
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Can the OFSAAI Configuration Schema password be modified post installation? 

The OFSAAI Configuration Schema password can be modified post installation. 
OFSAAI application stores the password in the database and few configuration 
files, thus any changes to the Configuration Schema password will require 
updating in those files. For more information, see Modifying OFSAA 
Infrastructure Config Schema Password. 

Can the OFSAAI Atomic Schema password be modified? 

The OFSAAI Atomic Schema password can be modified. OFSAAI application 
stores the atomic schema password in the database and few configuration files, 
thus any change to the atomic schema password will require updating those files. 

To change the Atomic Schema password, follow the steps: 

1. Login to OFSAA. 

2. Navigate to System Configuration > Database Details window. Select the 
appropriate connection, provide the modified password and save. 

3. Based on the Web Server installed, follow the steps: 

a. If you are using Apache as Web server: 

* Update the <Context> -> Resource tag details in server.xml file from the 
$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> 
will exist). 

b. If you are using WebSphere as Web server: 

* Login to the WebSphere Administration Console from the left side menu. 

* Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

* Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified). 

c. If you are using WebLogic as Web server: 

* Login to the WebLogic Administration Console from the left side menu. 

* Under Domain Structure list box, expand the appropriate Domain and 
navigate to Services > JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

* Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified). 

4. Restart the OFSAAI services 
 

No te : If the modified passwords are not updated, OFSAAI logs 
display the message ORA-28000: the account is locked. 

 

 

Does the upload of Business Data model depend on Java Memory? 

Business data model upload through OFSAAI depends on the Java memory 
settings on the client and server machines. Java memory setting varies with the 
data model size and the available RAM. Contact Oracle Support Services for more 
details. 

Why do the Business Metadata Management screens (Business Processors screen) in 
User Interface, take more time to load than other screens? 
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The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is 
continuously being updated/refreshed to cache metadata. This can be observed 
when you are starting startofsaai.sh and if any of the log file (For example, 
SMSService.log) in DynamicServices.xml is being continuously refreshed for 
longer time. 

By default, the Metadata Log file cache size is set to 1000. If in case the log is being 
updated beyond this limit, retrospectively the preceding entries are overwritten. 
For example, the 1001th entry is overwritten by deleting the first entry. This 
results in the application window taking a longer time to load. 

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, 
depending on the currently logged count for the specific metadata. 

1. Generate the Log report by executing the following query in config schema. 

select count(1), t.metadata_name, m.dsn_id 

from metadata_master m, metadata_type_master t 

where m.metadata_type = t.metadata_type 

group by t.metadata_name, m.dsn_id 

2. The preceding query returns a list of codes with their respective metadata 
count. You can refer to "metadata_type_master" table to identify the metadata 
name. 

3. View the log report to identify the metadata which is being  
updated/refreshed beyond the specified cache size limit. Accordingly increase 
the cache size limit in Dynamicservices.xml depending on the currently 
logged count for the specific metadata. 

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total 
measure reported in log is 1022, increase the limit to 2000 (approximately). 

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue. 

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere 
application server? 

The Java memory needs to be increased in ejbdeploy.sh file which is present 
under <WebSphere Install directory>/AppServer/deploytool/itp. For 
example, 

$JAVA_CMD \ 

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \ 

What configurations should I ensure if my data model size is greater than 2GB? 

In order to upload data model of size greater than 2GB from OFSAAI Data Model 
Management -->Data Model Maintenance--> Import Model, you need to configure 
the required model size in struts.xml file available in the path $FIC_WEB_ 
HOME/webroot/WEB-INF/classes. 

 

No te : The size requirements have to be always specified in bytes. 
 

 

For example, if you need to configure for model size of 2.5GB, then you can 
approximately set the max size to 3GB (3221225472 bytes) as follows, in order to 
avoid size constraints during model upload. 
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<constant name="struts.multipart.maxSize" value="3221225472"/> 

After configuring struts.xml file, generate the application EAR/WAR file and 
redeploy the application onto your configured web application server. For more 
information on generating and deploying EAR / WAR file, refer Appendix C. 

What should I do if my Hierarchy filter is not reflecting correctly after I make changes 
to the underlying Hierarchy? 

In some cases, the Hierarchy Filters do not save the edits correctly if the 
underlying Hierarchy has been changed. This can occur in hierarchy maintenance, 
where you have moved a member to another hierarchy branch, and that member 
was explicitly selected in the Filter and is now a child of a node which is already 
selected in the Filter. Refer Support Note for the workaround. 

Can I install an Application Pack on an existing Atomic schema/ Information 
Domain created manually? 

No, you cannot install an Application Pack on existing Atomic 
schema/Information Domain created manually. Application Packs can be 
installed only on Atomic Schemas/Information Domain created using schema 
creator utility and/ or the Application Pack installer. 

What should I do if I get the following exception while trying to view the model 
outputs in Model Outputs screen, "Exception ->Local Path/STAGE/Output file name 
(No such file or directory)"? 

Ensure you have created a folder "STAGE" under the path mentioned as "Local 
Path" in the web server details window. This folder needs to be created under the 
local path on every node, in case of web application server clustering. 

What should I do if I get the following exception during OFSAA services startup, 
"Exception in thread "main" java.lang.UnsatisfiedLinkError: net (Not a directory)"? 

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference 
to point to a physical JRE installed. 

What is the optimized memory settings required for "New" model upload? 

The following table lists the optimized memory settings required for "New" model 
upload. 

 
Table O–1 Optimized Memory Settings fo r Ne w Model Up load 

 

 
 

Model Up load Options 

 
Size of Data Model 
XML File 

X_ARGS _APP ENV 
Variable in OFS AAI 
AP P Layer 

Pick from Server 106 MB "-Xms1024m 
-Xmx1024m 

36 MB "-Xms2048m 
-Xmx2048m 

815 MB "-Xms4096m 
-Xmx4096m 

1243 MB "-Xms6144m 
-Xmx6144m 

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=536494621882321&id=1586342.1
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Table O–1    Optimized Memory Settings  fo r Ne w Model Up load 
 

 
 

Model Up load Options 

 
Size of Data Model 
XML File 

X_ARGS _APP ENV 
Variable in OFS AAI 
AP P Layer 

Model Upload Utility 106 MB "-Xms1024m 
-Xmx1024m"-Xms2048 
m -Xmx2048m 

336 MB "-Xms4096m 
-Xmx4096m 

815 MB "-Xms4096m 
-Xmx4096m 

1243 MB "-Xms6144m 
-Xmx6144m 

Save New Erwin File In 
Server 

106 MB "-Xms1024m 
-Xmx1024m 

336 MB "-Xms2048m 
-Xmx2048m 

 "-Xms4096m 
-Xmx4096m 

 "-Xms6144m 
-Xmx6144m 

 
What should I do if I get the following error message, "ORA 01792 maximum number 
of columns in a table or view is 1000 during T2T execution"? 

You should apply the following patch set from Oracle. Applicable only for 12c. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1 

I did not enable OFS Inline Processing Engine Application license during the 
installation. However, I have enabled it post installation, using the Manage OFSAA 
Product License(s) in the Admin UI. Are there any other additional configurations 
that I need to do? 

Yes. Follow the instructions explained in the OFS Inline Processing Engine 
Configuration Guide available on OTN. 

I get an error when I try to build an Oracle OLAP cube. What should I do? 

Execute the following grant on the appropriate ATOMIC schema 
grant olap_user to &database_username 

How do you turn off unused Information Domains (Infodoms) from caching? 

Follow these steps to turn off unused infodoms from caching: 

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation. 

2. In the DynamicServices.xml file, identify the section for <Service code="20">. 

3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

4. Repeat the same in the WEB layer too. Generate the application EAR/WAR 
file and redeploy the application onto your configured web application server. 
For more information on generating and deploying EAR / WAR file, refer to 
the Appendix C section. 

5. Restart the OFSAAI Services (APP and WEB). For more information, refer to 
the Starting Infrastructure Services section. 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1
http://docs.oracle.com/cd/E60058_01/homepage.htm
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No te : This setting helps cache the Infodom metadata only for the 
infodoms that are accessed after user login. Infodoms which are not 
accessed, are not cached. 

 

Sample code is as follows: 

<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" 

NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE> 

While creating an Excel Mapping, after specifying the excel worksheet, the target 
table, and mapping each column in the worksheet to a target table, I click Save and 
nothing happens. But when I click Cancel, a message pops up informing me that all 

changes will be discarded", what is to be done. 

Check if the version of Internet Explorer and JRE Plugin are as mentioned in the 
Desktop Requirements section of this manual. If not, use the qualified versions as 
mentioned. 

Can multiple OFSAA Infrastructure instances share the same Config Schema? 

No, only one OFSAA environment can be installed using one Config Schema. 

Can Atomic Schema be shared? 
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Yes, it can be shared between two OFSAA instances. 

While setting a firewall, which ports should be opened for communication between 
the Web Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the 
Web Application Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate 
properly? 

The OFSAA Servlet port which is same as Web server port should be open. Also 
the web application port should be open. 

Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database 
where older versions of OFSAA is Installed? 

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are 
not intending to use multi language support. 

Can I install already installed application in a different infodom? 

No, it is not possible to install the same application in two different infodoms. 

How can I configure the OFSAA application for High Availability? 

OFSAA can have active-passive high availability.  For more details, refer 
Configuration for High Availability- Best Practices Guide. 

During OFSAA installation should I provide web application server's IP /Hostname 
and port or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle 
HTTP Server/ IBM HTTP Server are configured? 

In case the web server is configured, you should enter the Web Server IP 
Address/Hostname and Port details during OFSAA installation. Here the Servlet 
port should be same as the Web Server port.  

If Web Server is not configured, the Web Application Server's IP Address/ 
Hostname and Port is required during the installation process. Here the Servlet 
port should be same as the Web application Server port. 

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.0.0.0 and higher 
versions? 

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. 
There is a change in the way agentservers are managed through 
AGENTSTARTUP.SH and AGENTSHUTDOWN.SH. 

What should I do when the message server process does not open and I get the 
following error message, "CI18NProvider::CI18NProvider, Error, unable to connect to 
the config database"? 

This error is displayed due to the following reasons: 

• The Config Schema password is already expired. 

• If the Config Schema password is going to expire soon and the message 
like  "ORA-28002: the password will expire within 6 days" displays while 
connecting to Config Schema through SQLPlus. 

• The Config Schema password is modified. 

To resolve the error, re-set the Config Schema password to the old password. Else, 
if the Config Schema password is modified to something else then follow these 
steps: 

1. Delete the $FIC_HOME/conf/Reveleus.SEC file. 

2. Shutdown the OFSAAI App service: cd $FIC_APP_ 
HOME/common/FICServer/bin ./stopofsaai.sh 

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf
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3. Shutdown the OFSAAI App service: cd $FIC_APP_ 
HOME/common/FICServer/bin ./stopofsaai.sh 

4. Start the Infrastructure Server in foreground directly on the server or through 
XWindows software using the command: ./startofsaai.sh 

5. Enter System Password. 

6. Enter the new Config schema password. The service starts and initializes if it 
is able to successfully connect to the DB and generates the Reveleus.SEC 
file. 

7. Post successful startup of the service, if required, the Infrastructure server may 
be shut down and restarted in the background using nohup mode. 

What is the mechanism of Log File sizing and backup? 

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs 
& <OFSAAI_DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in 
RevLog4jConfig.xml. 

The default size of the log files (MaxFileSize) is set to 5000kb and number of 
maximum backup log files (MaxBackupIndex) retained is set to 5, both of which 
are configurable. Increasing these parameters to a higher value should depend on 
the server hardware configurations and may reduce the performance. 

To configure the Logs file size on OFSAA Application server, follow these steps: 

1. Navigate to $FIC_HOME/conf where OFSAA is installed. 

2. Edit the following parameters in the file RevLog4jConfig.xml 

* param name="file" : Enter the path where the Logs are to be generated. 

* param name="MaxFileSize" : Provide the required file size. 

* param name="MaxBackupIndex" : Provide the required number of 
backup files to be created. 

Example: 

<appender name="REVSERVERAPPENDER" 

class="org.apache.log4j.RollingFileAppender"> 

<param name="file" value="$FIC_ 
HOME/ficapp/common/FICServer/logs/RevAppserver.log"/> 

<param name="Append" value="true" /> 

<param name="MaxFileSize" value="5000kb" /> 

<param name="MaxBackupIndex" value="5" /> 

<layout class="org.apache.log4j.PatternLayout"> 

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/> 

</layout> 

</appender> 

To configure the Deployed area logs file, follow these steps: 

1. Navigate to <EAR/WAR Deploy area>/conf folder. 

2. Repeat step 2 from the preceding section. 
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Can we modify the Log file path? 

Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml 
file. The default log file path (file) is set by the installer. This can be configured to 
another path. 

Can I point the environment with HTTP enabled to HTTPS after installation and vice 
versa? 

Follow these steps: 

1. Create SSL related certificates and import to respective servers. 

2. Enable SSL on a desired Port (example 9443) on your existing and already 
deployed web application servers. 

3. Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) 
configured and in all the URLs specified on the following files: 

* $FIC_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and $FIC_ 
HOME/ficweb/webroot/conf/FICWeb.cfg 

* $FIC_HOME/ficapp/icc/conf/WSMREService.properties 

* $FIC_HOME/ficweb/webroot/conf/ModelExecution.properties 

* $FIC_HOME/ficdb/conf/MDBPublishExecution.properties 

* $FIC_HOME/ficdb/conf/ObjAppMap.properties 

* $FIC_HOME/utility/Migration/conf/WSMigration.properties 

* $FIC_HOME/utility/WSExecution/conf/WSExecution.properties 

* $FIC_ 
HOME/EXEWebService/WebSphere/ROOT/WEB-INF/wsdl/EXEWebS 
erviceImpl.wsdl 

* $FIC_ 
HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServi 
ceImpl.wsdl 

* $FIC_ 

HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceIm 

pl.wsdl 

4. Replace XML attribute/Node values as specified on the following files: 

* $FIC_HOME/ficweb/webroot/WEB-INF/web.xml 

* FIC_WEBSERVER_PORT=9443 

* FIC_WEBPROTOCOL=https 

* $FIC_HOME/conf/LookUpServices.xml and $FIC_ 
HOME/ficweb/webroot/conf/LookUpServices.xml 

* PORT="9443" PROTOCOL="https:" 

5. Login to Config Schema and execute the following SQL command to replace 
protocol and SSL port. 

SQL> update configuration cn set cn.paramvalue='9443' where 

cn.paramname='SERVLET_ENGINE_PORT'; 

SQL> update configuration cn set 
cn.paramvalue=replace(cn.paramvalue,'http:','https:') where 
cn.paramname='FormsManagerCacheReload'; 
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SQL> update web_server_info ws set 

ws.servletport='9443',ws.servletprotocol='https'; 

6. Create EAR/WAR file and Re-Deploy. 

What should I do if my HIVE connection fails with the following exception: 

java.sql.SQLException: [Cloudera][HiveJDBCDriver](500164) 

Error initialized or created transport for authentication: 

[Cloudera][HiveJDBCDriver](500168) Unable to connect to server: 

GSS initiate failed. 

com.ibm.security.krb5.KrbException, status code: 37 

message: PROCESS_TGS at 

com.ibm.security.krb5.KrbTgsRep.<init>(KrbTgsRep.java:20) 

This happens if there is a clock skew between the client and the KDC server. To 
resolve this, there are two solutions: 

• Solution 1: 

Synchronize the clocks between the servers. For more information, refer 
http://docs.oracle.com/cd/E19253-01/816-4557/setup-192/index.html 

• Solution 2: 

1. Set clockskew parameter on the server side (KDC) krb5.conf file and replace 
the same file in HIVE_LIBRARY_PATH folder. Parameter value should be 
decided on the basis of the time difference between the two machines. 

2. Get the epoch time on the two servers by firing “date +%s” on the command 
line. 

3. Clockskew param value should be chosen as a value sufficiently larger than 
the difference of the preceding two calculated values. 

4. Set “clockskew = <value>” in the /etc/krb5.conf on the KDC server. 

5. Restart Kerberos services. 

What should I do if my schema creator log has the following exception: 

Failed to detect a valid hadoop home directory 

java.io.IOException: HADOOP_HOME or hadoop.home.dir are not set. 

at org.apache.hadoop.util.Shell.checkHadoopHome(Shell.java:302) 

at org.apache.hadoop.util.Shell.<clinit>(Shell.java:327) 

at org.apache.hadoop.util.StringUtils.<clinit>(StringUtils.java:79) at 
org.apache.hadoop.security.Groups.parseStaticMapping(Groups.java:130) 

at org.apache.hadoop.security.Groups.<init>(Groups.java:94) 

at org.apache.hadoop.security.Groups.<init>(Groups.java:74) 

at 
org.apache.hadoop.security.Groups.getUserToGroupsMappingService(Groups.java:30 
3) 

at 
org.apache.hadoop.security.UserGroupInformation.initialize(UserGroupInformation.j 
ava:283) 

http://docs.oracle.com/cd/E19253-01/816-4557/setup-192/index.html
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at 
org.apache.hadoop.security.UserGroupInformation.setConfiguration(UserGroupInfor 
mation.java:311) 

at HdfsDbUtil.connect(HdfsDbUtil.java:162) 

at SchemaParserUtil.validateHiveConnection(SchemaParserUtil.java:1359) 

at SchemaParserUtil.checkAllPreChecks(SchemaParserUtil.java:1011) 

at Main.execute(Main.java:317) 

at Main.main(Main.java:145) 

This occurs when HADOOP_HOME environment variable is not set. You can 
ignore this exception since we do not mandate to install HIVE where OFSAA is 
installed. 

What should I do if the sliced data model upload takes a long time to complete? 

If the metadata cache size is set to a lower value than the actual 

count of each metadata type (hierarchy, dataset, dimension etc), then 

it gets into performance degrade issues. We have to increase the cache 

size for each metadata type according to the count in the environment. 

Following are the parameters in DynamicServices.xml to be configured 

depends on the metadata count in your environment. 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/> 

Metadata count can be derived based on the following queries: 

select count(1) from metadata_master where metadata_version=0 --- 

for all metadata 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=1 --- for measure 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=2 --- for Dimension 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=3 --- for HCY 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=4 --- for DATASET 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=59 --- for BP's 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=54 --- for Alias 
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select count(1) from metadata_master where metadata_version=0 and 

metadata_type=5 --- for CUBES 

select count(1) from metadata_master where metadata_version=0 and 

metadata_type=856 --- for Derived Entity 

For LDAP authentication, which server connects with the LDAP server, the 
Application server (where ofsaai is installed), or Web Application server (where EAR 
is deployed)? 

For LDAP authentication, the Application server (ficapp) connects with the LDAP 
server. 

The LDAP server in the setup listens on secure protocol ldaps (port 636). I have the 
root certificate of the LDAP server for SSL, and would like to know where to offload 
this certificate? 

You need to import the certificate into the JDK/JVM used by Reveleus server in 
ficapp layer. 

How to relocate FTPSHARE folder? 

You can run the PortC.jar utility. For more details, refer Changing IP/ Hostname, 
Ports, Deployed Paths of the OFSAA Instance section in the OFSAAI Admin 
Guide available on OHC. 

How do we identify the list of ports that are used by/configured in an OFSAA 
environment? 

1. Navigate to $FIC_HOME folder on Target. 

2. Run the PortC.jar utility using the command: 

java -jarPortC.jar DMP 

A file with the name DefaultPorts.properties will be created under $FIC_ 
HOME directory which will contain the ports. For more information, refer 
Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance 
section in the OFSAAI Admin Guide available on OHC. 

 

No te : This feature is available only after applying 7.3.5.2.0 Minor 
Release patch. 

 

 

What should I do if I get the following error message, "Error while fetching open 
cursor value Status : FAIL"? 

This error occurs while executing envCheck.sh because the user does not have 
access to V$parameter. This error does not occur due to sysdba or non sysdba 
privileges provided they have access/grants to V$parameter. 

What should I do when an entity containing many attributes (>100 columns) is 
selected as Source entity and the Data Mapping (T2T definition) save operation takes 
longer than expected with the hourglass in the UI continuously rotating? 

The workaround is: 

1. Locate the webserver deployed area webroot/conf/excludeURLList.cfg 

file. 

2. Modify the following entries: 

• [SQLIA]./dataIntegrator/ to [ALL]./dataIntegrator/ 

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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• [SQLIA]./ETLExtractionServlet to 
[ALL]./ETLExtractionServlet 

3. Save the changes and restart the webserver. 

4. Resave the definition. 

What should I do if I get the following error message when I try to start the OLAP 
server: 

./olapdataserver: error while loading shared libraries: 

libessapinu.so: 

cannot open shared object file: No such file or directory 

FATAL ERROR :- OLAP DATA SERVER start up failed. 

This error occurs when OLAP component is not configured and OLAP feature in 
OFSAA is not used. However, this error can be ignored. 

How to patch the OFSAA Infrastructure Installation? 

Oracle strongly recommends installing the latest available patch set so as to be up to 
date with the various releases of the OFSAA product. 

Refer http://support.oracle.com for more information on latest release. 

How to clone the OFSAA Instance? 

There is a consistent need for a faster and effective approach of replicating an existing 
OFSAA instance for further project developments, that is, setting up OFSAA instances 
that are exact copies of the current OFSAA instance. 

For more information on cloning, refer OFSAA Cloning Reference Guide. 

What should I do if I get the error "FATAL ERROR-Problem with OFSAA Service" 
during OFS_ALM_PACK installation? 

Increase the sleep counter (default value is 80) to a higher value in the following 
section of the OFS_ALM_PACK/OFSAAIUpdate.sh file: 

if [ $count -eq 0 ] ; then 

sleep 80; 

count=` grep -i "FICServer Initialization Complete" 

$FIC_HOME/ficapp/common/FICServer/bin/nohup.out|wc   -l    ̀

fi 

if [[ $count -gt 0 ]] ; then 

echo OFSAA Service - OK 

else 

echo FATAL ERROR-Problem with OFSAA Service 

exit 1 

fi 

 

Ap plication Pack 8.0.6.0.0 FAQs 

What is an Application pack? 

An Application Pack is suite of products. For more information, refer About 
Oracle Financial Services Analytical Applications (OFSAA) Application Packs. 

http://support.oracle.com/
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Can I get a standalone installer for OFSAAI 8.0? 

No. AAI is part of every application pack and installs automatically. 

Where can I download OFSAA 8.0.2.0.0 Application Pack? 

You can download the OFSAAI 8.0.2.0.0 Application Pack from Oracle Software 
Delivery Cloud (OSDC). 

What are the minimum system and software requirements for OFSAA 8.0 Application 
Pack? 

Refer installation guide section Hardware and Software Requirements. 

Is my environment compatible with OFSAA 8.0.2.0.0 Application Pack? 

Environment Check utility performs the task. It is part of install and can also be 
run separately. 

Does the OFSAA 8.0.2.0.0 Application Pack support all Operating systems? 

OFSAA 8.0.2.0.0 Application pack supports the following Operating Systems: 
LINUX, AIX, SOLARIS 10, 11. Refer to Technology Matrix for the technology 
matrix that OFSAA suite products are/ will be qualified on. 

How can I install OFSAA 8.0.2.0.0 Application Pack? 

Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation 
And Configuration Guide published in OHC for the application pack installers. 

Does this installation require any Third party Softwares? 

Oracle Financial Services Advanced Analytical Infrastructure Installation And 
Configuration Guide published in OHC lists the third party software that needs to 
be installed. 

What languages are supported during OFSAA 8.0.2.0.0 Application Pack installation? 

US English is the language supported. 

https://edelivery.oracle.com/EPD/Search/handle_go
https://edelivery.oracle.com/EPD/Search/handle_go
http://docs.oracle.com/cd/E55339_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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What mode of installations OFSAA Application Pack supports? [that is., Silent, GUI] 

OFSAA Application Packs supports both GUI and Silent Mode. 

Does OFSAA 8.0.2.0.0 Application Pack support Multi tier Installations? 

OFSAA 8.0.2.0.0 supports only single tier installation. For more information refer 
to OFSAAI FAQs section. 

Does this Application Pack validate all prerequisites required for this installation 
like Memory, Disk Space and so on? 

Yes. The pre-requisite checks are done by the respective application pack installer. 

What happens if it aborts during installation of any application/products within an 
Application pack? 

You must restore the system and retrigger the installation 

Does this Application pack 'Roll Back' if any application installation fails due to 
errors? 

Rollback of installation is not supported. 

Does the Application pack install all applications bundled? 

All application pack system files are installed but there is an option to enable the 
licensed products. 

Can I re-install any of the Application Packs? 

You can retrigger in case of failure. 

Does this Application pack allow enabling / disabling any of the applications 
installed? 

Yes, you can enable but you cannot disable once the product is enabled in an 
environment. 

I have installed one application in an Application pack, can I install any of new 
application within the Application pack later? 

No, installation of additional applications is not required. If you wish to add an 
application later, you can enable the application at that time. 

How many OFSAA Infrastructures can be installed in a single server? 

There is no issue in installing separate OFSAAI installations, each with their own 
PFT/FTP installations and separate associated database instances and separate 
Web Server installations on the same server as long as adequate memory is 
allocated for each instance and as long as each OFSAAI installation is installed 
using a separate UNIX user and profile. Care should be taken if running multiple 
OFSAAI installations on a single server. Adequate memory will be required for 
each installation as several OFSAAI processes (model upload, DEFQ services, etc) 
take significant amounts of memory. So it depends on your server memory. 

Is it possible to install OFSAA 8.0.2.0.0 Application pack on an existing 'Infodom' 
where another OFSAA 8.0.2.0.0 application is installed? 

Yes. However, the Behavioral Detection Application Pack and Compliance 
Regulatory Reporting Application pack are the exceptions. They need to be 
installed in a different Infodom. 

Can I select an Infodom for the Application pack during installation? 

Yes. You can select or change the required infodom. 
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Can I install all Application Packs in a 'Single Infodom'? 

Yes. But, the Behavioral Detection Application Pack and Compliance Regulatory 
Reporting Application Pack are the exceptions. They need to be installed in a 
different Infodom. 

Is it possible to install applications on different Infodom within the Application 
pack? (For example, I want to install LRM and MR in two infodoms) 

Applications within application pack have to be installed in the same information 
domain in the same environment. 

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0? 

You can install only one infodom during installation. But after installation, you 
can create multiple infodoms. 

Is the 'Data Model' bundled specific to an Application pack or to an individual 
application? 

A merged data model for all applications within the application pack is bundled 
and uploaded. 

Is it possible to install OFS Enterprise Modeling later? 

OFS Enterprise Modeling is a separate product and can be enabled as an option 
later from any application pack that bundles Enterprise Modeling. 

Does the Application pack create sandbox automatically for the required 
applications? 

Yes, Sandbox creation is part of application install process. 

Are upgrade Kits available for individual applications or the complete Application 
Pack? 

Maintenance Level (ML) Release / Minor Release upgrades are available across 
all applications. 

Can I upgrade AAI only? 

Yes, you can upgrade AAI alone. 

Can I upgrade one application within the Application Pack? (For example, I want to 
upgrade LRM in the Treasury Application pack, but not MR.) 

No, an upgrade is applied to all applications in the application pack. 

Is it possible to uninstall any Application from the Application pack? 

No, it is not possible to uninstall any Application from the Application Pack. 

Can I uninstall entire Application Pack? 

No, you cannot uninstall the Application Pack. 

Is it possible to uninstall only application and retain AAI in the installed 
environment? 

No, you cannot uninstall only the application and retain AAI in the installed 
environment. 

Does Application Pack contain all Language Packs supported? 

Language Packs need to be installed on the application packs. 

Can I install an Application Pack over another Application Pack (that is same 
infodom or different infodom)? 
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Yes, you can install an Application Pack over another Application Pack in the 
same information domain or different information domain. But Behavioral 
Detection Application Pack and Compliance Regulatory Reporting Application 
Pack, Asset Liability Management Application Pack and Profitability Application 
Pack are the exceptions. They need to be installed in a different Infodom. 

Can I use an existing manually created schema as information domain for application 
pack installation? 

No. Schemas required by OFSAA applications have to be created using Schema 
Creator Utility. 

Does OFSAA 8.0.2.0.0 support on WebLogic 10.3.6 with Oracle 12c? 

Yes, OFSAA 8.0.2.0.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 
10.3.6 supports oracle 12c with some additional configurations. Refer the link 
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_ 
12cdriver.htm#JDBCA655 for additional configurations. 

What should I do if I get the following error message while running the schema 
creator utility, "HostName in input xml is not matching with the local hostname"? 

One possible reason could be the machine is configured for zonal partitioning. 
Ensure all the known IP Addresses of the machine are present in the /etc/hosts 
file. 

What are the Java versions supported in OFS ALM Application Pack version 8.0.2.0.0? 

OFS ALM Application Pack supports Java 1.7.x and 1.8.x. 

Is OFS ALM Application Pack version 8.0.2.0.0 supported on Java 8? 

Yes. To install this release of the OFS ALM Application Pack version 8.0.2.0.0 on Java 
8. For more information, refer to specific notes mentioned in the sections Installer and 
Installation Prerequisites, Configurations supported for Java 8, Configuring the 
Schema Creator Utility, Installing in GUI Mode, Installing in SILENT Mode. 

Can I upgrade the Oracle Database version from 11g to 12C on which OFSAA 8.0.6.0.0 
version is installed? 

Yes, you can upgrade. When the DB Server was Oracle 11g, the ojdbc jar used was 
ojdbc6.jar. But, when the DB is upgraded to 12c, you need to upgrade the 
ojdbc6.jar to ojdbc7.jar. 

Copy ojdbc7.jar from $ORACLE_HOME/jdbc/lib to the following locations: 

• $FIC_HOME/utility/OFSAAGenerateRepository/lib/ 

• $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/ 

• $FIC_HOME/ficdb/lib/ 

• $FIC_HOME/ficapp/icc/lib/ 

• $FIC_HOME/ficapp/common/FICServer/lib/ 

• $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/ 

• $FIC_HOME/ficweb/webroot/WEB-INF/lib/ 

• $FIC_HOME/ficdb/etl/classes/ 

What should I do when I get "[ERROR] - Error : APP Setup bin file failed." message 
during OFS_Application_PACK installation? 

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655%20for%20additional%20configurations
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655%20for%20additional%20configurations
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655%20for%20additional%20configurations
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This is a generic error message that appears during application installation failure. 
You should check the installation log files for more information about what failed the 
installation. 

However, if the message is displayed and the log files are not generated, it could be 
that it is a temp directory issue. The resolution is that your UNIX administrator has to 
disable the NOEXEC option. The installers extract the installation files into the /tmp 
directory, and if NOEXEC is enabled, execution of binaries will not happen in the 
directory and the installation fails. Re-run the installer after the configuration is 
changed. For detailed information, see the support note at 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1. 

What is the required disk space for ALM Application Pack installation? 

The required free disk space for ALM installation is Current disk space of $FIC_ 
HOME + Installer size. 

 

Forms Framework FAQs 
What should I do when I have large volume of data to be exported? 

It is recommended to use BIP reports or OBIEE reports if you have to export large 
volume of data. 

How do I export the columns added to the grid using Field Chooser option? 

Perform Grid Export operation to export the columns added to the grid by Field 
Chooser option. 

'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What 
should I do? 

Expand All/ Collapse All button is disabled if the number of hierarchy nodes is more 
than 50 and if it is a non-custom hierarchy. Hierarchy with more than 50 nodes is 
considered as large hierarchy and the data will be fetched dynamically when you 
expand the parent node. 

What is the difference between the two Searches available in the Hierarchy Browser 
window? 

In the new Hierarchy Browser window introduced from 7.3.5.1.0 version, there are 2 
search options available as highlighted in the following figure: 

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
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• DB Search (Top search container): It will search the required node in database 
and displays the result as shown below. This search is performed on full hierarchy 
nodes. 

• UI search (Below the hierarchy): This search will find the required node in the UI 
and will show in tree structure. 

 

No te : In case hierarchy nodes are more than 50 and if it is a 
non-custom hierarchy, then the UI search will not show the required 
node in tree structure, until all the nodes are expanded and loaded 
manually in the UI. 

 
What is a Custom Hierarchy? 

Custom hierarchies will be having the parameter configuration customQuery as 
shown below and the customized query will be taken from the HIERARCHY_FILTER_ 
MASTER table. 

Configuration in xml: 

<CONTROL ID="1003" TYPE="41"> 

<CONTROLPROPS> 

<EXTRAPARAMETERS> 

<PARAMETER NAME="customQuery" VALUE="Yes"/> 

</EXTRAPARAMETERS> 

</CONTROLPROPS> 
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</CONTROL> 

For custom hierarchy, all the hierarchy nodes are loaded in UI without any limit. 

So, even if the hierarchy nodes are more than 50, the UI search will show the required 
node in tree structure and ExpandAll and ExpandBranch images will be enabled. 

 

Error Dic tionary 
This contents of this section has been created with the interest to help you resolve the 
installation issues if any. There is a compilation of all the possible errors that might 
arise during the installation process with the possible cause and the resolution to 
quickly fix the issue and proceed further with the installation. 

This section includes the following topics: 

• Accessing Error Dictionary 

• Error Code Dictionary 

 

Ac ces s ing Error Dic tionary 

Instead of scrolling through the document to find the error code, you can use the pdf 
search functionality. In the "Find" dialog available in any of the Adobe Acrobat version 
that you are using to view the pdf document, follow these instructions to quickly find 
the error resolution: 

1. With the Installation pdf open, press Ctrl+F or select Edit > Find. 

2. The Find dialog is displayed as indicated. 

3. Enter the error code that is displayed on screen during Infrastructure installation. 

4. Press Enter. The search results are displayed and highlighted as follows: 

 
Figure O–1 Error Code 

 

 

View the details of the issues, its cause, and resolution specific to the error code. 
Repeat the step to find an answer to any other errors that you notice during 
installation. If you are not able to resolve the issue even after following the steps 
provided in resolution, you can contact support.oracle.com along with log files and 
appropriate screen shots. 
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Error Code Dic tionary 
 

Error code - OFSAAI-1001 
 

Table O–2 Error code - OFS AAI-1001 
 

Cause Unix shell is not "korn" shell. 

Resolution Change the shell type to "korn". Use chsh unix command to change 
SHELL type. 

Shell type can also be changed by specifying shell path for the Unix 
user in /etc/passwd file. 

Note: chsh command is not available in Solaris OS. 

 

Error code - OFSAAI-1002 
 

Table O–3 Error code - OFS AAI-1002 
 

Cause No proper arguments are available. 

Resolution Provide proper arguments. Invoke Setup.sh using either SILENT or 
GUI mode. 

Example: ./Setup.sh SILENT or ./Setup.sh GUI 

 

Error code - OFSAAI-1004 
 

Table O–4 Error code - OFS AAI-1004 
 

Cause File .profile is not present in $HOME. 

Resolution Create .profile in $HOME, i.e. in the home directory of user. 

 

Error code - OFSAAI-1005 
 

Table O–5 Error code - OFS AAI-1005 
 

Cause File OFSAAInfrastructure.bin is not present in current folder. 

Resolution Copy OFSAAInfrastructure.bin into installation kit directory. 

 

Error code - OFSAAI-1006 
 

Table O–6 Error code - OFS AAI-1006 
 

Cause File CustReg.DAT is not present in current folder. 

Resolution Copy CustReg.DAT into installation kit directory. 

 

Error code - OFSAAI-1007 
 

Table O–7 Error code - OFS AAI-1007 
 

Cause File OFSAAI_InstallConfig.xml is not present in current folder. 

Resolution Copy OFSAAI_InstallConfig.xml into installation kit directory. 
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Error code - OFSAAI-1008 
 

Table O–8 Error code - OFS AAI-1008 
 

Cause File validateXMLInputs.jar is not present in current folder. 

Resolution Copy validateXMLInputs.jar into installation kit directory. 

 

Error code - OFSAAI-1009 
 

Table O–9 Error code - OFS AAI-1009 
 

Cause File log4j.xml is not present in current folder. 

Resolution Copy log4j.xml into installation kit directory. 

 

Error code - OFSAAI-1010 
 

Table O–10 Error code - OFS AAI-1010 
 

Cause Unknown error occurred. 

Resolution Make sure to provide proper argument (SILENT or GUI) to the 
Setup.sh file. 

 

Error code - OFSAAI-1011 
 

Table O–11 Error code - OFS AAI-1011 
 

Cause XML validation failed. 

Resolution Check InfrastructurePreValidations.Log for more details. 

 

Error code - OFSAAI-1012 
 

Table O–12 Error code - OFS AAI-1012 
 

Cause Property file with locale name does not exist. 

Resolution Copy MyResources_en_US.properties to the setup kit directory and 
keep en_US in LOCALE tag of OFSAAI_InstallConfig.xml. 

 

Error code - OFSAAI-1013 
 

Table O–13 Error code - OFS AAI-1013 
 

Cause File OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 

not found. 

Resolution Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 
to the setup kit directory. 

 

Error code - OFSAAI-1014 
 

Table O–14 Error code - OFS AAI-1014 
 

Cause XML node value is blank. 

Resolution Make sure all node values except SMTPSERVER, PROXYHOST, 
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD, 
NONPROXYHOST, or RAC_URL are not blank. 
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Error code - OFSAAI-1015 
 

Table O–15 Error code - OFS AAI-1015 
 

Cause XML is not well formed. 

Resolution Execute the command dos2unix OFSAAI_InstallConfig.xml to 
convert plain text file from DOS/MAC format to UNIX format. 

OR 

Make sure that OFSAAI_InstallConfig.xml is valid. Try to open the 
file through Internet Explorer for a quick way to check validity. If it 
is not getting opened, create new OFSAAI_InstallConfig.xml using 
the XML_Utility.jar. 

 

Error code - OFSAAI-1016 
 

Table O–16 Error code - OFS AAI-1016 
 

Cause User installation directory contain blank spaces. 

Resolution Provide an installation path that does not contain spaces. Check the 
tag USER_INSTALL_DIR in OFSAAI_InstallConfig.xml file. This path 
should not contain any spaces. 

 

Error code - OFSAAI-1017 

 

Table O–17 Error code - OFS AAI-1017 
 

Cause User installation directory is invalid. 

Resolution Provide a valid installation path. Check if you are able to create the 
directory mentioned in USER_INSTALL_DIR tag value of OFSAAI_ 
InstallConfig.xml file. 
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